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THE APPLE-MICROSOFT RIVALRY broke into a new
battleground last month with the launch of Apple’s
Safari 3.0 browser—in public beta—for both Windows
and Mac OS X. A million downloads of the browser
for Windows were clocked right in the first week
after the launch. Speculation is rife in regards to this
totally unexpected move by Apple.

One school of thought says the motive for this is
to invite more developers to code applications for
the iPhone, which runs on Mac OS X. Apple has
made an attempt to pitch Web-based applications—
which, naturally, imply Safari—as the iPhone devel-
oper platform. The other possible reason for Apple
having released Safari for Windows could be that
Apple simply wants to increase its browser market
share, which, as you know, lags way behind IE or
even Firefox. And with Microsoft still battling the
lawsuit on its bundling of IE with its operating sys-
tems, there might still be a chance for Apple of
taking a lead in this new browser war—if Microsoft
loses the case.      

History, though, tells us a different tale. It is
common knowledge that Apple has never quite
been successful at building applications for the
Windows platform. The QuickTime media player
failed miserably; iTunes is far from having become
the default media file management software for 
PC users. So what are the chances of Safari picking
up steam?

The initial, scathing reviews are hardly encour-
aging. Barely a few hours after the announcement of
Safari for Windows, security experts found not less
than 18 security holes in the browser. Technology
experts, prominent tech bloggers, and message
boards have ridiculed Safari for a buggy beta; the
user interface enthusiasts are disappointed with the
look and feel. The worst of all, it’s slow. The problem
could quite simply be that Safari for Windows wasn’t
built for the regular Windows user. It’s not Windows
enough: for example, Safari uses Mac OS X font anti-
aliasing instead of Windows’ inbuilt ClearType, and
fonts look blurry and bold. Menus are hard to read.
Safari uses its own set of key combinations for things
like flipping through tabs—which is not a universal
standard, let alone a habit for IE users. 

So when Apple tries to force down a Windows
user’s throat its own idea of a “superior” user inter-
face, it is not taken to with kindness.

Windows users might have been forced to use
iTunes if they wanted to play their iPods, but it’s
still an irritant to those used to the convenience of
drag-and-drop offered by Windows media player.
Similarly, for a browser, Apple will need to 
do things the Windows way and follow the 
standards expected by the Windows user. It 
might get away with it’s our-way-or-the-highway
attitude for its own products—the Mac, the iPod, 
or even the iPhone, but to successfully lure 
Windows users, the approach they need to take will
be one of humility.

editor@thinkdigit.com

Editorial

Deepak Ajwani Executive Editor

It’s Not 
Windows Enough

“Apple has never quite been
successful at building applications 

for the Windows platform”
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Enter

16
Shweta Kawatra
hates Mumbai
traffic. She
wants a
teleporter!

16
New tech for
Rich Internet
Applications

20
The MS/FOSS
thing is getting
messy

22
Microsoft’s
Photosynth is
quite incredible.
Find out what
exactly it is

Digital Passion

Contents Magazine

Tomorrow
30 The Body 
Beautified
Da Vinci may have
gotten the proportions of
the body right, but he
probably never thought
we’d get advanced
enough to actually
replace parts as
though they were
disposables

Do It Yourself
34 Create Your Own Linux Distro
Whether you’re already a Linux afficionado or
not, we believe you should read this one. You
can’t create a Windows-like OS... how about a
Linux distro? Your own OS? To use, to show
off? It’s not that difficult. Really.

Lead Feature
45 Hacking The Kid
Kids love computers, as you
know all too well, and we also
don’t need to tell you they love
the games best. How about
going beyond the obvious
pastime? How about getting
them to learn something, open
up their mind while they’re at
the Desktop?

Lead Feature
25 Chic Tech
Pretty much every
male thinks women
love pink gadgets,
and that’s a myth.
We’re busting that
one, and a lot
more—after having
spoken to several
women

Cover Story

50 Computing Comfort
It’s forever raining new
laptops, it seems. The
omnipresent motif of
dropping prices applies.
Want a laptop? Need one?
Either way, here’s our annual
shootout

64 Bazaar
Some of the best of the latest in the world of tech
products. Featuring a fabulous keyboard, a great set
of headphones, a fast graphics card, an amplified
2.1 Bose system, and then some

40 Droolmaal
Maal to drool after... featuring a gold-plated
cell phone. An absolutely fabulous
touchscreen LCD to draw on. The world’s
“smallest and lightest camcorder.” And
more—turn to the page, but don’t wet it

42 Take A Crack At
You have pre-defined sound events in XP,
such as “Critical Alarm” and so on. Think you
can create custom sound events, like an
audio clip playing when Photoshop starts up?

38 30 Days With
Here’s about a month with the Asus P535. It’s
a Windows Mobile device, and our reviewer
thought it was pretty cool. Except that it
doesn’t have a full keypad. He says
“convergence” and “convenience” say it all

Net Gain
76 Do It Yourself (And Don’ts, Too)
Our Web site review this month includes a DIY site,
one that teaches you Web design to supplement our
Fast Track, and best of all, a place to go to after which
you won’t need to fill in Web forms any more!

Old Way, Tech Way
87 Commuting Vs. Telecommuting
Are we already in the age where physical commuting
is unnecessary? What was the work-at-home
experience like for one Digit writer? Read on to
find out

Agent001
85 Pixel-perfect

Agent 001 is dead sure many of you still aren’t
aware what’s in the digicam market today.
Myths busted, features-to-look-for included,

models mentioned—in short, sound, sane
buying advice

Digital Tools
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Test Centre
96 One Thing 
Too Many
Here’s our annual
inkjet MFD shootout.
They have not been
overshadowed by
their laser
counterparts. What
models for your
office—and why?

Tech Careers
89 Be The Game
Don’t bother about it if you don’t particularly
like games, but if you do, we’re putting it into
your head that you can create them

Lead Feature
92 No-nonsense
Notebook
Let’s put you in a dilemma
if you aren’t already.
Should it be Mac, Vista, or
Linux for your business?
An informed verdict.

Smart Business
109 Smart Training
Introducing fun ways of
training your employees.
These may be expensive
now, but the idea is
catching on quick. Be at
the cutting edge...

Trend
106 Web 2.0 And Businesses
Should you, as an employer, encourage your
subordinates to blog, to use social networking sites?
It really is a trend that’s catching on

Digital Business

Stat Attack ......................................18
The Digital World ............................18
Beat That ........................................19
Gender Benders ..............................20
Buzzword Of The Month ..................20

The A-list ........................................70
Q&A..................................................72
Tips & Tricks ....................................77
Whatever Happened To ..................120
Bluff Your Way Through..................122

Digit Diary ......................................123
Blogwatch ......................................123
Inbox ..............................................128
Tech Quiz........................................130
Tabloid Tech....................................131R
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113 Game On
Reviews. Yet another racing sim, but it gets
a 7 from our reviewer. Then there’s
Supreme Commander, where you are, well,
a commander of many forces. But most
importantly, God of War II!

Escape

121
C: the greatest
high-level lan-
guage ever.
Here’s about the
duo who wrote
the famous book

123
A robot (in Korea,
of course) was
the best man (!)
at a wedding.
Naturally, these
Koreans are crazy

Digital Leisure Lead Feature
116 Virtual Weapons 
In Real Life
Computer games
haven’t been
ignored by the US
DoD and other
agencies. Looks like
they have indeed
been inspired by
weapons from
games—think
about the Rail
Gun and such.
We could be
wrong about
the inspiration
part, but there
are strong
similarities
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FREE
Blob Wars:
Blob and Conquer
(Linux)
With the apparent defeat
of Galdov and the

reclaiming of the Fire,
Time, Space, and Reality
Crystals, the Blobs’ battle
was only just beginning.
Bob had rescued many
Blobs and fought many
battles, but now he had

an ever bigger task
ahead of him. The Blobs’
homeworld is still littered
with the alien forces and
Bob once again makes it
his task to lead the
counter attack. But even
without Galdov the aliens
are still extremely well
organised...

D.R.O.D.—Deadly
Rooms Of Death,
Architects Edition
A brilliant puzzle game
that mixes in some
portions of RPG as well.
Basically, the story is
thus: you’re a big ugly
dude who’s been

trapped in a big cave
thing and has to kill all
the bugs to get out.

Porrasturvat:
Stair
Dismount
Score as much
damage as you can
by sending some
poor sucker down
the stairs. By
controlling the

initial conditions of the
fall, you can create some
pretty nasty-looking

accidents.

■ Cassetto
■ Dr. Goo
■ Roswell Racer
■ Toblo
■ Within a Deep Forest

MUSIC
Captain Obvious Live
at Bar 227 - Full
Album
Enjoy the sounds of this
German Instrumental Rock
band at Bar 227 in Hamburg

FUN SOFTWARE
Packet Garden

This is an open source, multi-
platform, experimental art
project that monitors your
Internet traffic and uses the
data from that to generate

virtual 3D worlds that you can
explore at will.

■ AnimatedAlien ScreenMate
■ AnnoyMail 2001 3.0
■ Babble Rock 1.0
■ BlueScreen Screen Saver 3.2
■ Fake Progress Bar 1.1

■ FlowerThinger 1.1

■ Vista Upgrade Prank 1.00

MULTIMEDIA
3D Canvas 7.0.1.2

3D Canvas is a real-time, 3D
modelling and animation tool
that incorporates the drag-
and-drop approach. Complex
models can be constructed
from simple 3D primitives or
created using 3D Canvas’
object-building tools.

SynthMaker 1.0.6

Create your own instruments
and effects to use in your
music or to share with others.
Learn about and experiment
with sound synthesis and
digital signal processing
techniques.

■ Celtx 0.9.9.1
■ Autostitch
■ Celtx 0.9.9.1
■ ChrisTV Lite 5.01
■ Flames 2.7.2
■ Fx New Sound Free 
■ Photowipe
■ RGS-AvancePaint 1.2.9
■ Mixcraft Recording Studio
■ Oriens JPEG Professional 1.3

SYSTEM
AutoMate 6.1.1
This is a software tool for
Windows that enables you to
easily build custom
automated tasks. In most
cases, these tasks can be
created without writing a
single line of code! Users
construct automated tasks

with the help of a Wizard and
an intuitive drag-and-drop
Task Builder. AutoMate

breaks down common user
actions into basic steps. You
build tasks step by step in
logical progressions. The
result emulates an actual
user performing the given
task or procedure.

■ Celtx 0.9.9.1
■ Autostitch
■ ChrisTV Lite 5.01
■ Flames 2.7.2
■ Fx New Sound Free 
■ Photowipe
■ RGS-AvancePaint 1.2.9
■ Mixcraft Recording Studio
■ Oriens JPEG Professional 1.3

INTERNET
Mozilla Firefox 3
(Gran Paradiso)
alpha 5

Firefox 3 (Gran Paradiso)
alpha 5 is a developer preview
release of the next-generation
Firefox browser. It is only
being made available for
testing purposes.

■ Bildsoft FastnPlay Lite +
Pro! 2007

■ Pidgin (formerly Gaim) 2.0.1
■ PowerArchiver Outlook

Plugin 2.0 Beta 3
■ Sockso 0.1
■ SpaceTime Beta
■ uBrowser
■ Mask Surf Standard
■ OutNote 1.0.9
■ PingPlotter 2.6
■ TubeTools 1.0.1.2

While on a well-deserved vacation, Professor Fizzwizzle’s
investigation of a strange volcano has landed him in a Molten

Mystery! Now it’s up to you to master exciting new gadgets, outwit
the Bat-Bots, and vanquish a truly cunning villain!

PERSONAL
Polyglot 3000

Here’s a small program
that can recognise the
language of any text,
phrase, or word you
provide it. It can handle
over 400 languages.

■ ISS Smart Flow 1.3.1
■ LetMe Type
■ Polyglot 3000
■ Pro Typist
■ ToDoList
■ episTree 2 build 2610
■ Classroom Spy

Professional
■ FolderShare 2.5.1
■ PC Tattletale 7.9.49

DEVELOPERS
Advanced Linux
Programming
“If you are a developer for
the GNU/Linux
system, this
book will help
you to:
Develop
GNU/Linux
software that works the
way users expect it to.
Write more sophisticated
programs with features
such as multiprocessing,
multi-threading, inter-
process communication,
and interaction with
hardware devices. Improve
your programs by making
them run faster, more
reliably, and more
securely.” All the sample
source code for this book
is on this CD.

Video Game Design
Pro 2006

Video Game Design Pro
2006 offers many tools,
resources, and
documentation to help
users communicate their
game concepts to others. 

■ Free Monitor for Google
■ Microsoft Fiddler 1.2
■ VLC media player

source code
■ FeedWrite
■ Easy SQL Scripter 1.0

Productivity

Entertainment

Tools

Gaming

L

Professor Fizzwizzle and the Molten MysteryProfessor Fizzwizzle and the Molten Mystery
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FREE
Excalibur:
Morgana’s
Revenge
EMR 3.0 is a unique
scenario based upon the
Aleph One (Marathon)
engine. It is a first-person
action adventure game,

featuring an epic and in-
depth story line. As a
Federation Marine resting
after your last mission,
you start aboard the
exploration class Starship
Kronos where you learn
that your real mission has
yet to begin. 

Urban Terror v4.0
Urban Terror is a realism
based total conversion
mod for Quake III Arena
which no longer requires
this game to be installed.
It only uses its engine,
which is open sourced
through the GPL and may

be distributed freely.
Urban Terror plays in
about the same setting as
Counter Strike, but is less
focused on realism and
plays much faster, which
among other things, is
caused by the ability to
strafe jump.

World of Padman
The World of Padman
made the change from a
mod for Quake 3 Arena
up to a very own game. It
is available for free and
features 7 game types, 12
maps, 6 player
characters, own music,
and a lot of fun
■ CodeRED—Battle for

Earth
■ CodeRED—Martian

Chronicles
■ Excalibur: Morgana’s

Revenge
■ ioUrbanTerror (Use

this to install Urban
Terror if you don’t
have Quake 3 Arena)

MOVIES
Nobody Needs to
Know

Nobody Needs to Know is a
story of Fame and the towns
and industries and the people
who create and support it. It’s
the story of two actresses on
divergent paths who
unwittingly illustrate the
power of Fame and its ability
to pursue those who run from
it and run from those who
pursue it.

MUSIC
Ocean Dreams by
DJ Fab

Listen to a preview of this
Instrumental album in the
Digit Media Player

Scramble by Stygmate
The Pop / Rock band
Stygmate started in 1992
under the original name
Scramble

Sparks by David
Alexander McDonald

Born in the English Midlands,
McDonald became an avid
lover of classical music after
seeing 2001: A Space
Odyssey.

A Part of Me by
Realaze

Relaze started his work on an
Amiga, and eventually
graduated to Fruity Loops to
create his music

MULTIMEDIA
Adobe CS3 Design Premium
A Digit exclusive! This trial of Adobe
Creative Suite 3 Design Premium
comes with: Adobe Photoshop CS3
Extended, Adobe illustrator CS3,
Adobe InDesign CS3, Adobe
Acrobat 8 Professional, Adobe
Flash CS3 Professional and
Adobe Dreamweaver CS3

Maya 8.5 Personal Learning
Edition
Maya Personal Learning Edition (PLE)
is a special version of Autodesk Maya
software, which provides free access to
Maya for non-commercial use. It gives
3D graphics and animation students,
industry professionals, and those
interested in breaking into the world of
computer graphics an opportunity to
explore most aspects of the award-
winning Autodesk Maya Complete
software in a non-commercial capacity. NOTE: You need to
register at http://usa.autodesk.com/adsk/servlet/
mform?siteID=123112&id=9432085 for your PLE Serial Key

Sound Borb 1.0
Sound Borb application was designed to be an audio ambience
generating system. The generative nature of Sound Borb’s
audio engine means that once you hit play, the ambience
you’re listening to will never end.

Reallusion CrazyTalk
Media Studio Edition 4.6
CrazyTalk combines powerful
facial animation technology with
easy utilities designed to bring
your photos to life through three
specialized versions to create
virtual hosts or animated actors.

■ Licence Protector Multimedia Edition 1.3.0.250
■ MeD’s Movie Manager 2.5.3.3
■ Sound Borb 1.0
■ Ideal MP3 Music Sorter 5.25
■ Plopp 1.2

SYSTEM
■ The latest drivers for your ATI or NVIDIA graphics card
■ Moffsoft FreeCalc
■ Slawdog AquiBind 1.0
■ Total Commander Ultima Prime 2.7

INTERNET
■ Instant Media 1.2.3
■ Silverlight 1.0 Beta
■ SleekOffice 1.1
■ WebCam Thingy 2.8

DUAL LAYER

No more Core, no more Extras—just
good old Fedora. Fedora 7 is the
latest in the line of Red Hat’s
popular free Linux distribution. Boot
from this DVD to begin installing it.

Note: At the beginning of the
installation, you’ll be asked if you
want to verify the installation media.
Please skip the test—this DVD fails
this test because of the additional
content on the disk, but Fedora will
install fine on your disk regardless.

F
PERSONAL
Banshee Screamer
Alarm 2.55

Banshee Screamer is an
alarm clock designed with
one purpose in mind: To
wake you up.

Active Desktop
Calendar 7

This fully customizable
calendar with notes, tasks,
alarms and contacts
provides seamless
integration and interactivity
with the desktop
background. You can
organize your data in layers
and share them with other
people on a local network.
The program integrates
with Outlook to show its
appointments and tasks on
the desktop. 

■ I-Doser 4.5
■ IDrive-E
■ iFinger Engine
■ Active Desktop

Calendar 7
■ Magic Desktop
■ Notezilla Portable 7.0

Build 78
■ Oxford Dictionary of

English (Second Edition)

DEVELOPERS
Microsoft Silverlight
1.0 Beta SDK

The Microsoft Silverlight
1.0 Beta Software
Development Kit contains
documentation, samples
and tools for developing
Silverlight applications.

■ ActivePython 2.5
■ Internet Explorer

Developer Toolbar
■ Microsoft Silverlight 1.0

Beta Software
Development Kit (SDK)

■ ElegantJ PDF Library 1.1
■ SiteSpinner 2.7c
■ VBto Converter 2.3

Productivity

Entertainment

Tools

Gaming

Digit
Exclusive

8,700 MB Of Quality Content!



By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Fedora 7
Size: 2.8 GB  

Adobe CS3 Design
Premium
Size: 1.9 GB

Maya 8.5 PLE
Size: 240 MB

taste technology at www.thinkdigit.com

This Month’s Question

To vote Log on to www.thinkdigit.com

Which Operating System would you like to use?

Digit Reader Poll

Windows 98 Mac OS X

Windows XP Windows Vista

GNU/Linux

Subscribe
No more snail-mail!
No need to visit post
offices! All you have
to do is log on to
www.thinkdigit.
com/subscribe and
use your Credit Card
to make sure you
never miss another
issue of your favourite
magazine!

FEATURED REVIEW FROM DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month, we feature a member review from the forum here.

AEF - Advanced Electron Forums
Link:http://www.anelectron.com
It is written in PHP and MySQL

Well I think that this software as far as I recollect is India's first home made forum/Bulletin Board software. This software is OK
as compared to the other giants like IPB, vBB , SMF. However it is better than phpBB. But for a month old software it is pretty
decent and its prospects are beginning to show up.

The first version was not that great but recently they made the new version 1.0.2 and they have included some pretty good fea-
tures like a shoutbox, news system (with news articles - this is not featured by many others listed above), threaded mode ,
suggest framework, dom drag stuff(I have seen this thing for the first time on any forum software), etc. I particularly like the
DOM Drag they introduced, its something new and novel. Well also it is very fast.

Coming to the looks I just Love the EYE Candy these guys have put up in the theme. Its so much better than that of the boring
SMF and PHPBB looks. AEF has used some good amount of designing and it is a good reason for trying it out.

Well I think this software is good altogether and is worth a try. Have you guys tried it out?

To comment on this review and more, visit www.thinkdigit.com/forum/showthread.php?t=61026

IInnddiiaa''ss  ffiirrsstt  hhoommee  mmaaddee  ffoorruumm  ssooffttwwaarree

Which of the following predictions will be a
reality in the next five years?

Free
Broadband
40.82%

Universal
Operating

System
13.52%

India moving
on to 4G
28.81%

Audio enabled
Search
16.85%

Last Month’s Question

Total: 2467
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Shweta Kawatra
Actress

Kawatra started her career
as a model in Delhi for big
names like Hemant Trivedi
and Lubna Adams. She has

been an actress
since 1995.

Kawatra’s break
in her acting
career came
from her lead

roles in soap
operas—in Kahani

Ghar Ghar Ki,
followed by her role as
Eesha in Kkusum. 

Technology to you is ….
The future! It allows us to have
a better life and a better
standard of living.

What gadgets do you use?
I have a mobile phone and use
a computer for designing my
own Web site. My husband has
promised to buy me a laptop if I
do a good job with the site. 

What would your dream
gadget be, and why?
A gadget that would teleport
me from one place to another. I
am tired of this Mumbai traffic.

What do you do online?
Due to my busy schedule, I
hardly spend any time on the
Net. But when I do, I reply to
my fan mail. I have made a
resolution to become more
tech-savvy. Otherwise my
children will soon treat me like
an outcast! 

Any instance where
technology has really helped
you? 
On 26 July, 2005, Mumbai was
flooded. I was stuck in traffic
and didn’t know what was
happening. Thanks to my
mobile, I was informed of the
magnitude of the flooding and
took shelter in a hotel.

Safari 3 beta For Windows
Apple recently released the Safari 3 beta version for Windows
XP and Vista users. (Safari is the default browser on Macs.)
Within 48 hours of its release, over a million downloads were
recorded. However, three security researchers independently
found eight vulnerabilities in the first 24 hours.

YouTube Remixer
YouTube has launched an online editing tool at their site, the
YouTube Remixer, powered by Adobe. The Remixer can be
used for joining video clips, photos, music, graphics, and
other special effects. This means YouTube members can now create more
professional-looking videos.

W e’ve been talking
about
conventional

Desktop applications moving
to the Web as Rich Internet
Applications (RIAs). These are
Web applications that
typically work within a Web
browser, and have features
and functionalities similar
to those of Desktop
applications. 

More technically, RIAs
are like layers of code
added between the user’s
end and the Web server to
perform certain tasks by
asynchronous
communication within
them. For instance, when
you visit an RIA-based Web
site that has an online
word processor (like
Google Notebook), code
gets transferred to your
system. This code acts as a
browser extension and
communicates with the
server. The code renders the
user interface of the
application to make it more
responsive. As you keep
writing in Google Notebook,
supplementary code keeps
getting downloaded.

Different technologies—
ActiveX controls, Adobe’s
Flash, JavaScript, Java
applets, AJAX, Windows
Presentation Foundation,
and other user interface
markup languages—are used
in the development of RIAs.
The limitation of RIAs is that
they are only functional
online. And now, to
overcome that limitation, a
number of development
tools have been—and are
being—released. 

Google recently released
Google Gears, an open source
browser extension that
enables Web applications to
be available offline. Google
Gears offers three chief
features—it can act as a local
server, as a database,

and can make applications
work in the background.. If
your Internet connection
fails and you need to check
your Gmail, Google Gears
makes it possible: data held
on a Web server can be
stored as a database on a
Desktop computer. When a
connection is established,
the data is synchronised
with the corresponding Web-
based applications.

Adobe, too, has launched
a similar cross-platform tool
named Adobe AIR (Adobe
Integrated Runtime, earlier
code-named Apollo) for
developers to build and
deploy advanced RIAs. Using
the Adobe AIR framework,
RIAs can be built using

Adobe Flash, Flex, HTML,
JavaScript, and AJAX to make
them work online as well as
offline. Google is working
with Adobe on AIR to make
further development of APIs
for running Web
applications offline possible.

“The Gears API will also be
available in Apollo, which
enables Web applications
to run on the desktop,
providing developers
with consistent offline

and local database
solutions,” said Kevin
Lynch, senior vice president
and chief software architect
of Adobe.

Microsoft’s Silverlight
offers the ability to build
APIs for online Web
applications and also make
those APIs work offline on
desktops: like Flash.

In May, Sun
announced its JavaFX

technology in response to
Silverlight; it is more
appealing to Flash and AJAX
developers because it’s
simpler. JavaFX products will
cater to the RIA market for
mobile devices, Desktops, TV
set-top boxes, and more. As
you can see, Google Gears
along with Adobe’s AIR,
Silverlight, and JavaFX will
compete in this space.

There’s also the Dojo
offline toolkit, out recently,
which will allow AJAX
developers to enable AJAX
services to run easily while
offline. In sum, what we’re
witnessing is the online /
offline gap being plugged.
Of course, that line can
never be totally erased, but
life is getting better.

Enter
DEVELOPERS’ DELIGHT

From Web To Desktop

Illustrations Harsho Mohan Chattoraj



NEW SENSOR TECH

Let There
Be Light

No more low-light
worries: Kodak has
leapt into the

limelight with new sensor
technology. Kodak has said
that their new technology
will go a long way in
overcoming light issues by
increasing light sensitivity,
which is one of the biggest
pains in the neck for
professional photographers
and amateurs alike.
Insufficient light makes for
noise in the output image:
grains, multi-coloured
speckles, and other
unwanted elements.

The majority of the
sensors in digital cameras
use the Bayer filter. This is a
chequerboard grid where
green pixels make up 50 per
cent, and red and blue
make up 25 per cent each.
Now, neutral,
“panchromatic” pixels will
be added to the array along
with the usual red, blue,
and green pixels.
Panchromatic pixels are
sensitive to all wavelengths,
and collect a larger amount
of light when it hits the
sensor. This will result in a
more true-to-life image. The
images will also be
reconstructed using a
different algorithm.

Steve Hoffenberg, an
analyst with Lyra Research
Inc. has said, “Typically,
new features like this
would be more likely to
show up in high-end

products and then trickle
down. But I think the
biggest potential benefit of
this may come in the
camera phone
environment. Camera
phones are using smaller
sensors to begin with and
smaller sensors generally
mean smaller pixels, which
means lower sensitivity.”

Kodak will first
incorporate this feature in
their own cameras and then
offer it to other camera
manufacturers in the first
quarter of 2008. 

Certain analysts have
expressed scepticism about
the technology.
Christopher Chute, an
analyst from IDC research
has said, “They have been
guarded about their
portfolio, with certain
degrees of success. But at
the end of the day you
need to have invented
something or have some
kind of intellectual
property in order to
maintain a market
position.”

However, Kodak intends
to make up for it: it is
estimated that they will
receive about $250 million
(Rs 110 crore) in royalties
and related revenues: every
month, the market is hit by
new camera models with
added features: Kodak’s
technology has the potential
to become widespread,
Chute said. “But first it
needs to prove itself. It can’t
just be a lab rat.” Kodak does
need to innovate beyond
their existing camera line-
up besides the technical
enhancements they’ve come
up with. 

A NEW INITIATIVE

Green Tech
Getting
Ahead

Global warming and e-
waste are serious
concerns. Over-

consumption of power by
electrical and electronic
gadgets—as well as PCs and
servers—doesn’t help the
cause: when the equipment
is disposed, the resulting e-
waste can cause upset the
ecological balance. The
Government estimates that
1,46,000 tons of e-waste is
produced annually in India
in the major cities.

Google and Intel have
spanking-new plans towards

Think iPhone...
Multi-touch
screens. are right
in. With the iPhone
and Microsoft’s
Surface—as in the

“touch-table”—having taken off,
the technology is here to stay. It
enables multiple users to
operate a device together.
Imagine scenarios like
interactive walls and tabletops… 

...and styluses!
Input styluses
tend to scratch
screens, and the
screens require
calibration. It
doesn’t allow multiple inputs.
Input area is small, and
accuracy is demanded of the
user. This input mechanism
isn’t out yet, but it’s definitely
not the way ahead.

DIGIT JULY 2007

Security Watch

Yahoo! Messenger
Vulnerabilities
The Problem
A pair of serious
vulnerabilities have been
reported in Yahoo! Messenger.
These could enable a hacker
to run malicious code with
minimal user intervention if
the messaging client is
running in the background.

In the first vulnerability, a
remote attacker could
compromise a machine running
a webcam on Yahoo! Messenger
by causing a buffer overflow in
its ActiveX component when
the user visits a Web page with
malicious HTML code. The
result is that more data is sent
to the RAM than it can handle,
causing the program or other
services running on the
computer to crash, or the
execution of harmful code. The
second exploit causes a buffer
overflow in the file ywcvwr.dll,
which is used in the viewer
component of the messenger
client.

eEye Digital Security, the
company that discovered the
exploits, gave them its
highest risk rating. Secunia,
another computer security
company, labelled it
“extremely critical.”

The Solution
Yahoo! has released a patch for
the exploits, stating that
everyone using their messenger
client should download the
updated version from
http://messenger.yahoo.com/d
ownload.php. Yahoo!’s
description of the exploit can
be found at http://messenger.
yahoo.com/security_update.ph
p?id=060707.

17

Dina ThakkarHarshal Namdeo
“eXtremely Pathetic!”“eXPired”

Dheeraj Kapoor
“eXtra Phaltu!”

V. Harish

“eXclusively Pampered” “eXcessive Pricing!”
Rachit Bakshi

“What’s “XP” in Windows XP for you?”One Silly Question
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going green, and they’re
hoping others will join
them. The tech giants
unveiled a voluntary
program—the Climate Savers
Computing Initiative—for
introducing more energy-
efficient computers and
servers to save energy, in
order to offset the
greenhouse effect.

Pat Gelsinger, senior vice
president and general
manager of Intel, says PCs
waste half the electricity
they draw. More energy-
efficient technology does
exist, but it would mean
about $20 (Rs 900) extra to
the cost of a typical PC, and
$30 (Rs 1,350) extra to the
cost of a back-office server.
“Energy costs of more than
$5.5 billion (Rs 2,475 crore)
will be saved. The
programme requires 90 per
cent efficiency standards,”
says Urs Hölzle, senior vice
president for operations at
Google. Computers and
software tools that manage
power will have efficiency
goals set by this programme.

About 40 companies
including major players such
as Dell, Lenovo, Microsoft,
Yahoo!, AMD, HP, IBM,
Hitachi, Unisys, Sun, eBay,

and others have signed up
for the programme. The
World Wildlife Fund is
included in the programme
for licensing the initiative as
an extension to WWF
Climate Savers Program.

In 2003, the European
Union adopted a directive
that restricts the use, for the
manufacture of electronic
components, of elements
that turn into hazardous
waste upon recycling. India’s
Wipro will, similarly, offer
Restriction of Hazardous
Waste (RoHS)-compliant PCs
and other products, the first
Indian computer maker to
do so.

Several computing
majors such as Intel, HP, and
Dell have opted to go green:
a few are already coming
out with “green PC” models,
which are more eco-friendly
and energy-efficient than
those currently available.
These will be sold with
rebates as incentives.

Having set up solar
energy systems to power
their headquarters, Google,
too, is going green. Their
popularity and corporate
presence is strong enough
to encourage others to move
ahead along similar lines.

A Round-up Of Technology News From Across The GlobeThe Digital World

SOUTH AFRICA
AMD has opened a local office with the aim
of spreading its reach in the fast-developing
IT sector. As it grows, AMD plans to
participate in black economic
empowerment, and has already set up
computer labs in schools across the country.

A federal judge ruled that data
that resides in RAM only for a
few minutes can be subpoenaed
and used as admissible evidence
in a court of law. The judge’s
rationale is that it is “stored
information.”

UNITED STATES

The People’s Liberation Army has
established information warfare
units to develop viruses to attack
computer systems and networks
that are a threat to China. It is
also investing in electronic
countermeasures and defences
against electronic attack.

CHINA

UNITED KINGDOM
Wireless access points in London
grew by 160 per cent in the last
one year, putting it ahead of all
other cities in the world. The
percentage of vulnerable access
points also fell.

NORWAY
Microsoft is changing the terms of its
schools agreement with regional
municipalities following a complaint
to the government. MS was charging
Windows licensing, and was bundling
its OS, on computers on which the
schools want to run other OSes, to up
discounts for school computers.

It’s all in the numbers

Stat Attack

Worldwide Memory Type Usasge

Worldwide Memory Size Usage

8.5 million cell phones go down 
the toilet every year. 1.16 million go into

washing machines. And 58,500 are
chewed up by dogs!

The US has
highest

proportion of

malicious
activity, at

31%. China is
second at 10%

Google uses over

10,000
networked

computers to
crawl the Web

200 million people use DSL. China is the
largest provider: 37 million

63.7%

27.8%

4.12%4.38%

DDR2-SDRAM

SDRAM

41.4%
1 GB

21.5%
2 GB

10.2%
Other

5.3%
256 MB

21.5%
512 MB

Other

AUSTRALIA
The country will be
networked in its entirety,
including bush and rural
areas, with fast broadband.
The $1.6 billion (Rs 7,200
crore) contract was bagged by
Singapore-based Singtel.

DDR-SDRAM

http://valid.x86-secret.com

http://valid.x86-secret.com
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Photograph Utsav Goswami

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Microsoft Office 
Access 2007
by Kenneth Hess

Published by
Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

“Sania—nice moustache!”

Time and research will
need to be put into “going
green” on a global scale, and
it is heartening to see that
the major players in the
computing space are not
only sitting up and taking
note, they’re also spreading
the word.

BEYOND 80

More Cores

September 2006, Intel
unveiled its 80-core
teraflop chip prototype.

It was part of a research
program, and not for
commercial purposes. The
chip did not contain x86
cores, and could only
compute floating points.
Other companies and labs
have also developed chips
with large numbers of cores:
ClearSpeed Technology, for
example, developed a chip
with 96 cores for performing
specific tasks.

After having officially
showcased the 80-core
prototype, questions were
shot at Intel: would they
make a multi-core chip with
x86 cores? Would the

latency, heat, and data
traffic problems be solved?
Intel merely said they were
working upon it.

Now Jerry Bautista, co-
director of Intel’s Tera-Scale
Computing Research
Program has said,
“Researchers at Intel are
working on ways to mask
the intricate functionality of
massive multi-core chips to
make it easier for computer
makers and software
developers to adapt to them.
These multi-core chips will
also likely contain both x86
processing cores, similar to
the brains inside the vast
majority of Intel’s server and
PC chips today, as well as
other types of cores. A 64-
core chip, for instance,
might contain 42 x86 cores,
18 accelerators, and four
embedded graphics cores.”

Each core on a massively
multi-core chip is connected
to an external memory chip
through thousands of
microscopic interconnects.
This technology of
connecting chips is known as
Through Silicon Vias (TSV).

One idea from a paper
released at the Programming
Language Design and

Implementation Conference
in San Diego has proposed
placing all the cores in an
“exoskeleton”(the external
protective structure/shell like
on outer body of insects or
other invertebrate) in a
heterogeneous multi-core
chip, either to make all the
cores look like a single core
or to make them appear as a
series of x86 cores. Another
paper presented at the
International Symposium on
Computer Architecture, also
in San Diego, suggests a
hardware scheduler that
would share computing tasks
among the cores. The
scheduler would not only
speed up processing, it
would also prevent heating
by transferring tasks to the
next non-busy core. Heat
issues are also being
addressed.

Intel might not have an
x86-core-based massively
multi-core chip now, but
they might well come up
with one. That chip we’re
looking forward to could
make Desktop computers
efficient enough to emulate
supercomputers, which
handle computing tasks
differently.

ERASABLE PAPER

Reprint,
Reuse,
Recycle  

Some of the most
significant computing
technologies have

originated at the Palo Alto
Research Centre (PARC). PARC
is a wholly-owned Xerox
subsidiary, where research
programs are undertaken in
areas ranging from
biomedical science to
ubiquitous computing.

PARC has now researched
and developed new printing
technologies, one of them
being solid ink. This is a wax-
based ink in the form of
cubes to be used in printers
in place of fluid inks. A solid
ink stick can print on both
sides of a paper
simultaneously. Using any
kind of media—from photo
paper to letterheads—better
colour quality can be
obtained, too.

Researchers at PARC
worked with customers to
find that 40 per cent of

Last Month’s Winner!
Dr. Y. Katheeja, 
72-SALAI STREET, VEDASANDUR-
624710, “Windows Bata!”
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Xerox customers dumped
printed paper at the end of
the day. The researchers have
also come up with a
solution: a technology called
“erasable paper,” for
reducing paper wastage.
Erasable paper is special
paper that, once printed
upon, gets erased on its own
after a certain time period.
The paper can therefore be
used multiple times. An
image is created on a special
paper that Xerox has
invented, by means of light
exposure. There is no ink
involved anywhere in the
process, so there is no
chemical pollution at any
stage. Xerox is making
preparations to make this
commercially available soon.

The concern here for
Xerox is that in the past,

they’ve been unable to
successfully commercialise
PARC innovations. Ethernet,
the graphical user interface,
and laser printing originated
from PARC. Of these, Xerox
has only profited from the
commercialisation of laser
printing. But now, erasable
paper is a technology that
every country will actively
look forward to, since it
makes for ecological as well
as financial advantages.

AOL STEPS IN

India Online!

America Online (AOL) is
the third-largest portal
after Yahoo! and MSN.

Last month, AOL officially
launched its portal—

www.aol.in—in India. India
being a big potential market
for portals has attracted
Microsoft, Yahoo!, and others
as well; with a strength of
more than 2,000 employees,
AOL has had a presence in
India since 2002, working on
and building new services for
AOL’s portal.

The AOL India portal has
services like e-mail, IM,
mobile services, Google-
powered search, and
channels like Bollywood,
Cityguide, International
Music, Education, and more.
India is the first country to
witness AOL’s next-
generation e-mail services. It
will offer users unlimited
storage, industry-leading
spam protection, and
powerful virus protection.

Like the Yahoo! and
MSN messengers, “cool”
features like offline
messaging, sharing of
pictures, personalisation,
and group messaging will
be available in AOL
Messenger. What would be
different is multi-tab
conversations and
simultaneous logins
through multiple AOL IDs.
AOL will also provide video
content from various
content providers. In
mobile services, along with
VAS (Value Added Services)
downloads; WAP Mail and
AOL messenger will be
made available.

In the future, more
products and services will
be made available, we have
been told. The content will
be made available in
regional languages as well.
AOL will add more content
and channels by
collaborating with their
other partners, apart from
Time Warner.

WHAT’S GOING ON?

FOSS:
Business As
Usual

As you already know,
Microsoft has been
going after the Free

and Open Source Software
(FOSS) community,
attempting to sue them for
violating 235 of its
patents. Analysts called it
a lame attempt to protect
its intellectual property.
The FOSS was disturbed for
a while, but has now
decided to just go ahead—
business as usual.

The Linux Foundation
Collaboration Summit was
recently organised at
Google’s Mountain view,
California campus. About
200 open source developers,
users, and software vendors
were present. The Linux
foundation group includes
Intel, AMD, HP, IBM, Oracle,
Novell, EMC, and Bank of
America, amongst others.

The FOSS developers and
software vendors discussed
the future of the open
source movement, and
talked about—obviously—the
patent infringement thing.
Some of those present at
summit referred to
Microsoft as “the enemy,”
while a few expressed the
idea that Microsoft would
never sue: James Bottomely,
CTO, Steeleye Technologies,
and Linux kernel developer
said, “Since Linux customers
also buy Microsoft, it’s
unlikely of them... It’s just
annoying and riled up.”

On another note, the
Linux community is facing

Everyone and their uncle is talking about the Microsoft
Surface: it’s a coffee-table shaped computer with a 30-
inch interactive display under a hard acrylic tabletop. Its
interactive display is capable of multi-touch interaction,
which is quite the buzz: you can access digital
information by touching it, using natural gestures, and
physical objects get recognised, too! For instance, place
a digital camera (with a wireless chip) on the Surface,
and data can be transferred to a media player through

hand gestures—this might sound unbelievable, but you’d
better believe it! The best part is, it allows multiple users
to interact with it simultaneously. Cameras are used
inside the powder-coated steel frame to sense the
touches, gestures, and objects. 

The brilliant gadget—if we can call it a gadget—
works without a mouse and keyboard. Currently,
Microsoft has announced it will be sold for between
$5,000 and $10,000 (Rs 2.25 to 4.5 lakh) initially to
corporate customers. It will thereafter become more
affordable for individuals.

Microsoft Surface

Vinod More  Vs. Indu Harikumar

We picked chatting buffs Vinod and Indu this time for our
task—some mind-work involved here. They had to chat
with two “people” in separate IM windows on MSN
Messenger, and figure which one was a chat-bot. The per-
son was Ashu, and the bot was Alice (alice@worldofalice.
com). Visit the site if you’re wondering what’s going on!

A cheerful Vinod began chatting with Alice like he already
knew her: “wat r u doing these days.”  Vinod asked Alice
and Ashu about their locations, to which Alice replied,
“Where i live is not important, the fact that i actually live
is!” Pretty impressive, yes? On the other side, his chat
with Ashu was more of an interview—too many questions.
In fact, Vinod asked the same questions to Alice and Ashu
at the same time. But it didn’t strike him for a long time
to ask about age—Indu had gotten lucky.

He did ask, though, at some point, and Alice’s
responded true to her bot-nature. Check this chat log

at www.shorttext.com/qtb42x.

The initial pleasantries done, Indu began
chatting with Ashu and Alice at the same

time. At first, Ashu confused her by responding like a bot:
“Try to rephrase the query.” Then Indu asked Alice, “What’s
Bokito in your status message?” Alice responded with links.
This didn’t do it for Indu (bots usually respond with links
and commands), though. Ashu’s smug replies and Alice’s
pleasant responses confused Indu no end. Then it
happened: Indu asked Alice her age. Here’s what she got: “I
was activated on May 29th 2006 at 16:40, so that makes
me 1.307926528412 years old.” Done!

Take a look at Indu’s chat log at www.shorttext.com/pwwvyo. 

GENDER 

BENDERS

Indu

Vinod
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Photosynth
What is Photosynth?
It’s a not-so-perfect-just-
yet technology from
Microsoft Live Labs that
takes a collection of photos
and analyses them for
similarities. It then displays
a 3D scene reconstructed
from the photos. You’ll
have to look at it in action
to see what this means!

Why is it special?
Microsoft plans to make
this technology Web-based,
which means that in the
future it might be possible
to browse different sections
of Web sites or view your
photos just the way you
would move around in a
virtual reality space.

How does it work?
In a Photosynth session,
digital photos are scanned
by pattern recognition
algorithms. When photos of
the same object are found,
the software compares
portions of these images to
create reference points on
a canvas. Using these
points, the image is
converted into a 3D model.

Who is developing it?
Photosynth is a
collaboration between the
University of Washington
and Microsoft Research
using Seadragon
technologies, a start-up
that Microsoft acquired.

When did it come onto
the scene?
Photosynth has been in
development since July
2006, and continues to be
improved upon. 

Where can I preview this
thing?
Photosynth only runs on
Windows XP SP2 and
above. You can preview it
at http://labs.live.com/
photosynth/InstallForVista.
htm?collection=none&show
Errors=0&st=sanmarco/ind
ex1.sxs. To preview it,
you’ll have to let it get
installed on your computer.

problems in the stabilisation
of new features in Linux-
based operating systems.
New features take too long
to come out, and this was
discussed. Raven Zachary,
open source analyst for the
451 Group, believes that in
regards to the usability of
Linux, no innovations were
happening.

The Linux Foundation
has support from 70
corporate and non-profit
players including Intel,
Oracle, IBM, Cisco, Motorola,
Nokia, NTT, Dell, Red Hat,

and Sun. These
companies use Linux-based
servers, and so want the
innovations, as well as more
stabilisation in Linux OSes
and open source software.

Dell’s announcement to
ship desktops and notebooks
with Ubuntu pre-loaded
could well have zapped
Microsoft. Microsoft
continues to strike deals
with Linux-based OSes—
Novell, Xandros, and
recently, with Linspire.
These deals contain clauses
for creating interoperability
between Microsoft products
and Linux.

But will Microsoft versus
the FOSS community ever
end? We see two
possibilities.

After signing their
agreement with Novell,
which we’ve talked about,
Microsoft wanted Red Hat
and Ubuntu to sign a cross-
licensing deal with them, but
neither party was interested.
If a miffed Microsoft decides
to file a suit against the top
Linux distributors, the latter
will, naturally, have to bear
the legal expenses to defend

themselves. This could even
affect the business models of
Linux distributors. Even if a
court declares the patent
infringement matter invalid,
Microsoft might decide on
another set of patents to use
to sue, dragging the matter
to court right until FOSS
developers give up. The
constant fear of litigations
will disturb open source
projects.

The second possibility
we’re talking about is Linux
suing Microsoft for violation
of patents. How? Well, Linux
springs from UNIX. “Think
how long UNIX has been

around,” says Andrew
Updegrove, software
license attorney and board
member of the Linux

Foundation. About this,
Linus Torvalds says, “It’s

certainly a lot more likely
that Microsoft violates
patents than Linux does.

Basic operating system
theory was pretty much
done by the end of the
1960s.” So if the threats
continue, the Linux and

FOSS communities could
retaliate. Of course, we don’t
know what’s going on
Ballmer’s head—he could
well have some other tricks
up his sleeve!

THE PRESENT AND THE
FUTURE

Indian
Bloggers
Meet Up

Censorship and Citizen-
Journalism have been
recently discussed

and debated in the media as
well as on the Web. To
discuss issues pertaining to
the blogosphere, an “un-
conference” for the Indian
blogging community was
held at the Symbiosis
Centre of Information
Technology (SCIT) campus,
Pune. About 200 enthusiast
as well as veteran bloggers,
along with sponsors from
larege portals, IT companies,
Web start-ups, and Web
marketing firms were
present. The primary

organiser was Tarun
Chandel, who was a student
at SCIT.

At the event, Rediff
unveiled their new service—
Blogshowcase—where
bloggers can showcase their
blog content and get
recognition through votes
and comments. The service is
still in beta: registration is
currently invitation-based,
but will become open for the
public soon. Rediff
spokesperson Jasmeet Singh,
vice president for product
marketing, said, “This is a
platform for users to
showcase their own content
from anywhere on the Web
through RSS feeds. These
feeds get updated frequently,
and the blogs are offered in
an organised format to those
who visit our site.”

Also present were the
marketing folks from Purple
Nova, a marketing firm, with
a new product that turns a
PC into a Web server. A
spokesman for Sulekha.com,
Sudhir Syal, spoke about the
concept of bringing blogs to
the print medium. Some
Web start-ups pitched new
blog concepts: SMS Gupshup,
an “SMS blogging” site,
talked about blogging
through SMS, and Fropper’s
ezBlogs offering simplifies
blogging with predefined
templates and such.

The participants
discussed blogging-related
topics—like how to start a
blog, blogging as business,
photo blogging, blogging
from the Indian perspective,
podcasting, and so on. A
woman blogger, “Melody,”
talked about the pitfalls of
freely-available information
and its misuse. A podcasting
talk by the publishers of
Poorna Puna, a youth
magazine, was enthralling.
Indian podcasters from
IndiCast, an Indian
podcasting site (yes, there
are some!) were also present.

However, several bloggers
present at the event felt the
start-ups and services offered
by the portals for bloggers
were “not cool enough.” But
in general, it was a healthy
discussion about how to
better the Indian
blogosphere. 



Robert Sovereign-Smith

“Ooh, look: a pink laptop! I want!”
“Computers are so boring… I’d rather be out shopping!

Sound familiar? All guys (or should we say
MCPs) should immediately identify with this.
Much of what follows will be a pin-prick

deflating a lot of male egos. Technology has fallen
as the last remaining bastion of male dominance.
Two of every 10 of you reading this article is female.
That’s the impressive demographic of our readers,
given the fact that we certainly aren’t a complete
beginner’s guide to technology. This fact alone tells
us that the gender bias of technology is ending, if
it hasn’t already.
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What do women
want? We take a
look  into the
minds of tech-
savvy women to
find out what
they want to
buy, and why
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Between three and four years ago, technology
companies found themselves in a quandary. While
trying to sell their products, apparently, salesmen
(or should we say salespeople?) often took it for
granted that female customers knew nothing of
tech. This resulted in a loss of sales, because no-
one, male or female, likes to be treated like a clue-
less moron. It was found that salespeople who
treated men and women alike, and only explained
features when they were asked for an explanation,
were the ones who sold the most. Thus began the
end of sexism in all things tech.

Women today are coding much of the software
we use, running tech companies, playing games,
and are as tech-savvy as can be expected. We con-
ducted a survey of as many women we knew—from
engineers to artists, dancers to technical writers,

Chic Tech
Lead Feature
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tures that were earlier hidden were now revealed.
Interestingly, when we at Digit first started using
the Office 2007 beta and trials, we found that the
men resisted the changes more. Women seemed to
adapt to it a lot faster. Today, of course, we all love
the Ribbon, regardless of gender.

Gadgets Galore
Our little survey told us that most women have
computers at home, and it seems laptops are the
preferred PC solution. Some had both laptops and
Desktops, while a minority had only a Desktop:
roughly 70 per cent had laptops, and 20 per cent
of those also owned Desktops (though the Desk-
tops were all older models). This is consistent with
the sales figures for increased laptop sales that all
PC vendors are reporting—so women are right up
there with changing technology trends.

Absolutely no surprise was the fact that
everyone we polled owned a cell phone—men,
women, children. Nokia was the popular choice,
with a few Sony Ericssons thrown in, and hardly
any of the others. However, interestingly, the
majority of those who had bought a phone in the
last two years made sure it had MP3 playback and
camera functionality. Music and camera phones
are the order of the day, with radio functionality
coming in a close third. 

The only exceptions to the music phone rules
were those who own a portable media player.
Again, no prizes for guessing which was the most
popular: the iPod. Though there were a few who
owned a Creative or a Philips portable media
player, they’re grossly outnumbered by iWomen… 

Gaming
The women we polled admitted to only casual
gaming. Cell phones and PCs were the favourite
platform, followed by those addictive iPod games.
Only a handful had a gaming console at home,
and even then it was mostly because of the pres-
ence of a male sibling. However, almost 5 per cent
had no male siblings, and still owned a gaming
console. A wild guess tells us that this is not radi-
cally lower than the figures for males in India.

Cynthia Dsouza (Mumbai) and Loveleen Pas-
richa (Delhi) both have gaming consoles at home,
and no male siblings that we could attribute this
phenomenon to. They both just love their gaming,
especially racing games, and spend over three
hours a week on them—a lot when you consider
that they’re not college students but working pro-
fessionals. Incidentally, Cynthia owns a PS2 and
an Xbox 360, while Loveleen has a PS2 and a PSP;
both are looking forward to buying a PS3.

F1
We have a joke going about the office about when
a female colleague was asked to restart the com-
puter by the System Admin over the phone. After
several repeated calls, the admin went down to her
floor to see what was wrong and found her
switching her monitor on and off, trying to reboot!
This was quite a few years ago, but perhaps we still
tell such stories because we at Digit consider our-
selves alpha-geeks, which automatically brings
with it our chauvinism. But enough rambling...

What we’re getting at is that women are gen-
erally the butt of technology jokes, and we found

teachers to beauty queens. In what follows, we
hope to give all of you a better picture of how
women use technology, and get a feel for how
tech-evolved they really are.

Harshini Shah, a Client Service Executive from
Mumbai, perhaps puts it best: “Men are more
interested in gadgets than women are, but times
are changing. Currently, we women use tech-
nology purely for basic convenience. Take the case
of a cell phone: paying extra for features such as
Bluetooth, GPRS, etc., does not seem logical to us—
unless we’re going to use them. However, a phone
with radio or MP3 support has become more of a
necessity than a luxury to us, and we’ll pay for it.” 

Too many men, on the other hand, buy stuff
and features they don’t really need—because of
the “cool” factor. Men just seem to have a higher
level of inquisitiveness. Whether that’s a good or
bad thing, we’ll let you decide for yourself, but we
men will sit and read manuals, and open up every
screw, just to see what’s underneath. Women—at
least the ones we spoke to—are just happy when
things work. They prefer to use and create only
when necessary, and do not have the curiosity to
take apart and see what makes something tick.
Which is something you know, and which is a per-
fectly okay thing.

Anything But Pink
During our interviews, we found that women
hated being stereotyped not just by men, but by
companies as well. We asked them all whether
they would be inclined to buy products targeted
at women: pink MP3 players, or phones with
calorie calculators, or a menstrual cycle time-
table. This elicited an emphatic “No!” from most.
Although looks were important to all the women
we polled, all of them hated the clichéd women-
only colour combinations of the devices targeted
at them. As for calorie and menstrual cycle
watchers, none of the women thought it too prac-
tical. Some did agree that they would like those
features in their phones, so long as the devices
were not pink or purple. Yes, that’s right—and we
believe manufacturers should take note.

We also quizzed the women about the impor-
tance of various parameters of personal devices,
and asked them to rate Looks, Features, Price, Per-
formance, and Customisability—in decreasing
order of importance—when it came to a buying
decision. The results? Features won by a landslide.
Looks came next, then performance and price tied
for third, and customisability came in last. 

Loveleen Pasricha, a Sr. Image Manager at
Media Solutions, Delhi, says, “The first thing to
look for is whether I need the gadget. Next I look
at the features it has, and try to find the best
combination of the features I need and the most
affordable price.”

Software
When it comes to software, which is perhaps what
all of us in the digital age use the most, the con-
sensus was “easier to use.” Of the ladies we spoke
to, those who use Microsoft Office at work or home
all seemed to have only praises for the MS Office
suite. When asked how they would like software to
be improved, a lot of women cited Office 2007’s
metamorphosis as significant—because a lot of fea-

My favourite software
would have to be
iTunes, because it’s
user friendly and I’m
addicted to podcasts. I
also love software that
is skinnable and
customisable. As for
gadgets, I look for
features and value for
money; looks aren’t
really that important. I
don’t think gadgets
and gizmos are
targeted at just men
anymore; I think
they’re unisex, and
targeted more at
different age groups.”

Sarah-Jane Dias
Miss India World 2007
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Interesting here is the fact that most of the
women insisted that they weren’t rash or impul-
sive shoppers—not for technology, that is. They
preferred to first read about the product, ask
either friends who already owned the same
model, and even spend as much as an hour with
the gadget (most often a mobile phone) at the
retail outlet before putting any money down.

Net Anywhere
Quite a few of those we polled used their mobile
service providers for Net access when away from
their desks. GPRS seems to be the favoured pro-
tocol. When asked what they do online, 95 per cent
of the answers contained the word “chat.” Most of
the ladies have Yahoo!, MSN, or Google Talk. Social
networking is popular; Orkut and Facebook
account for most of the surfing bandwidth.

Other activities involve using the PC for work,
researching things for their respective jobs,
playing games.... Mousumi says, “I am fascinated
by Microsoft Office and Adobe and Flash MX.
When I’m not working, I’m usually dabbling in
SEO for friends.”

Also very common were Reliance or Tata data
cards, which you just plug into your laptop’s
PCMCIA and then stay connected.

So What Does It All Mean?
What it all boils down to is the fact that women
are a lot more tech-savvy than we give them credit
for. Some may call our data skewed, though,
because we only polled the middle and upper-
middle class. We did this because the majority of
women in this class have the education and
money to be able to purchase tech products and
services—and thus the biggest female target audi-
ence of manufacturers. 

Currently, both software and hardware seem
to be heading in the right direction—by just
demystifying technology, making it simple to use
and understand. Everyday technology, or con-
sumer technology, which is what most manufac-
turers are focused on, seems to already have
piqued the interest of the fairer sex. Down with
pink products, we say—quite happily. 

robert_smith@thinkdigit.com

that there just isn’t enough justification left to
continue telling them. Today, hordes of both men
and women are employed in the BPO / services
industry, and more often than not, when you dial
a helpline, you get a woman on the other end
helping you with your problem. It makes us
wonder whether the women in this industry tell
jokes about technology-challenged male callers!

When they require help with something tech-
related, most of those we quizzed admitted to
using one of three solutions: dialling the manu-
facturer’s helpline, using the age-old dial-a-geek-
friend service, or searching online for help. Of the
three, looking for solutions online is the least pop-
ular, and most had male geek friends on speed-
dial. However, this happens to only be true about
PC troubleshooting. Purchase decisions are a com-
pletely different matter.

Buying Advice
When it comes to buying PCs most admitted to
asking friends or family for help—mostly males.
Some just depend on their system assembler, or
base buying decisions on ads. For laptops, the gen-
eral consensus is that branded products cannot
be bad anyway, so you’re pretty safe just buying
the latest model that falls within your budget.
Most owned Core Duo- or Core 2 Duo-based lap-
tops, with Windows XP being the most popular,
but quite a few were running Windows Vista. 

The scenario is quite different when buying
personal products such as cell phones or MP3
players. Harshini says, “I’m usually the one who
gives buying advice to my female friends. If I need
advice myself, I generally speed-dial one of my male
geek buddies, because none of my women friends
know much more than me about technology.”

Karina Noble prefers to follow her own deci-
sions, as does Mousumi Chatterji, a technical
writer at LionBridge, Mumbai. Mousumi says, “I
try and buy things on my own, and do the nec-
essary research. I don’t want to end up blaming
someone else if I don’t like what I buy.” A col-
league of Mousumi, Sharada Menon, also
prefers to buy things on her own after visiting
the manufacturer’s Web site and looking for fea-
tures and reviews online.

Here’s what some of the ladies had to say about software, and what they want/expect from it

“I love the user friendly
tutorials and wizards
that software have
incorporated today. This
makes it easy for anyone
to accomplish tasks.”

—Karina Noble 
A teacher of Indian

origin in Canada

“I just want software
that does not crash and
gets the job done
quickly and efficiently.”

—Loveleen Pasricha
Sr. Image Manager,

Media Solutions, New Delhi

“I use Picasa for
pictures and iTunes for
music. Anything that’s
easy to use is good soft-
ware.”

—Harshini Shah
a Client Service Executive,

Maximus, Mumbai

“We professionals have
no problems, but soft-
ware should be designed
to make it easier for
those new to technol-
ogy—men or women.”

—Diana McGowan
Executive Director,

Education Abroad,  Australia

“Software should be easy
to use. The whole soft-
ware industry has a long
way to go, when it comes
to easy adoption for the
masses.”
—Romasha Roy Choudhury

Business Director,
Cynapse, Mumbai
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Ram Mohan Rao

Here we go again about
man-machine convergence:
two years ago, we spoke about

cyborgs and the engineering of the human
condition. This time it’s about bionics. So why are
we repeating ourselves?

We aren’t. “Cyborgism” is about transcending
human capabilities, about creating supermen.
Bionics is about repairing injured or disabled
humans so they can function normally—as
normally as possible, at any rate. Becoming a
bionic man may not sound as cool as becoming a
cyborg, but the stories are just as fascinating.

“Bionics” actually refers to the application of
mechanisms found in nature to the design of arti-
ficial systems using technology. However, there is
so much usage of the term in the context of
designing body parts that “bionics” is now
almost synonymous with “artificial organs”.

Humans are benefiting from bionics to a
degree of sophistication you wouldn’t believe.
Though expensive, there are bionic eyes,
ears, arms, legs, knees, lungs, livers, you
name it… a bionic anus has been devel-
oped, too, in case you were wondering.
The following, then, is the story of how
technology is repairing bodies and
restoring lost bodily functions—a story
of brain, mind, body, machine.

Sight And Sound
Research into the
possibilities of bionic
enhancements dates
back a long time, but the
first real breakthrough—at
least, the most-remembered
and best-known achievement of the
early days—was the development of a bionic ear.
The Australians are so (rightly) proud of it, it has
been featured on a postage stamp: they call it the
“Australian Bionic Ear.”

Developed by Prof Graeme Clark, the proto-
type was first implanted in an adult at The Royal
Victorian Eye and Ear Hospital in 1978. This one
let the patient hear speech for the most part:
speech, aided by a small processor that the patient
could wear, was analysed and converted to elec-
trical signals that were direct stimulation to the
main hearing nerve.

The bionic ear has been brought much closer
to perfection over the years. It is now more popu-
larly known as the cochlear implant.

In the case of the sense
organs, pretty much the same prin-

ciple applies throughout all implants:
how do we see, and how do we hear? Infor-

mation is converted into electrical impulses that
speed along nerves. The same thing happens in
the Argus II system, which consists of external
glasses, a retinal implant consisting of electrodes,
and a wearable processor. The camera on the
glasses views the image and sends signals to the
processor. These are converted to bio-friendly
information, which is sent back to the glasses and
then wirelessly to a receiver under the surface of
the eye. Once the signals are inside the eye, it’s

easy to imagine: the signal is conveyed to the
electrodes in the retinal implant, which stim-
ulate the retina appropriately. (The retina

then does its job of sending signals to the
optic nerve, which carries on to the brain.)

Note that both systems mimic biology:
they have been inspired by the appropri-
ate biological mechanisms, and they do
almost exactly the same thing their

biological counterparts do. 
Argus II has been given the go-

ahead by the US Food and Drug
Administration, and may be

used in patient trials—initially
with patients over the age of

50. Commercialisation will
happen if successful, and
the system will cost
around $30,000 (Rs 13.5
lakh). It’s obviously not
for everybody—yet.

It’s fine in theory,
but what do patients

experience? It’s encouraging,
but far, very far, from perfect. Terry Byland, then
58, was fitted with an implant in 2004. When it
was done, “It was like seeing assembled dots—now
it’s much more than that,” Byland says. “When I
am walking along the street I can avoid low-hang-
ing branches—I can see the edges of the branches.”
What about faces? “I can’t recognise faces, but I
can see them like a dark shadow.” What this
means is that we’re still a long way from “restor-
ing vision”—it’s more like helping the blind live
their lives without someone (or a dog) having to
guide them all the time.

An Arm And A Leg—And A Mind
Jesse Sullivan can put on his socks, eat without
assistance, and vacuum the floor without assis-

A largish step short of the cyborg, the Bionic Man is already a reality

The Body Beautified



tance, too. This is interesting not because he is
a baby, but because both his arms were ampu-
tated. He now has artificial arms—and they seem
to be doing well.

Sullivan’s arms are a major advancement:
we’ve had externally-powered hands and wrists
and more for many years, but the problem is with
the control mechanisms. These things interface
with the body at the point where the natural limb
was amputated; they are controlled by brain
signals from a pair of muscles there. That allows
only a single motion at a time; for example, to
move the wrist and the elbow at the same time—
try it, it’s easy for us, but impossible with those
prostheses. The system Sullivan has works on a
different principle: researchers at the Rehabilita-
tion Institute of Chicago discovered that when a
limb is lost, the body’s mechanism that controls
the limb—the control signals—are accessible from
nerves that can be grafted to other muscles. This
produces signals that can be used to control pros-
theses in a more natural way.

Such a “muscle reinnervation procedure” is
used in Sullivan’s Bionic Arm. Nerves from the
shoulder were transferred, in Sullivan’s case, to his
chest muscles. The prosthetic arm uses the signals
from the chest, activated by Sullivan’s thought-
generated nerve impulses. As you can guess, elec-
trodes on the surface carry the signals to the arm.
Sullivan doesn’t need to think “somewhere in his
chest” about moving his arm; the nerves have been
transferred, so when he thinks about moving his

elbow, some chest muscle detects the thought, and
the arm moves. It probably takes a lot of getting
used to, but like we said, Jesse Sullivan seems
pleased. This is semi-mind-control, because noth-
ing is connected directly to the brain; we’ll come
to total mind control in a bit.

“Smarts” can be infused into anything these
days, it seems. BBC reporter Stuart Hughes has a
prosthetic leg. He lost his leg stepping on a land-
mine covering the Iraq war. Receiving a pros-
thetic in such a situation is routine nowadays;
what’s special here is that the foot—called the
Proprio—is intelligent. It can detect what kind of
terrain is being walked upon.

“Every type of terrain has a distinct ‘signature’
which the software controlling the foot is able to
interpret. When the microprocessor recognises a
change in terrain, it instructs a motor to auto-
matically adjust the angle of the foot in prepara-
tion for the next step,” explains Richard Hirons of
Ossur, the Iceland-based prosthetics company that
developed the Proprio.

The idea that we’re quickly moving towards
seamless integration of man and machine is
getting more and more commonplace. Saeed
Zahedi, visiting professor in prosthetics at the
University of Surrey, is confident that we could
soon create hybrid limbs that combine natural
tissue with electromechanical devices. “What
we’re seeing at the moment is just the tip of
the iceberg.”

And then, there’s direct mind control. A
company called Cyberkinetics developed a brain-
computer interface called BrainGate, which was
breakthrough enough to have been in the news
the world over. It is actually plugged right into the
brain, and allows the paralysed patient to do
things like control a computer cursor and move a
robotic hand by “thought control,” meaning
thinking about the action does it. Matthew Nagle,
stabbed in 2002 and paralysed from the neck
down, was the first to try BrainGate. Of course, he
still had to sit in a wheelchair all the time, but he
wowed people by controlling a computer cursor
and similar feats. (He actually could beat some
people at Pong.)

Space doesn’t permit talk of all the cool,
groundbreaking stuff going on in the space of
prosthetics and their interfaces and the signals
that control them—see box Links for more. We
should remember that much of this borders on
“cyborgism,” for lack of a better word.

We mentioned the performance artist and
would-be cyborg, Stelarc, in our June 2005 issue—
we quoted him as saying, “The body is neither a
very efficient nor very durable structure…” He
now has an extra ear in his arm and says it could
be “connected to a modem and a wearable
computer, and broadcast RealAudio sounds to
augment the local sounds that the actual ears
hear. This “extra ear” becomes a kind of Internet
antenna that telematically and acoustically scales
up one of the body’s senses.” Stelarc is not very
articulate, and what follows and precedes those
sentences doesn’t make much sense to us. (As an
aside, his Web page is, surprisingly, ghastly.) Why
we’re mentioning Stelarc at all is because it indi-
cates that bionics, as a phenomenon, has excited
the imagination of this new breed of humans that
wants to be wedded to machines.

What’s Ahead?
Plenty. If you’ve been with us thus far, it might just
seem that whatever’s been done only needs to be
improved upon. Not so. Think about one of the
essential problems: how to directly interface devices,
such as implants, to the nervous system. Brand-
new technology needs to be developed for this to
happen. For one example, there’s micro-mechan-
ics, as we learn from Strategic Workshop on Future
Challenges in Bionics, by Giulio Sandini of the
University of Genova. Micro-mechanics would have
to come in if a direct interface between nerve cells
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What kind of
computer signal
would a nerve be
able to under-
stand?

He’s actually repairing a bike! Make no mistake—pros-
theses today allow recipients to be near-normal
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and silicon is to be developed. Micro-mechanics,
because—imagine this—tiny connectors actually
touching individual neurons. Apart from the fact
that it’s all tiny, Sandini explains that bio-compat-
ible materials need to be explored; in addition, a
“micro-environment” suitable for the coexistence
of the flesh and the wires needs to be devised.

Thinking from the ground up, then, we have
more problems. Think of information coding.
What kind of computer signal would a nerve be
able to understand? How can—or should—we fire
neurons? This involves deep study of the language
that nerve cells use amongst themselves, and how
that relates to the impulses we can generate.

Now, if we’re going to have a new kind of
coded information, we’re also going to need a new
kind of information processing. Think about this:
once an implant is in place, the tips of the nerves
and the tips of the electrical interface cannot
possibly be perfect. This means the processor
would need to be tweaked a little to make for a
better implant experience, and for that tweaking
to happen, we need to make sense of the infor-
mation actually flowing within the device.

We also need better and new types of batter-
ies—as in everything digital today. Receivers of, say,
artificial legs, can take their legs off at night and
recharge them from the mains, but what about
those with heart implants? Forget to recharge, and
you pay for it with your life... of course, it’s not
quite that way, but we’re talking about devices
that can be powered by such things as body heat
and limb movement. Like watches that don’t
require batteries, running on the energy generated
by the movement of your forearm.

Then there is the problem of creating new
sensors. Optical and acoustic sensors are reason-
ably acceptable today in terms of quality, but what
about those used in smell and taste? Smell, as you
know, occurs when molecules of a substance
bombard sensors in the nose. We need to create
devices that can actually translate molecular
concentration into computer-friendly signals. 

Endpoint: The Brain
In the ultimate analysis, to make implants work
the way we want them to, we need to understand
how the brain works. Grand dream, naturally, but
little step by little step, that’s the road ahead.

“Philosophers and psychologists have long
noted that human perception has both analogue
and digital characteristics,” says Dr Sebastian
Seung, a professor at MIT and co-author of the
research report we’ll soon talk about. “One
neuron can make another active or inactive, but
the intensity of the activity varies in a continuous
way.” In other words, apart from turning each
other on and off, nerve cells also have analogue
interactions. This is reflected in, say, visual percep-
tion: we make spontaneous yes / no distinctions
like whether it is light or dark outside, but we also
see shades of grey when we need to.

In what seems a breakthrough idea to us—if
not a breakthrough implementation—researchers
at MIT have, using this concept, built a circuit of
artificial neurons with hybrid analogue / digital
interconnections. Details are sketchy, but the
creators believe such circuits can—after refine-
ment—help process auditory and visual informa-
tion for robots. They could also process feedback
information from bionic implants: retinal chips—
as in the artificial eye we talked about earlier—
could at some point be pre-processors feeding into
such circuits, for example.

What is special about the circuit, the way we
see it, is that it mimics the brain. It’s a top-level
idea, and it’s not been seen in action yet, but think
about it: since the brain is the final processor of
information from and to any source in the body—
biological or artificial—it’s natural that the circuits
that interface with it should behave like it.

Such is the road ahead: “Continued research
in neuroscience and bioengineering will no
doubt lead to improvements in man-machine
interfaces and functional replacements, but it
will be a long, hard road filled with many fail-
ures and a few successes.” That’s William Jenk-
ins, Vice President for Development at Scientific
Learning, which makes products that develop
learning and communication skills.

Endnote
So bionics helps the blind see, the wheelchaired
walk, the deaf hear, and more. It’s interesting
that some people look upon the field with a
kinky sort of fascination: going beyond need, as
in patients who need prostheses, they want
implants. What if we could have more than two
arms, Hindu-god-style? When will such things be
socially acceptable? 

We’re veering away again to the realm of
cyborgs, androids, and other such interesting crea-
tures, but then, bionics does straddle the middle
ground between corrective surgery and all this. 

Like we said, it’s not just a question of our
current methods getting better: there are funda-
mental issues to be addressed. Again, like we said,
there needs to be a better understanding of brain
function for bionics to take off.

We cannot end on a predictive note, saying
when those legs will be on the shelves: Jenkins is
probably right. It will be a long, hard road. 

ram_mohan@thinkdigit.com

The extra ear
becomes a kind of
Internet antenna”
Stelarc
Principal Research Fellow
Performance Arts Digital
Research Unit
Nottingham Trent University

http://tinyurl.com/285zhx
A cool robotic hand with ultra-cool fingers. Videos, too.
http://tinyurl.com/yuv677
“Physical Enhancement Page.” Lots of links. Trans-
humanism and stuff.
http://tinyurl.com/2xg2ge
Excellent, long Wired article on The Desire To Be Wired.
http://tinyurl.com/yqkv5v
A company page. They call it “healthcare,” and they talk
about bionic stuff like store products. Don’t skip the part
about the biker.
http://tinyurl.com/yovamq
About the bionic products of Iceland-based Ossur, whom
we mentioned.
http://tinyurl.com/2crlnt
Web site of Victhom, which develops bionic devices.
Videos here too.
http://tinyurl.com/yvdmon
Artificial everything: researchers make kidneys from a
cow’s ear, and more.
http://tinyurl.com/27jdkl
The first completely artificial heart. Videos.

Links
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Digital Passion l Do It Yourself

Asfaq Tapia

Wouldn’t it be ultra-cool to carry around
your very own operating system with
you? Or share an OS with friends? Have

you wanted to build an OS according to your
requirements and needs? If you’ve answered “yes”
to all the above, you’re in for a treat! Here, we show
you how to build your very own, customised Linux
distribution (distro).

For creating our distro, we used Ububtu 7.04
as a base and built over it. We wanted an OS that
would allow us to do the usual Internet brows-
ing, creating documents and spreadsheets,
e-mailing, and playing movies and videos. Here’s
how to do it.

Get hold of the Ubuntu 7.04 ISO file
from last month’s (Anniversary) issue
and install it. You’ll need to be

running in Ubuntu while you create the distro.

Make a list of all the essential
programs you need. We chose NTFS
Read/Write Support, The GIMP, Gaim,

Automatix2, Flash 9 player with the Mozilla
plugin, W32 Codecs, Audio / Video codecs (Bad
and Ugly versions), and VLC Media Player to
make the distro complete.

We now need a program to do our
dirty work because, quite frankly,
building a Live CD the Linux From

Scratch (LFS) way can be quite a pain in the
a***. We chose Reconstructor, a Linux CD
creator. It’s a small download, from http://
reconstructor.aperantis.com/

Fire up Reconstructor with “sudo
python reconstructor.py” in
your Linux Terminal, and you’ll be told

which dependencies you need to install before
you run Reconstructor.

Go to System > Administration
> Synaptic Package Manager >
Settings > Repositories to

make sure the Universe and Multiverse reposito-
ries are selected. Open a terminal and run
“sudo apt-get install squashfs-
tools gcc rsync libbogl-dev libus-
plash-dev gpg dpkg-dev fakeroot
apt-utils” in the terminal window. You
need to be online for this to work.

After downloading the dependencies,
start Reconstructor again and you’ll be
greeted by a welcome screen.

In this new screen, the locations of
working directories need to be set up—
they tell the program where all the files

are stored locally. Select the “Create Remaster”,
“Create Root”, and “Create Initial Ramdisk”
options. These options are used to create the cd-
rom directory tree, the root filesystem directory
tree, and the initial ramdisk tree.

The last option in the window asks for
the location of the main Ubuntu ISO
file, which will be used to replicate the

directory structure. Click the “...” button next
to the Live CD ISO Filename option, and navi-
gate to where the Ubuntu ISO file is located;
then click Next.

This screen is divided into various tabs,
the first being “Boot Screens”. As the
name suggests, this is where you

change the first screen that is shown (the splash
screen) and also the image shown after you
select the boot options. To select an image here,
click the “Generate” button. Select the source
image (which has to be a 256-colour PNG) and
choose where to save it. Reconstructor will copy

We bet you didn’t think it was possible!

Reconstructor’s welcome screen

Make sure all the boxes are checked

Create Your 
Own Linux Distro

Create Your 
Own Linux Distro
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it to the correct directories, automatically
giving you the custom screens. 

You can also change the CD text colour
on the Live CD by clicking on the
button and choosing your colour.

The “Gnome” tab allows you to
change the default login screen,
theme, and fonts of the Ubuntu soft-

ware after it’s installed. Options such as
XDMCP, sounds, and root login can be modi-
fied here. You can either select one of the
default themes, or click
the “...” button next to
the theme selection
option and import a
custom theme. This is
either a tar.gz or a
tar.bz2 package.

Reconstructor then
automatically imports
all icons, themes, and
wallpaper customisa-
tions in the the live cd
environment. Hunt for
more of these at http://
gnome-look.org/

The “Apt” tab allows you to select the
repositories you want available
during the live CD customisation

phase. What impressed us most was that
based on the version of Ubuntu you’re using
as a base, Reconstructor automatically
chooses the corresponding repositories. So
far, so good!

In the next tab—”Live CD”—you can set
the default username, password, and
hostname of the computer.

Once that’s done, move over to the
next tab called “Modules”—the soul of
the program. Towards the bottom half

of the screen, you’ll find options to install or
remove custom programs from the list above.
Here you can add any program that appeals to
you, especially the essentials we mentioned
earlier. There is also an option to “Update
Module”, which allows you to check if the
module is updated.

There are loads of modules available for
Reconstructor; these can be downloaded from
http://reconstructor.aperantis.com/index.php?option=
com_remository&Itemid=33&func=select&id=4 or
http://tinyurl.com/2dthrq. After downloading,
these modules can be added into Reconstructor
by clicking the “+ Add” button. 

Once you have all the modules and customi-
sations in place, click on the Apply button to go
ahead and compile your very own distro!

asfaq_tapia@thinkdigit.com

Adding customisations

Adding Repositories

Set a custom username and password here

Select custom apps in the Modules window

Customising the boot screen settings

There are loads
of modules for
Reconstructor
available for
download



Day 1: Hey there good lookin’…The P535 is beautifully finished in charcoal grey andexudes a quality feel. Even though the side buttons onthe body and the four-way scroll button are chromed, it’smatte, and therefore doesn’t look gaudy. The fit andfinish is excellent, and the rear cover fits f lush—no playeven after multiple SIM card and battery inspections.Accessories are abundant, and their quality is excellent.
Day 5: Pop the hood…
The crisp 240 x 320, 2.6-inch screen is a joy. The P535 isdevoid of a keypad… don’t lose the stylus! There’s a 2.0megapixel camera with auto-focus and flash. Thebattery is 1300 mAh, on par with similar-spec PDAs. Itsinnards consist of a 520 MHz PXA270 processor fromIntel—this provides oodles of clout to run resource-hungry apps. With 64 MB of RAM and 256 MB of fastNAND ROM, the P535 offers more storage than manyother PDAs. More on that later…

Day 7: Cry to me…
While signal reception and call quality is on parfor a PDA phone, I have a gripe with the loudness(or rather the lack thereof) of the speaker. Eventalking about the hands-free, I say my ancientNokia 6630 gives much better sound qualityand volume. Another negative is the 2.5mmjack, this means that my lovely Boseheadphones won’t work with this phone.A plus is the hold switch

reminiscent to the iPods—it
freezes all buttons and screenactivity. 

Day 11: Upward
mobility
Surfed at office using
the P535, the
integrated “g” class
wireless connectivity

is good for road
warriors. The
P535 is also
Bluetooth 2.0

ready and 

supports A2DP, so you can enjoy your tunes with anyBluetooth headset.
Transferring data to my PC using the USB cable wasslow, a little more than I’d have liked—to my dismay, Idiscovered this is a USB 1.1 device.

Day 13: Peashooter!
Necessity demanded I use the camera today. I must say theauto-focus works well, and camera quality is comparableto the similarly-rated K750i.

Day 16: Words…
A conference today. I found jotting down quick notes apain, especially after the full-size QWERTY layout I’maccustomed to. This is not for those into typing long e-mails or documents. You’ll need to invest in a Bluetoothkeyboard. Handwriting recognition is good—at par withother Windows devices.

Day 20: I’m all ears
We were doing some video mixing for a workshop. Iplayed around recording voices, and we all had somefun. Later I transferred these files onto my PC. Soundquality is good, and this is something that can be usedfor the odd interview: the mic is quite sensitive. However,a Dictaphone it’s not.

Day 23: Deck of cards
Attended a client meet today. I used the business cardscanner utility, which I must say works very well,extracting nearly every detail accurately. Very, verynifty… Plus I handled the remote presentation using thebundled application in conjunction with my laptop’sBluetooth. (One installation later, that is.) The softwareworks f lawlessly— another area where you can use theP535, and effectively.

Day 26: Homeward Bound…The P535 is all packed to despatch. My thoughts centreon words like “convergence” and “convenience”—anapposite way to describe a device so small and yet sopowerful. A full keypad less means it won’t replace myPDA. However, for those who won’t miss all those keys,this is one powerful, compact, stylish, yet functionalmobile workstation.

michael_browne@thinkdigit.com

Michael Browne
I’m the Windows Mobile user, who gets poked at for my rather bulky IMate Jasjar, but I love the sheer functionality at my 

disposal. Anyway, since I’m the WM5 user, I got a chance to play around with this beauty…

ASUS P535

Digital Passion l 30 days with...
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Droolmaal The good stuff.
Stuff to lust after.
Stuff for the well-moneyed.

his little gadget is a marriage between a
handheld gaming device and a digital
camera. There’s nothing quite like playing

photographer and then gaming when the creative
juices have run out! The DXG-589V has a video
camera that records at 640 x 480, and a 5
megapixel still camera. The 3-inch screen should be
quite enough for gaming as well as previewing
images and videos. You can even record video
streams using the provided video inputs. An
expandable SD memory slot lets you dump all your
videos and songs onto external storage cards.
There’s also a remote so you can control the camera
from a distance. A gaming + imaging device seems
like loads of fun to us… we shouldn’t have to wait
much longer: it’s expected to be out anytime now.

DXG DXG-589V

T

re you the highly creative painter-designer-artist? Do
you want the ultimate in pointing devices? Do you
have $2,400? Get yourself a Wacom Cintiq 21UX! This

is a 21.3-inch touchscreen LCD that does a resolution of 1600
x 1200. You get a battery-free pen that lets you draw right
on the screen with a whopping 1,024 pressure levels! You get
three standard nibs for the pen, a felt pen nib, and a stroke
nib as well for variety in feel. Finger-sensitive touch-strips
let you easily scroll around and zoom like you would with
your mouse scroll.

There’s more—you get eight customisable buttons. The
screen has two layers, one

meant to reduce glare and
the other to give you a

paper texture. The
makers claim you can

place your rulers,
protractors, and

other measure-
ment tools directly

on the screen—
like you would
on a drawing
board—and go

ahead and draw!
If you don’t have the

$2,400, there’s still hope: you can get
yourself a 200-rupee mouse!

A
n an age where technology
and flamboyancy meet, what
you get is something like the

Nokia 8800 Sirocco Gold. It’s 18-
carat-gold-plated; the scratch-
proof screen is sapphire-coated,
supports a resolution of 208 x
208, and can do 262,144
colours. A colour-matched
Bluetooth headset and
desktop stand comes
with the bundle. A 2MP
camera is thrown in
along with the MP3
player and FM
tuner. The MP3
player supports a
wide range of
audio formats—MP3,
MP4, AAC, eAAC, and
WMA. Onboard memory is 128
MB. The phone lacks an expandable memory slot and also
weights a bit more than most phones, but then it’s about
elegance and luxury more than anything else. Cost? 1,000
(Rs 54,000), excluding taxes.

I

Nokia 8800 Sirocco Gold
Wacom Cintiq 21UX

Digital Passion l Droolmaal
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Sony’s new obsession seems to be tiny
gadgets. Sony claims the HDR-CX6EK HD is
the world’s smallest and lightest

camcorder. It weights just around 370 gm without
the batteries; it can record videos at 1080i and still
images at 6.1 MP. 5.1 Dolby surround sound can be
recorded using the inbuilt microphone. The 2.7-
inch touchscreen is used to view footage and
navigate through the interface. You can also
connect the device to an HDTV and view your shots
using the HDMI interface.

A new feature here is the Face Index, which
detects faces from within videos and creates an
index so you can look for videos of a particular
person by clicking on a thumbnail! The HDR-CX6EK
will set you back by $1200 (Rs 54,000), though.

S

Archos 704 WiFi
e hate to say this, but your 2-inch-screen phone is a sad
excuse for mobile entertainment, put face to face with the
Archos 704 WiFi. You get this device in 40 GB and 80 GB vari-

ants; it has a 7-inch touchscreen that supports a resolution of 800 x
480. A wide range of high-quality video formats such as MPEG4, WMV,
AAC/H.264/MP4, MPEG2, and VOB are supported. Formats like PDF
for books and image formats such as JPG, BMP, and PNG are
supported as well. Hook up the optional DVR Station and it will record
video streams off your TV; it can also play back media on your TV.

Other than playing music and videos, you can also surf the Net
using Opera over the Wi-Fi connection.

And then, you can
turn the device into a
camcorder by hook-
ing it up to certain
digital cameras or to
the optional helmet
camera (a mini-cam
that you can strap on
to your head—which
sports enthusiasts will
love, for example).
You can thus take
advantage of the large
onboard storage. The
expected price for the
80 GB 704 is $550 (Rs
24,750).

W

Digital Passion l Droolmaal

Sony HDR-CX6EK

Microsoft Surface

images from the camera to the phone. We can’t do
justice to it here—you’ll have to see it in action!

We’re excited about this kind of computing, but
we doubt the Surface is going to end up in your
home anytime soon—it’s going to cost between
$5,000 and $10,000 (Rs 2.25 to 4.5 lakh!). We’ve
heard it’s going to be out around the end of this year.

ou’ve probably heard
about the Microsoft Surface—
it’s been all in the news. In case you

haven’t, it has a 30-inch touchscreen display in a 21-inch box
that supports multi-touch; it can be used by many people at
once. It lets you pick up elements such as videos and images
and drag and drop them around, like you would with a
mouse—but only you use your hands! What makes it even
more revolutionary is that you can put a digital camera and a
mobile phone upon it, and they get detected automatically.
You can then view images off the devices, or drag and drop

Y
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Take a Crack 
and win

PC Upgrade & Repair
Street Smarts
by Dave Crane, Bear
Bibeault and 
Jord Sonneveld

Published by 

Rules and Regulations
Readers are requested to

send in their answers by the 15th

of the month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

Last Month’s Solution
Last month’s challenge was to boot into XP
using a floppy disk. Here’s how to do it.

First format a floppy disk using XP’s
format utility: open My Computer, right-
click the floppy icon, and select Format.

Copy the files
ntldr and
ntdetect.com from
the i386 folder in the
Windows XP CD to the
root of the floppy disk.
Then create a file
called “boot.ini” in the
root of the floppy disk
to contain information
corresponding to the
computer which you
want to boot using the
floppy. The boot.ini
file should look
something like this:

[boot loader]
timeout = 30
default =

multi(0)disk(0)rdisk(0)partition(
1)\WINDOWS

[operating systems]
multi(0)disk(0)rdisk(0)partitio

n(1)\WINDOWS = “Microsoft Windows
XP Professional” /fastdetect 

If XP is installed in any directory other
than “Windows”, say “x”, the third line
must read:
default = multi(0)
disk(0)rdisk(0)partition(1)\x

and the fifth line must read:
multi(0)disk(0)rdisk(0)partition(
1)\x = “Microsoft Windows XP
Professional” /fastdetect

Also, in the third and fifth lines, in
partition(y), y indicates the partition
number in which XP has been installed.
Change it to the appropriate value. To find
the exact values for your system, in XP,
right-click My Computer and click on
Manage. Click Disk Management in the
left pane. Now you will be able to view all
the drives and their partitions on the
right-hand side, look at the bottom right
part of the window. Each drive is labelled;
there is the drive letter along with the
drive name, in the next line you will see
the drive capacity and the file-system and
in the 
last line, you will see the health status.
Observe this last line for each drive 
and in one of the drive, you will see the
status as Healthy (System). This is the
boot partition where XP resides. 
Note the disk number, say X, at the right
of this drive, this is the value which you
should put in the rdisk(X). You will be
graphically able to find the partition
number by counting the partition from
left. If the system partition is the first
then you should use partition(1), if 
it is second then it will be
partition(2), an so on.

If the computer boots from a SCSI hard
disk, multi(0) must be replaced by
scsi(x), where x depends upon the
adapter specified in the SCSI driver. If the
scsi(x) option has been made use of in
the boot.ini file, copy the device driver
for the SCSI controller and put it in the
root of the floppy disk, along with the
three other files, and rename it to
ntbootdd.sys.

In the case of SCSI hard disks, in the
third and fifth lines, in disc(z), z
represents the SCSI-ID of the hard disk
that must be booted into. Change it to the
appropriate value. 

THIS MONTH’S CHALLENGE

Win!

R Vinod 
Salem, Tamil Nadu

LAST MONTH’S WINNER

How would you create
custom sound events in
Windows XP?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Boot Into XP Using A Floppy!

DIGIT JULY 2007

Add Sound
Events To XP

Format the Floppy

Create or copy Boot.ini

LAST MONTH’S CHALLENGE
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Nimish Chandiramani

I
t’s not like we have a foot in the grave
here or anything, but every once in a
while, today’s kids make us feel old—
learning how to configure your mobile
phone from a 12-year old doesn’t really

help that youthful feeling. With a PC in nearly
every middle class home, and more on the way,
it’s no surprise that parents summon the off-
spring every time an error message baffles
them. The kids will be exposed to technology
no matter how much you “protect” them from
it—even if you don’t buy a PC; the best you can
do is ensure they’re using applications that will
be of some use to them.

EasyBits Magic Desktop
www.easybits.com
Remember Microsoft Bob? In the days of Win-
dows 3.1, Bob was a new, friendly user interface
for Windows, designed to make computers easy
to use for newcomers. A little dog named Rover
guided you around the OS, telling you what you
could do with it. The idea was nice, but Bob was
a little too friendly and quite an insult to the
intelligence, and finally made it to the Dark
Place where all terrible products end up. When
we first started up Magic Desktop from this

month’s DVD, it reminded us of Bob, only
without the nausea.

Somehow, it’s taken someone this long to
realise that the same idea could apply wonder-
fully to children—Magic Desktop looks like
Windows XP, only with child-friendly colours,
themes and applications—perfect to keep a 5 to
10-year-old off your back. It functions like a pro-
tective layer on your XP installation, blocking
keyboard shortcuts like [Alt] + [Tab] and
[Ctrl] + [Alt] + [Del], and suppressing
applications and dialogs that may pop up in the
background—ensuring that your child doesn’t
stray into your running applications and do
some damage. You’re also given full control
over Internet access—the bundled browser will
load Web sites only after you approve them. The
bundled applications range from simple maths
quizzes to puzzle games, and even a child-
friendly e-mail client! While Magic Desktop
insulates your child from everything else on
your PC, you can decide which applications can
be accessed from within Magic Desktop. 

Lead Feature

Digital Tools l Jumpstart

77
Tools
Digital

50
Technology For Personal And SoHo Productivity

8532 Laptops
Tested!

Tips: Outlook, Linux,
Torrent Clients 

Pixel-perfect

Kids have this annoying habit of getting stuck to PCs—why not make sure they
learn something while they’re at it? 

Hacking The Kid

Magic Desktop’s music player lets your child go wild—
just make sure to turn down the volume

Illustration Chaitanya Surpur 
Photograph Sandeep Patil
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exaggerated—though Celestia is based on actual
data gathered by the Hubble space telescope,
and it does let you navigate to planets and stars
and view them from any angle you like. 

The universe that you view is supposedly in
the state it should be at that instant—if you see
the Earth at point X in Celestia, it’s estimated
that it’s at the same point in real life. We can’t
really verify this, what with being unable to
afford a trip to space, but we’re told that the
estimate is more than dependable. The interface
is quite easy to use—if you’re on a random star-
hunt, just click on a star you like (double-click to
centre that star in your view) and hit [G] to go
to it. After a brief, very Star Trek-like trip, you’re
at the star you chose, with a little scientific infor-
mation about the star at the upper-left corner of
the screen. The best way to start with Celestia,
though, is to run the demo ([D]), which takes you
through the Solar System, some popular con-
stellations, an interesting star or two, and a view
of the Milky Way. It also gives you an idea of the
features you have at your disposal—viewing the
orbits of heavenly bodies, for instance.

For even more educational value, download
the Celestia Educational Activities add-on from
http://celestiamotherlode.net/catalog/educa-
tional.php—the tours of the universe (complete
with sound) are more exhilarating than your
first day at the planetarium. Each activity comes
with a guide for educators—helpful if you’re
teaching a group of children about the universe.

Scratch
http://scratch.mit.edu/
You can’t argue that software programming isn’t
a lucrative career today—and India’s already
booming IT industry still has a long climb ahead
of it—we haven’t built our answer to Microsoft
yet, have we. We’re not asking you to breed soft-
ware engineers, but monetary promises aside,
programming also teaches children to think ana-
lytically, break down problems to little bits, and
generally figure out how technology works.

The researchers at MIT’s Lifelong Kinder-
garten project have come up with the Scratch pro-
gramming language, which teaches children
programming through visual elements. Loops, for
example, are shown as bright orange clamps that
enclose code, and the code itself is a bunch of
statements inside interconnecting blocks. Think
of it as drawing a flowchart before actually
coding, only the flowchart is the code itself. The
resultant program isn’t one of those boring old

One of the features we liked was the bonus
system—to ensure that your child doesn’t get
attached to just one program, you can assign
bonus points to applications that you want your
child to access on a regular basis, multiplication
tables for instance. These points can then be used
to access other applications like games or the
browser. The message you send your child is
clear—do your duties and your rights will follow. 

Once the ten-use demo expires, you can pur-
chase Magic Desktop for $29.99 (Rs 1,350), and
we highly recommend that you do.

Google Earth
http://earth.google.com/
Children don’t like geography, mostly. Think
back to times when you really couldn’t care less

what the Steppes were (we used to think grass-
lands were really big gardens) and the world’s
miscellaneous geographical formations were
just new words to remember. 

Google Earth takes all that away and actually
makes learning about the world fun—it brings the
Atlas to life. We don’t really need to tell you much
about it—it’s been talked about in these pages many
times, and you’ve got it off our DVD often (at least,
we hope you have). A lot of new overlays have been
added to the new Google Earth—you can now view
photos from Panoramio, a community project that
matches photos to the locations they were taken
at. You can take a photograph of the neighbour-
hood garden, for example, and mark the garden’s
location on Google Earth—anyone moving over that
area will then be able to see your photo. The whole
process of touring the earth looking at everyone’s
photos can be mesmerising. But we digress.

It shouldn’t take much thought to assess
Google Earth’s educational value—schoolchildren
will be able to appreciate the places they read about
better when they’ve seen them from above, for one.
Turn on the National Geographic Magazine layer in
the left pane to take your child through their Africa
Megaflyover—interesting sights (no sounds) from
the Dark Continent. Geographical formations will
also make much more sense when you get to see
what they look like outside the textbook. 

You could even recommend it to your child’s
schoolteacher, and maybe you’ll have a classful
of geography geeks on your hands.

Celestia
www.shatters.net/celestia/
What Google Earth is to, well, Earth, Celestia is
to the universe! All right, so that’s perhaps a tad

Don’t you wish you had this when you were in school?

Boldly go where no child has gone before

Google Earth
actually makes
learning about
the world fun—it
brings the Atlas
to life
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console programs—the scripts you create apply to anima-
tions. You can create games, presentations, and even what
they like to call “interactive art.”

Check out the Web site to see what Scratch is capable
of, and sit down with your child and create your next
masterpiece together—you can even share it on the site!

Sid Meier’s Railroads!
www.2kgames.com/railroads/railroads.html

Every child needs a break from all that learning, and
Sid Meier’s Railroads! is the way to do it. Miniature
train sets are nothing short of captivating, and this
game will let your child do it in the style of the origi-
nal rail barons of long ago. The challenge is to set up
a rail network in the map you play (parts of North
America and Europe, mostly), manage your finances,
make profits, buy and sell companies, and get rich
before your opponents do. You get to play as and
against some of rail history’s biggest names, and the
game features a veritable encyclopaedia of informa-
tion on each railway engine and the history of the
first railways in general. For a full review of
Railroads!, pick up our January 2007 issue. 

We’re honestly not sure what the lesson is here—
maybe your teen (the game isn’t for the too-young) will
learn the basics of managing incomes, expenditures
and loans; perhaps they’ll learn the basics of the stock
market… you never know. What we do know, however,
that Railroads! is one of those few games that gives the
mind a good, solid workout, and that’s always good. 

nimish_chandiramani@thinkdigit.com

MIT’s Scratch teaches children programming the only way they’ll learn—with lots of
visual elements

Let Railroads! teach your child the basics of squishing the opposi-
tion—through smart resource management, of course
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COMPUTING COMFORT
You know you want one, but an informed decision you can make not. We can change that. In
test… 32 of the best!

Michael Browne

T
he words portability, connectivity,
and convenience describe the need for
laptops best. It’s important to be con-
nected at all times these days: knowl-
edge received late is knowledge lost in

many cases. Then there are those emergencies
when you just have to jot down a few notes, and
a paper and pen aren’t within reach…

There are also those for whom a laptop is
not a necessity but part of their lifestyle—a
classy extension of oneself, a wardrobe acces-
sory, or even a status symbol.

Anyone who has ever attended a LAN party
will testify to the pain in the neck, shoulders,
and other regions that result from lugging a
bulky cabinet, LCD, or worse still—a CRT, and
peripherals about. Now think convenience.
Although a laptop is still not a Desktop replace-
ment for gamers, a good mouse coupled with a
reasonably-configured laptop will see you
through most fragging sessions just as easily.

Inbuilt goodies like memory card readers,
wireless connectivity, and Bluetooth are some-
thing 99 per cent of Desktops won’t have.
Although a fast Desktop would still leave the
best-performing laptops grovelling in the dirt,
the point here is that notebooks are a solution
for various needs—and manufacturers are
tailoring them to suit those.

A word about the reviews
that follow: Acer, Dell,
and Fujitsu are going
through a product
refresh cycle. The
older models are
no longer avail-
able, and the new
range wasn’t out
at the time of this
writing. Expect
reviews of laptops
from those manufactur-
ers in our Bazaar section in
the issues to come.

Value Laptops
This category is the most
populous of the four.
Compaq aside, we have
mostly home-grown
brands here. In fact, if you
want a big-brand laptop
and are restricted to the

45K price point, we suggest you dump the idea
of a big brand altogether. While we haven’t yet
gotten to US prices, its good to see Indian ven-
dors taking such aggressive price points. Bear in
mind that hardware scales with price, so a
Rs 20K laptop will most certainly win no pro-
cessing accolades.

ACI was present in force in this category
with four models. Compaq and Intex featured a
model each; LG and HCL featured three apiece.
Zenith made it to the party with two laptops.

Features
The most attractive notebook here is the
Compaq Presario v3225AU. The palm-rest and
even the outer lid feature the same treat-
ment HP uses on its high-end DV series.
This material is extremely smooth to
the touch, and it seems it will easily
withstand the rigours of daily use.
It’s a real pity that HP chose to
use the same material on the
touchpad. This makes it too
slippery—just not enough
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feedback. Slightly less painful—but painful nev-
ertheless—are the too-soft mouse keys. The
Presario v3225AU also has a slightly flawed key-
pad: use it a bit and you’ll notice the keys have
too much travel. However, keypad feedback is
largely subjective, and some people like soft
keypads. (We don’t.) On a positive note, the lay-
out of the keypad is very good. 

All the ACI laptops except for the Ethos C
have great keypad feedback. Our gripe was the
lack of shortcut keys—an Internet key and a
media player button just do not cut it. The
Ethos C does feature shortcut keys to switch off
Wi-Fi and the touchpad, though.

The Zenith Director with its silver and grey
colour tones will appeal to the corporate user
segment, which, as you can see from the name,
is its intended audience. The only ergonomic
issue we could find was the largish spacing
between the keys—not good unless you’re used
to it. The Presidio, too, featured a great keypad,
and in a tiny body. We didn’t place this one in
the ultra-portable category because of its
weight and thickness.

Intex’s M54N doesn’t feature a very good
finish, but we’ll forgive that considering the
price. What we won’t forgive is the tacky,
chromed shortcut key buttons. The carry bag is
beautiful and sturdy. 

Some of the ACI laptops—the Ethos series—
feature a little subwoofer directly underneath
the touchpad. This is supposed to provide
improved bass, but it just doesn’t!

Performance
The Core Duo processors here gobble up all the
benchmarks that have anything to do with
number-crunching.

The second-most important aspect of a lap-
top is the storage subsystem, which often
becomes a bottleneck.
The two LG RD400s
and the Compaq
Presario v3225AU have
a strong storage subsys-
tem, as the scores testi-
fy. If your applications
lean towards this trend—
for example, transferring
large files, or opening
large images in PhotoShop,
you know where to look—at
this price point.

The ACI Duo 1430 and 1430D
offer very good multimedia performance,
as their scores in 3D Mark 2005 and our game
tests revealed. This makes them suitable for play-
ing the occasional game… movie playback is also
guaranteed to be skip-free, although the quality
of the LCD panel should have been better, in
keeping with such good graphics performance.

The Conclusion
The Presario v3225AU isn’t shy on features,
with touch controls similar to that of the DV
series, and dedicated buttons for wireless con-
nectivity—not to mention superb build and
attractive looks. This one just had to be a 
winner. The Digit Best Buy Gold is with the

Compaq Presario v3225AU: unbeatable value
at Rs 32,990. 

The T2350-powered Zenith Director is our
Digit Best Buy Silver winner: unbeatable

value and great performance for the price—
only Rs 29,700.

If you want something half-decent to
game with in this price category, ACI is the
only way to go, with the Ethos Duo 1430D
actually featuring NVIDIA graphics hard-
ware (the GeForce Go 7300 series).

If you’re looking at something
compact at a ridiculously

low price, the Zenith
Presidio will surely
please your aesthetic

sensibilities as well as your
wallet. At Rs 28,700, it’s a steal. Drop in

a little more memory and watch this little
notebook really run—very suitable for most
everyday applications.

PERFORMANCE LAPTOPS
There exists a cadre of users that will not be
satisfied with just good performance at a
value-for-money price point. They’ll want bet-
ter graphics—perhaps a discrete graphics solu-
tion; more CPU horsepower; and memory
bandwidth to handle it. These are the users
who will also be likely to need more storage
space. We discuss, in this section, laptops that
cater to this user profile.

Features
There was a lot of beauty in this category—from
the dusky, all-black, matte-finished Lenovo R61
ThinkPad, to the flashy and even more eye-
catching HP DV6226tx. While the R61 seems to
draw you in subtly, the DV6226tx simply grabs
you by the scruff and demands attention with
the kind of piano finishes we’ve seen on much
more expensive hardware. Equally attractive is
ASUS’ F3Jc: it features a very pleasing black and
dark grey finish.

The LG X Note P1 has a very alluring shape,
and the quality of fit and finish is excellent.
The white, matte-finished body immediately
attracts more than just a cursory glance. A pity
they used navy blue on the lid—it gives the
effect of a school uniform. Or could that have
been intentional…?

Once again, the coating treatment given to
the DV6226tx’s palm-rest, ditto the outer lid, is
absolutely top-notch. Equally tasteful is the sub-
tle and flowing patterns adorning the entire
top body and inside, which we’re told is
inspired from Japanese rice fields. It seems, in
Japan, paddy is grown not in straight rows but
in flowing, curved patterns. Whatever the inspi-
ration, the result is stunning!

Equally cool are the media buttons above the
keypad: they’re touch-activated and a cool backlit
blue! Also bundled is a tiny IR remote for Media
Center purposes. This tasteful blue extends to the
power jack area, which will illuminate when the
adapter is connected to the mains. All this blue is
attractive without hitting you in the face in any
way. The speaker grille is also attractive, and
proudly sports “Altec Lansing.” As we’d expected,
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Compaq Presario v3225AU
Exceptionally good value

Zenith Director
Sturdy, rugged, great value
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sound quality and volume levels are better than
on most other laptops.

The R61 is all about quality. It has that subtly
sturdier build that comes from use
of quality material both inside
and outside. All ThinkPads
come with hard drive protec-
tion inbuilt, and the R61’s hard
drive head will park if the sensor
inside the notebook detects a
sharp change in G force (as in a
fall). Loads of nifty little features
like a light near where most laptop
webcams are ensures that your key-
pad stays illuminated even if the
rest of your room is not. The R61 also fea-
tures a brilliantly crisp resolution—1440 x
900—something all but extinct in this category.

ASUS’ F3Jc has a beautiful keypad—well-
laid out, and even better feedback. The feed-
back from the touchpad is also positive and
accurate, in fact, it’s on par with the excellent
ThinkPad R61. A far cry from this is the HP
DV6226tx; as with the Presario v3225AU, the
touchpad offers insufficient feedback due to
its slippery-smooth surface.

52

Incidentally, ASUS’ F3Jc also has DVI con-
nectivity—a welcome and rare feature.
Equally rare was the fact that this laptop
ships with two batteries—one compact for 
regular use, and the other a large 7200 mAh
battery pack.

Performance
The Lenovo R61 features a jaw-dropping T7700,
the absolute top-end laptop processor from
Intel’s Core 2 Duo line-up. Running at 2.4 GHz
and featuring an 800 MHz FSB, this CPU happi-
ly ate up all the data it was being fed by the 2
GB of fast 667 MHz memory that the R61 has
under its hood. Coupled with the Intel 965PM
a.k.a. the Santa Rosa platform, the R61 is an
über-number-cruncher.

ACI’s Matrix 1501 is another hot performer,
featuring the T7200 processor and 2 GB of
memory. Additionally, this laptop features the
ATI X1600 graphics processor with 256 MB of
dedicated video memory—enough to send most
casual games into orbit.

A shade behind these come the ACI Matrix
1425, HP DV6226tx, and ASUS F3Jc, featuring
the NVIDIA 7400/7300 Go.

We slotted the laptops into four categories.
Value Laptops (up to Rs 45,000): The laptops here are mostly
entry level solutions from most vendors. However, recent price
reductions also mean this category holds exceptional value for
money. Better hardware is trickling down to this segment.
Performance Laptops: This category comprises the laptops with
good enough configurations for power users and those who demand
more processing power and speedier performance.
Ultra-portables: These are for those who want something with a small
footprint: something light, and therefore easy to carry around. This
category is populated by models with screen sizes up to 12.1 inches.
Lifestyle Notebooks: These have nothing in common really, aside
from the fact that they’re different! Everyone would love to own one,
they have oomph. They’re drool-worthy.

Pre-test
We did a clean format on all the laptops, creating a primary partition
of 30 GB and a secondary partition of what was left. We installed a
fresh copy of Windows XP SP2 on those laptops that came bundled
with Windows XP. The ones bundled with Windows Vista got a fresh
copy of Windows Vista Ultimate Edition. We used all the latest drivers
from the manufacturers’ Web sites.

Features
We took special note of ergonomics—something that most people fail
to realise is very significant. We rated the keypad layout, the feel of
the keys while typing, and ergonomic enhancements like switches
and buttons for enabling and disabling functions like Bluetooth, Wi-
Fi, the touchpad, and more. We also rated the feel of the palm rest,
another significant, oft-overlooked parameter. 

Finally, we rated the laptops on their build quality, looking
separately at parameters like body, keypad, and movable parts.

We felt it equally important to rate specifications like storage
space, the presence of connectivity options, the number of USB and
FireWire ports, and functional add-ons like card readers and webcams. 

Performance
Our tests, as always, consisted of a gamut of synthetic benchmarks
and real-world tests.

Synthetic Tests
PC Mark05 tests a computer’s most pivotal components and provides
a macro as well as micro look of those. The CPU, hard drive, memory,
and graphics subsystems are benchmarked, and an individual as well
as overall score is brought up.

3D Mark 2005 is a well known graphics subsystem test. It tests
the pixel and vertex processing of a graphics solution and brings up
an overall score.

We used DisplayMate to judge the quality of the screens. In
particular, we concentrated on its suite of colour tests.

WirelessMon 2.0 was our benchmark of choice to test signal
strength (as a percentile) in Zones 1 and 2. For those who remember,
we used these Zones in our Wireless Router/Access Point test earlier
this year. For those who don’t, Zone 1 was a replication of a scenario
where the laptop and the wireless access point were in the same room,
though approximately 15 feet apart. Zone 2 saw the access point and
the test subject 25 feet apart with a cement wall in between. 

Real-World Tests
We used a 1080i clip to test the candidates on their ability to provide
a good movie-watching experience. We watched for skipping of video
and audio, as well as screen anomalies. We judged onscreen colour
rendition.

Our video encoding test consisted of a 100 MB .VOB file being
converted to DivX. This is a test of the laptops’ CPUs more than
anything else, but hard drive and memory performance do play a
small part.

The file transfer test saw us copying a 1 GB file from the primary
partition to the secondary partition of the laptops’ hard drives. This
tests the storage subsystem.

Our game benchmarks consisted of an OpenGL and a DirectX
based game each, Far Cry and Doom 3 respectively. These games
were benchmarked via a fixed “timedemo” (a rendered clip
consisting of a fixed number of frames), with settings at medium,
and the resolution at 800 x 600.

In the wireless bandwidth test, we transferred a 50 MB file
wirelessly between a Desktop hooked up via RJ45 to the access point
(802.11g ready) and the test subject. To arrive at the bandwidth
figure, we divided the file size by the amount of time taken.

How We Tested

HP DV6226tx
A great buy!
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The Conclusion
When it comes to ergonomics, none can hold a
candle to the HP DV6226tx and the Lenovo R61,
although HP’s keypad feedback is an adverse
factor. Try as they might, the HCL Z22 CDP and
the LG X note P1 BP33A can’t stand in the same
league as the others in this comparison,
even though the X note P1
is shockingly costlier than
the HP DV6226tx.

It’s no surprise, then,
that the combination of
good processor, great graph-
ics, and excellent pricing,
along with a lot of goodies
(like the great speakers,
touch controls, and wireless
remote) help the HP
DV6226tx bag our Best Buy
Gold award. This notebook makes
a very good buy if you’re looking for a
powerful and attractive solution, or even if
you’re interested in a good multimedia solution
with a lot of show and functionality.

Very close on its heels comes the attractive,
powerful, and ergonomic ASUS F3Jc, our Best
Buy Silver winner. In fact, there’s less than a
point of a gap between our Gold winner and
this one: it is a good performer that builds upon
a solid feature list and ergonomic package.

Although LG’s X-Note P1 is also an attractive
solution, one look at the price makes it seem
lacklustre—it’s more expensive than the superi-
or DV6226tx, and within a hairsbreadth of the
excellent ASUS F3Jc.

Lenovo’s excellent ThinkPad R61 deserves a
mention here. It doesn’t win Gold, but this is
mainly due to its astronomical price:
Rs 1,55,000, which is more than double that of
the next-costliest option (the Matrix 1501). The
high price is mainly due to the T7700, which is
a costly part, and, of course, the ThinkPad
branding. However, cheaper CPU options are
available in the ThinkPad lineup. If you must
have the best possible CPU and are willing to
pay for the peace of mind associated with the
rugged ThinkPad brand, the R61 is definitely
the quickest way there.

Gaming, did you say? The only notebook
here worthy of your attention and your cash
would be the ACI Matrix 1501. Though it’s
boxy, and the touchpad isn’t the best around,
the combination of a strong processor with a
sterling graphics solution make it ideal for
gamers. The price (Rs 77,999) will hurt a bit,
but the performance should take some pain
off the sting.

ULTRA-PORTABLES
While 17-inch laptops have blurred the line
between laptops and Desktops—in fact, they’re
called Desktop replacements—they’ve moved
away from what a notebook PC is meant to be:
nicely portable. So if you’re frequently on the
go, or just want something light and slim, 
yet powerful, in short a real notebook, then 
an ultra-portable is for you. We must caution
you though—ultra portables are generally 
costlier than a similar-specification-bearing
“regular” notebook.

ASUS F3Jc
Good performer, great value
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BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 48)
Performance (Out of 38)
Price Index (Out of 14)
FFeeaattuurreess
Component Specifications
Processor Model No.
Processor Speed 
RAM (MB) / Type / Speed (MHz)
Chipset
Graphics Solution
Onboard Video Memory
Audio Solution
HDD Size
Bundled OS
Characteristics
Screen Size 
Screen Resolution (Native)
Weight (kg)
No. of Ports (USB / FireWire)
Connectivity (LAN / Bluetooth / Wi-Fi)
Memory Card Reader / Types of Cards
Inbuilt Webcam (✔/✖)
Build (Scale of 10)
Build Quality (Body)
Build Quality (Keypad)
Build Quality (Lid, Movables)
Ergonomics 
Keypad/Touchpad Tactile Feedback (So 10)
Key Layout (Scale of 10)
Shortcut Keys/Switches (Scale of 10)
Biometrics Login (✔/✖)
WiFi On/Off Switch (✔/✖)
Bluetooth On/Off Switch (✔/✖)
TouchPad On/Off Switch (✔/✖)
PPeerrffoorrmmaannccee
Synthetic Scores
PC Mark 2005
CPU / Memory Score
Graphics / HDD Score
Overall
SiSoft Sandra 2007
Drive Index / Memory Bandwidth (MBps)
3D Mark 2005
Display Mate Tests
Colour Accuracy Test (Avg) (Scale of 10)
Battery Life Test (Hours:Minutes)
WiFi Signal Test (Wireless Mon) (%)
Zone 1 / Zone 2
Real-World Tests
HD Movie Viewing (Scale of 10)
Video Encoding (100 MB file) (sec)
File Transfer Test (1 GB test file) (sec)
DOOM 3 (fps) (800 x 600, medium detail)
FarCry (fps) (800 x 600, high detail)
Wi-Fi Performance (Zone 2) (MBps)

Scoreboard                      Value Laptops: Up to Rs 45,000  
ACI

Emerald

25,999
+ Attractive, cheap

– Low on storage space

50.54
20.79
17.15
12.60

Pentium M 730
1200 MHz
512 / DDR2 / 533
Intel i915GM
Intel GMA 900
Shared
Realteck ALC 880
60 GB
Windows XP Pro

15”
1024 x 768
2.40
4,1
✔/✔/✔

✔/ SD, MMC, MS, xD
✔

6.00
6.00
6.00

6.50
5.50
5.50
✖

✖

✖

✖

1925 / 1861
555 / 2943
1357

36 / 1787
201

5.75
2:34

25 / 15

5.00
216.50
118.93
6.30
2.59
1.89

ACI
Ethos C

31,199
+ Decent specs

– Keypad layout

46.40
18.28
17.62
10.50

Pentium M 730
1600 MHz
512 / DDR2 / 667
Intel i915GM
Intel GMA 900
Shared
Realteck ALC 655
80 GB
Windows XP Pro

14.1”
1280 x 800
2.30
3,1
✔/✔/✔

✔/ SD, MMC, MS, xD
✔

6.25
6.00
6.00

5.75
5.50
4.25
✖

✖

✖

✖

2568 / 2458
679 / 2657
1693

31 / 2270
187

5.25
2:32

25 / 12

5.00
245.40
89.80
5.60
2.30
2.01

ACI
Ethos Duo 1430

36,399
+ Good keypad feedback

– Plain looks

54.55
20.74
24.81
9.00

Core 2 Duo T2350
1866 MHz
512 / DDR2 / 667
Intel i945GM
Intel GMA 950
Shared
Realteck ALC 880
80 GB
Windows XP Pro

14.1”
1280 x 800
2.30
3,1
✔/✔/✔

✔/ SD, MMC, MS, xD
✔

6.00
6.00
6.00

6.50
5.25
4.25
✖

✖

✖

✖

3364 / 2105
1912 / 2645
3165

34 / 2899
1645

5.25
2:36

24 / 12

5.75
213.20
63.76
14.70
12.82
1.54

ACI
Ethos Duo 1430D

41,599
+ Good specs and performance

– Plain looks

53.57
20.74
24.96
7.87

Core 2 Duo T5200
1600 MHz 
1024 / DDR2 / 533
Intel i945GM
NVIDIA Geforce Go 7300
256 MB
Realteck ALC 655
80 GB
Windows XP Pro

14.1”
1280 x 800
2.3
4,0
✔/✔/✔

✔/ SD, MMC, MS, xD
✔

6.00
6.00
6.00

6.50
5.25
4.25
✖

✖

✖

✖

3465 / 2210
1898 / 2564
3156

31 / 2939
1685

5.25
2:40

23 / 14

5.50
210.50
63.60
43.80
45.40
1.47

Compaq
Presario v3225AU

32,990
+ Great looks, good performance

– Sticky touchpad

58.25
26.51
21.81
9.93

Turion 64 ML-36
2000 MHz
512 / DDR2 / 667
NA
NVIDIA GeForce Go 6150
Shared
Cx20549@NVIDIA nForce 430 
80 GB
Windows Vista Home Basic

14.1”
1280 x 800
2.46
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.50
6.50
6.50

6.50
6.50
6.00
✖

✔

✔

✖

2802 / 3331
1178 / 3764
2187.00

38 / 4270
283

6.00
3:00

25/14

6.25
192.45
83.90
10.10
6.80
1.58
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HCL

S21 CMP

29,990
+ Decent integrated graphics

– Bulky, weak CPU

53.43
23.31
19.20
10.92

Intel Celeron M410
1466 MHz
512 / DDR2 / 533
ATI Radeon Xpress 200M
ATI Radeon Xpress 200M
Shared
Realtek ALC 660
80 GB
Windows Vista Starter

15.4”
1280 x 800
2.80
4,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.00
6.00
6.00

6.00
6.00
5.00
✖

✔

✖

✖

2293 / 2185
479 / 3074
1789

29 / 2610
511

6.00
3:02

23/13

5.75
194.34
58.63
6.60
5.70
1.76

HCL
K21 PDC

37,490
+ Good configuration

– Bulky

52.89
23.79
20.36
8.74

Dual-core Pentium T2080
1733 MHz
512 / DDR2 / 533
ATI Radeon Xpress 200M
ATI Radeon Xpress 200M
Shared
ALC 660
120 GB
Windows Vista Home Basic

15.4”
1280 x 800
2.80
4,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.00
6.00
6.25

6.00
5.75
5.00
✖

✔

✖

✖

2356 / 3215
467 / 3278
1876

32 / 3274
521

6.00
2:55

23 / 12

6.00
123.40
62.50
4.30
2.80
1.86

HCL
X22

39,990
+ Fast CPU

– Tacky shortcut keys

53.65
23.74
21.72
8.19

Core 2 Duo T2350
1866 MHz
1024 / DDR2 / 533
Intel i945GM
Intel GMA 950
Shared
AD 1986A
120 GB
Windows Vista Home Basic

15.4”
1280 x 800
2.30
4,1
✔/✖/✔

✔/SD, MMC, MS Pro
✔

6.00
6.00
6.25

6.25
6.00
5.00
✖

✖

✖

✔

4237 / 2804
668 / 3481
2987

35 / 3040
560

6.00
3:00

24 / 12

6.00
140.42
57.14
Failed
4.59
1.53

Intex
M54N

38,990
+ Attractive looks

– Low on RAM

49.97
20.89
20.68
8.40

Core 2 Duo T2050
1060 MHz
512 / DDR2 / 667
Intel i945GM
Intel GMA 950
Shared
Realtek ALC883
60 GB
Windows XP Pro

15.4”
1280 x 800
2.00
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.00
5.75
6.00

6.00
6.00
4.75
✖

✖

✖

✖

2484 / 3295
573 / 3354
1921

32 / 3432
673

5.50
3:04

24 / 15

5.50
145.67
85.65
6.40
4.34
1.75

LG
RD400 5D23A2

28,990
+ Great Value

– Relatively slow CPU

49.24
18.37
19.57
11.30

Celeron M440 
1866 MHz
512 / DDR2 / 667
Intel i940GML
Intel GMA 950
Shared
Realtek ALC262
80 GB
FreeDOS

14.1”
1280 x 800
2.35
3,1
✔/✖/✔

NA
✔

5.75
6.00
6.25

6.50
6.25
5.50
✖

✖

✖

✖

3068 / 2722
719 / 4094
2023

40 / 2852
Failed

5.75
2:45

21 / 13

6.00
135.30
97.40
6.70
5.35
1.31

LG
RD400 5D4A2

37,990
+ Great value, good config

– Plain looks

45.87
16.88
20.37
8.62

Core 2 Duo T2050
1733 MHz
512 / DDR2 / 667
Intel i943GML
Intel GMA 950
Shared
NA
80 GB
FreeDOS

14.1”
1280 x 800
2.60
3,1
✔/✖/✔

NA
✔

6.00
6.00
6.00

6.50
6.25
5.00
✖

✖

✖

✖

3230 / 3100
696 / 3865
2465

38 / 3005
573

6.00
2:34

23 / 13

6.00
143.54
101.50
5.60
4.87
1.22



Digital Tools l Laptop Test

BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 48)
Performance (Out of 38)
Price Index (Out of 14)
FFeeaattuurreess
Component Specifications
Processor Model No.
Processor Speed
RAM (MB) / Type / Speed (MHz)
Chipset
Graphics Solution
Onboard Video Memory
Audio Solution
HDD Capacity
Bundled OS
Characteristics
Screen Size
Screen Resolution (Native)
Weight (kg)
No of Ports (USB, FireWire)
Connectivity (LAN/Bluetooth/WiFi)
Memory Card Reader/Types of Cards
Inbuilt Webcam (✔/✖)
Build (Scale of 10)
Build Quality (Body)
Build Quality (Keypad)
Build Quality (Lid, Movables)
Ergonomics 
Keypad/Touchpad Tactile Feedback (So 10)

Key Layout (Scale of 10)
Shortcut Keys / Switches (Scale of 10)
Biometrics Login (✔/✖)
Wi-Fi On/Off Switch (✔/✖)
Bluetooth On/Off Switch (✔/✖)
TouchPad On/Off Switch (✔/✖)
PPeerrffoorrmmaannccee
Synthetic Scores
PC Mark 2005
CPU / Memory Score
Graphics / HDD Score
Overall
SiSoft Sandra 2007
Drive Index / Memory Bandwidth (MBps)

3D Mark 2005
DDiissppllaayy  MMaattee  TTeessttss
Colour Accuracy Test (Avg) (So 10)
Battery Life Test (Hours:Minutes)
WiFi Signal Test (Wireless Mon) (%)
Zone 1 / Zone 2
Real-World Tests
HD Movie Viewing (Scale of 10)
Video Encoding (100 MB file) (sec)
File Transfer Test (1 GB test file) (sec)
DOOM 3 (fps) (800x600, medium detail)

FarCry (fps) (800x600, high detail)
Wi-Fi Performance (Zone 2) (MBps)

Value Laptops: Up to Rs 45,000  
LG

X Note R400 E277A2

44,990
+ Well priced

– Poor onboard graphics

45.82
18.50
20.04
7.28

Core 2 Duo T2350
1866 MHz
512 / DDR2 / 667
Intel i945GM
Intel GMA 950
Shared
Realtek ALC262
120 GB
Vista Home Basic

14.1”
1280 x 800
2.60
3,1
✔/✖/✔

NA
✔

6.00
6.00
6.00

6.50
6.00
5.00
✖

✖

✖

✖

4261 / 2781
356 / 3422
2896

32 / 2986
Failed

6.00
3:10

24 / 12

6.00
142.67
114.32
Failed
3.20
1.85

Zenith
Presidio

28,700
+ Very compact, functional

– More memory needed

53.21
23.04
18.76
11.41

Pentium M 740
1333 MHz
256/  DDR / 266
Intel i915GM
Intel GMA 900
Shared
Realtek ALC655
60 GB
Windows XP Pro

12.1”
1280 x 800
1.90
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.25
6.25
6.25

6.75
6.50
5.00
✖

✔

✖

✖

2784 / 2333
624 / 3102
1751

34 / 1754
Failed

6.00
3:03

25 / 14

5.50
165.18
72.80
5.80
2.40
1.64

Zenith
Director

29,700
+ Handsome, VFM

– Bulky, low on RAM

57.55
26.01
20.51
11.03

Core Duo T2350
1866 MHz
256/DDR2/667
Intel i945PM
Intel GMA 950
Shared
Motorola Si3054
80 GB
Windows XP Pro

15.4”
1280 x 800
2.40
4,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.50
6.25
6.25

6.25
6.00
4.00
✖

✔

✔

✖

4154 / 2635
778 / 3585
2647

40 / 2958
180

6.25
2:45

25 / 13

5.75
180.20
75.80
5.50
2.10
1.42

BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 44)
Performance (Out of 46)
Price Index (Out of 10)
FFeeaattuurreess
Component Specifications
Processor with Model Number
Processor Speed
RAM (MB) / Type / Speed (MHz)
Chipset
Graphics Solution
Onboard Video Memory
Audio Solution
HDD Capacity
Bundled OS
Characteristics
Screen Size
Screen Resolution (Native)
Weight (kg)
No. of Ports (USB / FireWire)
Connectivity (LAN / Bluetooth / Wi-Fi)
Memory Card Reader / Types of Cards
Inbuilt Webcam (✔/✖)
Build (Scale of 10)
Build Quality (Body)
Build Quality (Keypad)
Build Quality (Lid, Movables)
Ergonomics 
Keypad/Touchpad Tactile Feedback (So 10)
Key Layout (Scale of 10)
Shortcut Keys / Switches (Scale of 10)
Biometrics Login (✔/✖)
Wi-Fi On/Off Switch (✔/✖)
Bluetooth On/Off Switch (✔/✖)
Touchpad On/Off Switch (✔/✖)
PPeerrffoorrmmaannccee
Synthetic Scores
PC Mark 2005
CPU / Memory Score
Graphics / HDD Score
Overall
SiSoft Sandra 2007
Drive Index / Memory Bandwidth (MBps)
3D Mark 2005 Score
DisplayMate Tests
Colour Accuracy Test (Avg) (Scale of 10)
Battery Life Test (Hours:Minutes)
Wi-Fi Signal Test (Wireless Mon) (%)
Zone 1 / Zone 2
Real-World Tests
HD Movie Viewing (Scale of 10)
Video Encoding (100 MB file) (sec)
File Transfer Test (1 GB test file) (sec)
DOOM 3 (fps) (800 x 600, medium detail)
FarCry (fps) (800 x 600, high detail)
Wi-Fi Performance (Zone 2) (MBps)

Scoreboard                      
ACI

Matrix 1425

51,999
+ Reasonably-priced

– Dated Looks

53.30
23.53
21.81
7.96

Core 2 Duo T2300
1666 MHz
2048 / DDR2 / 533
Intel i945PM
NVIDIA GeForce Go 7300
256 MB
AD1986A
120 GB
Windows XP Pro

14.1”
1280 x 800
2.40
4,1
✔ / ✔ / ✔
NA
✔

6.00
5.00
6.00

6.50
5.50
4.75
✖

✖

✖

✖

3886 / 2733
1919 / 3065
3371

31 / 3614
1703

5.25
2:25

23 / 15

6.00
150.00
78.90
44.10
47.78
1.76
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Performance Laptops
ACI 

Matrix 1501

77,999
+ Great for gaming

– Plain-looking

55.81
26.17
24.33
5.31

Core 2 Duo T7200
2000 MHz
2048 / DDR2 / 533
Intel i945PM
ATI Radeon X1600
256 MB
Realtec ALC882
160 GB
Windows XP Pro

15.4”
1280 x 800
2.90
4,1
✔ / ✖ / ✔
✔ / SD, MMC, MS
✔

6.00
6.00
6.00

6.00
5.50
4.75
✖

✖

✖

✔

5082 / 3997
3075 / 3214
4595

39 / 3636
3734

5.00
2:30

23 / 12

6.00
110.50
75.95
66.00
79.19
1.77

ASUS
F3Jc

60,250
+ Good performance, looks

– None in particular

56.22
29.04
20.31
6.87

Core 2 Duo T2050
1600 MHz
1024 / DDR2 / 667
Intel i945PM
NVIDIA GeForce Go 7300
512 MB
Realtec ALC660
100 GB
Windows XP Pro

15.1”
1280 x 800
3.10
4,1
✔ / ✖ / ✔
✔ / SD, MMC, MS
✔

7.50
7.00
7.25

7.00
7.25
6.75
✖

✔

✖

✔

3632 / 2517
1856 / 3319
3205

31 / 3203
1591

6.50
4:05

25 / 14

6.50
158.62
93.62
44.00
46.04
2.12

HCL
Z22CDP

45,990
+ Good value

– Boxy look

51.87
27.81
15.06
9.00

Core 2 Duo T5300
1733 MHz
1024 / DDR2 / 533
Intel i945GM
Intel GMA 950
Shared
AD 1986A
160 GB
Vista Home Premium

15.4”
1280 x 800
2.30
4,1
✔ / ✔ / ✔
✔ /SD, MMC, MS Pro
✔

6.00
6.25
6.00

6.00
6.00
5.00
✖

✖

✖

✔

4309 / 3184
654 / 3707
3002

28 / 2452
456

5.75
3:20

25 / 12

6.00
135.30
76.20
Failed
4.50
1.57

HP
DV6226tx

56,990
+ Funky looker, good features

– Needs better graphics

59.17
31.23
20.68
7.26

Core 2 Duo T5200
1600 MHz
1024 / DDR2 / 667
Intel i945PM
NVIDIA GeForce Go 7400
128 MB
Cx20549
120 GB
Vista Home Premium

15.4”
1280 x 800
2.50
4,1
✔ / ✔ / ✔
✔ /SD, MMC, MS Pro, xD
✔

7.00
7.00
7.00

6.00
7.25
6.50
✖

✔

✖

✔

4004 / 3164
1922 / 3321
3166

34 / 3564
1662

6.75
3:40

23 / 13

7.00
135.26
81.20
40.90
42.30
2.00

LG
X Note P1 BP33A2

59,990
+ Great looks and keypad

– None in particular

46.97
25.16
14.91
6.90

Core 2 Duo T2250
1733 MHz
1024 / DDR2 / 667
Intel i945GM
Intel GMA 950
Shared
Realtek ALC883
100 GB
Vista Home Premium

15.4”
1280 x 800
2.60
3,1
✔ / ✔ / ✔
✔ /SD, MMC, MS Pro
✖

6.25
6.00
6.00

7.00
7.00
6.25
✔

✖

✖

✖

3934 / 2689
654 / 3225
2654

28 / 2957
530

6.00
3:20

24 / 14

6.00
148.21
121.40
Failed
4.72
1.64

Lenovo
R61

155,000
+ Sturdy, powerful, feature-rich

– Expensive

52.25
29.83
19.75
2.67

Core 2 Duo T7700
2400 MHz
2048 / DDR2 / 667
Intel 965PM
NA
NA
NA
160 GB
Windows Vista Ultimate

15.4”
1440 x 900
2.70
4,1
✔ / ✔ / ✔
✔ /SD, MMC, MS Pro
✔

7.25
7.00
7.50

7.00
7.00
7.00
✔

✖

✖

✖

6230 / 4287
1055 / 4653
4976

37 / 4620
760

7.00
3:10

26 / 15

6.25
84.82
119.43
14.40
9.10
1.97
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Digital Tools l Laptop Test

Features
The vanilla-plain ACI Dimiq 1200 and the boxy
HCL W9504 PMP730 are (you guessed it!) the sim-
pletons of the ultra-portable world. The Compaq
Presario B1950 is also rather plain-jane, though
we must say the build quality of
all three models is
quite good.

If we could reward
outright beauty, we’d
have to have cataracts in
both eyes not to accolade
Sony for the raw sex
appeal exuding from the
Vaio SZ483N. An absolute-
ly gorgeous-looking hunk
of carbon fibre—yes, real
carbon fibre—and brushed
aluminium alloy encompasses
some of the fastest hardware you’ll see
under a 12.1-inch form factor. This laptop is
also ultra-light, courtesy the carbon fibre, and
has brilliant ergonomics. Placement of switches
and even keypad layout is typically Sony-pre-
cise. The only sore point with the ergonomics is
the mushy keypad; there is also excessive key
travel. The presence of biometrics security via a
fingerprint scanner is another utilitarian fea-
ture, and we found logging in very convenient—
no passwords, just a finger-swipe.

Equally brilliant is the Stamina mode, some-
thing the Vaio series proudly sports. There’s a
switch provided, right next to the Wi-Fi on/off
switch that actually switches between Intel
onboard graphics and an NVIDIA 7400 Go solu-
tion, with a system restart of course.

ASUS’ W5Fe is another standout looker with
a secondary 2.8-inch LCD screen embedded in
the laptop cover. This tiny screen can be used to
control a media player. Incidentally, using this
screen doesn’t eat up system memory: it has
1 GB of Flash memory all to itself. ASUS is to be
commended on the brilliant touchpad and key-
pad feedback.

LG’s X-Note C1 looks neat—it’s a tablet-PC-
type swivel. This is misleading (fooled us!) as it
isn’t a tablet PC (no touch-screen). The quality
of build is good, and though keypad feedback is
very good too, the keypad itself isn’t too well
laid-out. Still, it was heartening to see this stur-
dy little contestant sport a Core Duo processor
with a gigabyte of RAM and a GeForce 7300 Go
graphics solution.

Compaq’s Presario B1950 had an ace up its
sleeve that some of the costlier HP models
couldn’t match—its touchpad has a matte finish
unlike the smooth finishes on the DV6226tx
and DV9223tx, and therefore provides more
feedback and greater accuracy while scrolling.

Performance
Although performance is definitely not the
forte of ultra-portables, prepare to be shocked
when you look at the figures the ultra-thin,
ultra-light Sony Vaio SZ 483N chalked up.
Sporting a top-of-the-line series T7400 Core 2
Duo and a GeForce 7400 Go solution, this note-
book is eminently suitable for all your mobile
computing needs. The white LED display is crisp

and clear, and working with Windows Vista
Ultimate was a pleasure. Add to the equation a
massive 160 GB hard drive under that tiny
hood, and you’ll learn to overlook that
Rs 1,24,990 price tag. The Vaio SZ483N also has
an excellent wireless solution, and a bandwidth
of 2.36 MB/s is enough for even the heaviest
browsing and downloading.

A surprise performer was the tiny 10.6-inch-
screen-bearing X-Note C1 from LG. With a Core
Duo processor that admittedly isn’t in the
Vaio’s league, and a modest GeForce 7300 Go
GPU under the hood, this notebook is a great
performer too.

The only other laptop that clung to these
two leaders was the ASUS W5Fe, whose tena-
ciousness has to be seen to be believed, consid-
ering the lack of dedicated graphics. The ASUS
does outscore the X-Note C1 as storage space
goes, however.

Among the performance minnows, the
Dimiq 1200 fights a valiant albeit doomed-
from-the-start battle against the Presario B1950
and the HCL W9504. It’s placed last.

The Conclusion
Our hearts prevailed here. The gorgeous Vaio
SZ483N/C wins our Best Buy Gold award by a
mile and then some! Seriously, take a look at
our tables, and you’ll see nothing even comes
close to the Vaio in this category: a surefire case
of done and dusted. This laptop should be the 
ultimate weapon of choice for the discerning
road warrior. 

The next-best thing according to us, and
our Best Buy Silver winner, is ASUS’ funky
and functional W5Fe, at a price of just
under a lakh.

If you want something reasonably fast
in this category but aren’t willing to
shell out a penny over 50K, the Compaq
Presario B1950 is definitely worth tak-
ing a long look at. It’s got all the fea-

tures, it’s light, ergonomic, and has
a great touchpad—all this in

a sturdy body that isn’t
too hard on the eye.

Though definitely not a show-
stopper, it gets the job done.
As funky as the LG X-Note C1 is, we don’t

recommend busting 100 grand on something
so frivolous when at 25K more, Digit’s Golden
Boy can be yours!

LIFESTYLE NOTEBOOKS
Ever feel proud driving down an expressway in
your new Honda City only to be overtaken and
dusted by a two-bit kid in a BMW M3? While we
don’t earn enough to be in either drivers’ shoes,
we understand (really!) how either one would
feel. For people who really wish to wear their
attitude, we’ve got not one but five of these
babies, just in case you happened to be on the
losing side of our analogy.

Just ASUS and HP make it to this category,
where flaunt takes equal ranking with quality—
and, of course, performance. Each of these lap-
tops is different in a big way. They are targeted
at different audiences.

Sony Vaio SZ 483N/C
The ultimate mobile powerhouse

J U L Y  2 0 0 7

ASUS W5Fe
Two screens—we love it!
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Digital Tools l Laptop Test

Features
The largest, TFT-wise, is the 17.1-inch HP
DV9223tx—a massive laptop that looks the
proverbial Goliath to the ultra-portable Davids.
Top-quality material and build is something
we’ve come to expect from HP now, and this lap-
top epitomises it all. The black piano finish is
classy, and the same, subtle rice-field-style
design we spoke about on
the HP DV6226tx is
present here. Once
again, a set of blue
backlit touch con-
trols give a dash of
colour to the func-
tionality. In fact, there
are more such controls,
given the larger surface
area HP had to play
around with. The speak-
ers are once again Altec
Lansing, and once again
excellent. The key travel is a
little more than we’d like, and the
slippery touchpad we have (sigh!) learnt to
live with. Once again, a Media Center remote is
bundled—couch potatoes, take heed!

ASUS’ G1S looks like a large hunk of plastic
with a carbon fibre top. This is an all-thrills,
some-frills gaming laptop that is very clear
about its reason for existence. Though not built
on slim, attractive lines, the G1S isn’t meant to
be so, going instead with the beefy look.
Pandering to the frag-happy fraternity is no
easy task, but ASUS has been up to the chal-
lenge for some time now. The G1S uses a lot of
green from the embedded dual fluorescent LED
strips down each side of the cover to the very
green-looking ASUS symbol for gaming, that for
all the world looks like an “eye” to us to liven up
things. There’s a G2S, too, not tested here, that
comes with blood-red lighting and matching
colour tones.

That said, the G1S has a lovely, spacious key-
pad that returns brilliant feedback. The only
issue is the misleading markings on the small
Shift keys: we kept hitting the wrong key as a
result. The matte-finished touchpad returns
sweet feedback, and is smooth enough to not
fatigue your finger while scrolling around dur-
ing prolonged use. Equally nice are the play but-
tons on the front, mounted atop a grey steel
bezel. Not so classy is the fluorescent green sur-
rounding the webcam—a little overdone in our
collective opinion. Incidentally, the G1S has a
terrific set of speakers for a laptop.

The ASUS Lamborghini VX1 has a hood—
umm, lid—just like its namesake. Did we men-
tion it even looks like the famous automobile?
With excellent materials and build quality, the
VX1 is simply stunning, supermodel stuff, but
then it has a pedigree to live up to! Once again
an excellent keypad layout; brilliant feedback
on both the keys and the touchpad make this
laptop a pleasure to work with. The material on
the palm rest area (some sort of buffed metal) is
even better than HP’s excellent piano finishes.
The screen is a gorgeous 1400 x 1050 pixels, the
highest-resolution TFT in this test.

ASUS’ S6F is as tiny as its brothers are large.
In fact, this would make a champion ultra-
portable. It’s small enough to pass off for a
ladies’ handbag, and the leather coating simply
lulls your senses into believing it’s little more
than just that—a fancy handbag! Then there are
the jewelled hinges and the ultra-attractive
indicator LEDs for various functions. We also
liked the unique coating on the keypad, and
the dark grey really looks good. If any laptop
was meant to look like a fashion accessory, this
one looks the part. The screen, though tiny, is
nonetheless crisp, and the keypad and touch-
pad work beautifully.

HP’s TX1016au looks like it just stepped off a
Versace ramp. Decked out in silver and black fin-
ery, the TX1016au is a Tablet PC complete with a
swivelling screen, a bundled pen (no smudgy fin-
gers on me please!), a wireless remote, and (oh
joy!) a biometric device (fingerprint scanner).
The swivel is extremely well-built: excellent fit
and finish.  The keypad is sufficiently tactile,
although we didn’t like the tiny Shift keys. The
touchpad, which is sieve-patterned (heavily dim-
pled) returns ample feedback, but will result in
a sore fingertips after extended use.

Performance
Based around Intel’s latest Crestline (965PM)
chipset, the ASUS G1S puts an Intel T7300 CPU
and 2 GB of memory to proper use. The graph-
ics solution is what any gamer worth his salt
will be interested in, however, and with a
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ASUS G1S
Great for gaming, multimedia
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Digital Tools l Laptop Test

BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 47/ 48 for Ultra Portable)
Performance (Out of 45/ 38       -do- )
Price Index (Out of 8/ 14           -do- )
FFeeaattuurreess
Component Specifications
Processor Model No.
Processor Speed 
RAM (MB) / Type / Speed (MHz)
Chipset
Graphics Solution
Onboard Video Memory
Audio Solution
HDD Capacity
Bundled OS
Characteristics
Screen Size
Screen Resolution (Native)
Weight (kg)
No. of Ports (USB / FireWire)
Connectivity (LAN / Bluetooth / Wi-Fi)
Memory Card Reader / Types of Cards
Inbuilt Webcam (✔/✖)
Build (Scale of 10)
Build Quality (Body)
Build Quality (Keypad)
Build Quality (Lid, Movables)
Ergonomics 
Keypad/Touchpad Tactile Feedback (So 10)
Key Layout (Scale of 10)
Shortcut Keys / Switches (Scale of 10)
Biometrics Login (✔/✖)
Wi-Fi On/Off Switch (✔/✖)
Bluetooth On/Off Switch (✔/✖)
TouchPad On/Off Switch (✔/✖)
PPeerrffoorrmmaannccee
Synthetic Scores
PC Mark 2005
CPU / Memory Score
Graphics / HDD Score
Overall
SiSoft Sandra 2007
Drive Index / Memory Bandwidth (MBps)
3D Mark 2005
Display Mate Tests
Colour Accuracy Test (Avg.) (Scale of 10)
Battery Life Test (Hours:Minutes)
WiFi Signal Test (Wireless Mon) (%)
Zone 1 / Zone 2
Real-World Tests
HD Movie Viewing (Scale of 10)
Video Encoding (100 MB file) (sec)
File Transfer Test (1 GB test file) (sec)
DOOM 3 (fps) (800 x 600, medium detail)
FarCry (fps) (800 x 600, high detail)
Wi-Fi Performance (Zone 2) (MBps)

Scoreboard                      Lifestyle Laptops  
ASUS

Lamborghini VX1

177,000
+ Superlative in all aspects

– Price also superlative!

64.18
32.04
29.09
3.05

Core 2 Duo T7400
2133 MHz
2048 / DDR2 / 677
Intel i945PM
NVIDIA GeForce Go 7400
512 MB
AD1986A
160 GB
Windows XP

15.1”
1400 x 1050
3.00
4,1
✔/✔/✔

✔/ SD, MMC, MS
✖

7.50
7.00
7.25

7.00
7.00
6.50
✖

✔

✔

✔

5236 / 4005
2623 / 3175
4623

36 / 4027
2237

7.00
2:50

22 / 15

7.00
101.80
70.00
60.80
66.31
2.30

ASUS
G1S

99,000
+ Ultimate configuration

– Some keypad quirks

68.51
28.43
34.63
5.45

Core 2 Duo T7300
2000 MHz
2048 / DDR2 / 677
Intel 965PM
NVIDIA GeForce Go  8600GT

256 MB
Realteck ALC 655
160 GB
Windows Vista Ultimate

15.4”
1440 x 900
3.10
4,1
✔/✔/✔

✔/ SD, MMC, MS
✔

7.25
7.00
7.25

7.00
5.75
6.50
✖

✖

✖

✔

5033 / 4238
4654 / 4236
4217

37 / 4358
7672

7.00
2:10

26 / 15

7.25
103.46
58.93
136.80
94.56
2.45

ASUS
S6F

109,800
+ Designer looks

– Performance

54.64
28.44
21.28
4.92

Core Duo LV2400
1666 MHz
1024 / DDR2 / 533
Intel i945GM
Intel GMA 950
Shared
Realteck ALC 660
80 GB
Windows XP Pro

11.1”
1366 x 768
1.37
1,1
✔/✔/✔

✔/ SD, MMC, MS
✖

7.00
7.25
7.25

7.00
6.00
6.25
✖

✔

✔

✖

3661 / 2588
1050 / 3270
2656

34 / 3570
530

6.25
2:23

23 / 14

5.75
172.56
86.29
7.80
3.69
2.15

HP
DV9223tx

89,990
+ A superb bundle

– Slightly bulky

68.97
30.40
32.57
6.00

Core 2 Duo T5500
1666 MHz
2048 / DDR2 / 667
Intel i945PM
NVIDIA GeForce Go 7600
512 MB
Cx20549
2 x 160 GB
Vista Home Premium

17.1”
1440 x 900
3.10
4,1
✔/✔/✔

✔/SD, MMC, MS Pro, xD
✔

7.00
6.75
7.00

5.75
6.75
6.50
✖

✔

✖

✔

4173 / 3488
3876 / 4111
3345

39 / 3613
3294

6.75
3:23

26/15

7.25
126.90
27.73
93.20
47.05
1.82

HP
TX1016au

74,990
+ Value, Performance, Showy

– Rough touchpad

63.53
31.20
25.13
7.20

Turion 64 X2 TL-60
2000 MHz
2048 / DDR2 / 667
NVIDIA Geforce Go 6150
NVIDIA Geforce Go 6150
Shared
Realtek ALC 862
160 GB
Vista Home Premium

12.1”
1280 x 800
1.40
3,1
✔/✔/✔

✔/SD, MMC, MS Pro, xD
✔

7.25
6.75
7.00

6.00
6.50
7.00
✔

✖

✖

✔

3949 / 3350
961 / 3297
3104

35 / 3453
897

6.50
3:34

24/14

6.75
124.50
78.30
11.50
9.45
2.21

JULY 2007 JULY 2007



61DIGIT JULY 2007

Ultra Portable Laptops
ACI

Dimiq 1200

51,999
+ Really compact

– Hard keypad

50.18
23.12
16.29
10.77

Core 2 Duo T5200
1600 MHz
1024 / DDR2 / 533
Intel i945GM
Intel GMA 950
Shared
Realteck ALC 260
120 GB
Windows XP Pro

12.1”
1280 x 800
1.90
3,1
✔/✖/✔

✔/ SD, MMC, MS, xD
✖

6.50
6.25
6.50

6.75
5.50
4.25
✖

✔

✖

✖

2288 / 2574
770 / 2654
2067

38 / 2806
416

5.75
2:30

22 / 14

5.25
225.03
64.56
8.60
3.94
1.59

ASUS
W5Fe

99,000
+ Novel features

– More memory needed

55.00
29.39
19.95
5.66

Core 2 Duo T5600
1833 MHz
1024/DDR2/667
Intel i945GM
Intel GMA 900
Shared
Realteck ALC 660
160 GB
Vista Home Premium

12.1”
1280 x 800
1.70
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

7.50
7.00
7.25

7.00
6.25
7.25
✖

✔

✖

✖

4596 / 3606
876 / 3678
3532

39 / 3403
549

6.75
3:10

24 / 15

6.25
118.71
68.76
Failed
6.15
1.86

Compaq
Presario B1950

44,990
+ Good touchpad

– Lower feature set

53.23
24.23
16.55
12.45

Core 2 Duo T2250
1733 MHz
512 / DDR2 / 667
ATI Radeon Xpress 200M
ATI Radeon Xpress 200M
Shared
Realteck ALC260
80 GB
Windows Vista Home Basic

12.1”
1280 x 800
1.80
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✔

6.25
6.50
6.50

6.50
6.00
6.00
✖

✖

✖

✖

2567 / 3100
1086 / 3453
2016

35/3890
210

6.00
2:40

23 / 13

6.00
189.63
112.30
14.35
9.45
2.02

HCL
W9504 PMP730

41,990
+ Good value for money

– Somewhat thick

52.31
21.68
17.29
13.34

Pentium M 730
1600 MHz
1024 / DDR / 333
Intel G915GM
Intel GMA 900
Shared
Realtek ALC 655
60 GB
Windows XP Pro

12.1”
1024 x 768
1.80
3,1
✔/✖/✔

✔/SD, MMC, MS Pro
✖

6.00
6.00
6.25

6.50
6.25
5.00
✖

✔

✖

✖

3200 / 2756
675 / 3245
2256

34 / 2456
566

5.75
3:20

23 / 12

6.00
156.20
102.50
6.50
5.70
2.14

LG
X note C1

99,900
+ Very light, fancy looks

– Expensive

49.37
23.22
20.54
5.61

Core Duo ULV U2500
1200 MHz
1024 / DDR2 / 533
Intel i945PM
NVIDIA GeForce Go 7300
64 MB
Realtek ALC883
80 GB
Vista Home Premium

10.6”
1280 x 800
1.30
3,1
✔/✔/✔

✔/SD, MMC, MS Pro
✖

6.00
6.25
6.00

6.25
5.75
6.00
✖

✖

✖

✖

3023 / 2400
1850 / 3400
1895

24 / 2992
1362

5.75
2:50

20 / 12

5.50
136.80
91.50
38.20
31.13
1.90

Sony Vaio
SZ 483N/C

1,24,990
+ Fast, light, functional

– Mushy keypad

62.46
31.15
26.83
4.48

Core 2 Duo T 7400
2166 MHz
2048 / DDR2 / 667
Intel i945PM
NVIDIA GeForce Go 7400
64 MB
Sigma Tel STAC 9872AK
160 GB
Windows Vista Business

13.3”
1280 x 800
1.69
2,1
✔/✔/✔

✔/MS Pro, Duo
✔

7.00
6.00
7.00

4.50
6.75
7.00
✔

✔

✔

✖

5476 / 4152
2585 / 3320
4436

33 / 3380
1654

7.00
3:10

27 / 15

6.75
92.00
67.80
46.40
46.74
2.36
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Digital Tools l Laptop Test

GeForce 8600GT with 256 MB of integrated
DDR3 memory, the G1S ripped through all our
game benchmarks. As 136-odd frames in Doom 3
testify, this laptop can be used for gaming at
reasonably high resolutions on most of the cur-
rent crop of games.

The DV9223tx features the next-best graph-
ics card—a Go version of NVIDIA’s GeForce 7600
with 512 MB of video memory. Although not in
the G1S’ league, this is the second-fastest gam-
ing solution from among all the categories.
Both the VX1 and the GS1 feature blazing
processors, though none of the other three
could be termed slow. The only AMD solution
was on the TX1016au, a Turion X2 TL 60 that
will handle all the processing you can throw at
it without breaking into the proverbial sweat.
An integrated graphics solution of the GeForce
Go 6150 cadre ensure this is no slouch in the
multimedia department either. The DV9223tx
manages to conceal a whopping 320 GB of stor-
age space in its admittedly large shell.

The ASUS S6F lags behind even the
TX1016au, but who’s noticing anything behind
all that leather anyway? Even though the
TX1016au lags behind the group, it’s not what
you could term a slowcoach. Unless you plan on
serious gaming, the TX1016au should pull
through most applications.

The Conclusion
There were two very serious inter-brand rival-
ries throughout our tests as ASUS and HP fight
it out, with neither willing to give ground to
the other, and any victories won were extreme-
ly hard-fought! At the top, the G1S goes the dis-
tance with the DV9223tx. What it gains in per-
formance, it loses on features. They end up
within 0.5 points of each other. The second bat-
tle takes place a couple of rungs lower as the
VX1 takes on the TX1016au—these two boys also
finish within a point of each other.

The little S6F loses out on performance
points, but is nonetheless a powerful mobile
platform in a tiny shell.

After some debate, we decided that since it
was such a closely-fought contest, there should
be two Gold awards, and no Silver. The ASUS
G1S (Rs 99,000) and the HP DV9223tx (Rs 89,990)
both win the Digit Best Buy Gold award.

If you want something fashionable that is
guaranteed to get drool out wherever you go,
the TX1016au is something you should serious-
ly look at. Not only is it brilliantly-priced for a
dual-core laptop with 2 GB of memory, you get
a host of nifty add-on functions—biometric

security, a touchscreen and a tablet form factor
(swivel), and a backlit array of touch buttons for
media playback.

The ASUS Lamborghini is for those who
aspire towards the car but fall short by a mil-
lion-odd dollars. It’s costly, but then you get to
flaunt the badge at a tiny fraction of the price.
It’s fast, too, and extremely functional. We’d
have loved to indulge in this sinful fantasy, but
at Rs 1,77,000 (the yellow version costs a shade
under Rs 2,00,000), even organ-donating won’t
make up the deficit…

Closing Thoughts
Notebook computers have taken strong steps
towards becoming adequate processing power-
houses. While they still aren’t in the Desktop
league and perhaps will never be—as the yard-
stick for Desktop performance also keeps
increasing—they can easily compete on process-
ing power, be it CPU or GPU, with the best
Desktops of three years ago. They’ve become
customisable too, with vendors offering a

choice of components.
Intel’s current Core 2 Duo based platform,

the Santa Rosa, has brought with it a host of
new, powerful features—as well as price cuts
throughout Intel’s older chipset line-up,
namely the Napa and Sonoma platforms.
Intel has chosen to go the platform way,
offering the Centrino as a three-part solu-
tion consisting of the processor, the chipset,

and the wireless solution. AMD choos-
es a different path by offering

just the processor, and leaving
it up to the vendor to choose

the chipset and other components. With
the current range of Core 2 and Core processors,
it seems Intel’s platforms are suddenly formida-
ble, and if sales figures are any indication, Intel
has been steadily encroaching on AMD’s note-
book market share ever since the Core 2 Duo.
Santa Rosa offers a staggering number of fea-
tures, which includes wireless 802.11n support,
Vista-supporting display adapters, and an 800
MHz bus with low power states. (Santa Rosa is
also known as Centrino Pro.)

Further on the horizon lurks Montevina,
scheduled for a 2008 second quarter release, and
support for the upcoming Penryn range of proces-
sors with power consumption figures in the
range of 29 W on the 45nm fabrication process.

AMD has been cooking up the successor to
their Kite and Kite Refresh platforms in the form
of their upcoming Turion platform, which will
feature more energy-efficient Turion X2 proces-
sors, possibly on a smaller fabrication. Support
for the emerging 802.11n, HyperFlash, and
Hybrid Hard Drive support, along with support
for faster memory, is also on the cards. AMD’s
Fusion processors are also expected in 2009, and
this should also cause a chipset overhaul.

With Vista and its heavy Aero interface
already being bundled with most notebook
computers these days, and the ever-increasing
army of resource-hungry applications emerg-
ing, we’ll soon need every bit of processing
juice manufacturers can muster. 

michael_browne@thinkdigit.com

PhoneCompany E-mailBrand

Contact Sheet Laptops

ACI
ASUS
Compaq
HCL
HP
Intex
Lenovo
LG
Sony
Zenith

ACI Technologies
ASUS Technology Pvt Ltd
Hewlett-Packard India 
HCL Infosystems Ltd
Hewlett-Packard India 
Intex Technologies (India) Ltd 
Lenovo India Pvt Ltd
LG Electronics India Pvt Ltd
Sony India Pvt Ltd
Zenith Computers Limited

022-40607000
022–6676 8800
1800-425 66 99/0124-2838700
9818989875
1800-425 66 99/0124-2838700
011-30888906/07
080-22108490 
0120-2560900/940 Ext 245
66006600 / 1800-11 11 88
022-28377300 Ext 377

sales@aci-asia.com
media_india@asus.com 
tapoti-t.tipnis@hp.com 
product.lab@hcl.in
tapoti-t.tipnis@hp.com 
sanjay@intextechnologies.com
buy@in.lenovo.com 
salvi@lgindia.com
sonyindia.care@ap.sony.com
sgulvady@zenith-india.com 

HP DV9223tx
Full-fledged entertainment
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When we unpacked the
Genius Traveler 355

Laser, it looked like any
other notebook mouse—
small and pretty, but with a
blue light where the scroll
wheel would normally have
been. We discovered the

middle button is no

longer just a
clickable scroll wheel. It has
an optical scanner that
tracks the motion of your
finger over it, and lets you
scroll in any axis. It still
functions as a button. This is
a good, unique feature:
you’ll no longer have a roller
getting spoilt after a few

months of use. 
The mouse supports

resolutions of 800 and 1600
dpi. The only way to switch
between them is to press
all the three buttons
together—we tried this, and
found no indication of
what dpi we were
switching to or using, on-
screen or in the drivers!

Left-handed users
should have no problem
using this one. The
mouse is small and lacks

curves and ergonomic
shape, though. Still, overall,
the comfort level is OK.

The mouse tracks well,
and thanks to its lightness, it
slides well on most surfaces.
The optical scroll we talked
about tracks vertical
movement well, but
horizontal movement seems
a little sluggish.

Build quality is pretty
OK, but the cable is
definitely a concern. It is
really thin—almost half the
thickness of that of a typical
desktop mouse.

The software CD installs
the drivers by itself and the
software for the mouse.
Installed were some 15-odd
processes, which ate up 60 to
65 MB of memory! Other
than the standard tasks like
changing sensitivity and
scroll speed, setting the
action for the middle click is
about the biggest thing you
can do with the drivers.

You’re better off using the
default Windows drivers.

The one good thing we
could agree on was the
mouse itself—performance
was more than satisfactory.
It is really small and pretty
light, which makes it
suitable for any laptop user.

The price tag of Rs 1,800
is a wee bit high—wired
notebook mice would be
cheaper. For the additional
price, you get unique features
like the optical scroller, and
pretty good performance.
Buy this mouse if it fits your
budget, but keep away from
the drivers!

Specifications
USB interface; resolutions: 800
/ 1600 dpi; Vista compatible

The diNovo Edge is
Logitech’s costliest

offering from its keyboard
line-up. It is thin and sleek—
just around 1 cm tall. 

The frame is sturdy; it
has a layer of Plexiglas on
top, which gives it a nice,
glossy finish. The
downside, however, is that
you’re bound to get
scratches and fingerprints
on it. It won’t go down too
well with users with sweaty
hands either. But there’s no
denying it looks great.
There’s a brushed metal
panel to complement the
glossy Plexiglas.

With the short key
travel, this feels like a laptop
keyboard. A circular
touchpad acts as a mouse.
Moving your finger around
the edges lets you scroll
vertically and horizontally.
The touchpad is pretty
small, though, and is a little
cumbersome to use. It can
be turned off if you’d like.

There is no numeric
keypad, and many of the
keys have been made smaller
to accommodate them in
the small, sleek form factor.
The touch slider for volume
control is a good addition.
Indicators light up when you
press some of the keys.
Pressing the Function key
[FN], for example, lights up
the multimedia buttons,
which are coupled with the
function keys ([F1] through
[F12]). There are buttons
for putting the PC into

standby, for opening the
default media player, and for
muting system sound.

The wireless Bluetooth
connection worked perfectly
fine with no glitches from
20 ft or so. Also, we should
mention that you get a chic
charging dock to go with the
looks of the keyboard itself.

Sleek and elegant it
may be, but the feel of the
keys really lets the diNovo
Edge down. The high price
tag of Rs 15,995 is another
major downside. Other
keyboards from Logitech
with more features—such

as the G11 and the G15—
are priced at half that
much or less. Those are a
lot bulkier, and are meant
for gaming. The only
saving grace for the diNovo
Edge is its looks. 

Specifications
Dimensions: 11 x 410 x 210 mm;
weight: 940 gm; Bluetooth 2.0;
inbuilt 950 mA Li-ion battery

Genius Traveler 355 Laser
A unique notebook mouse

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS

Contact: Logitech India
Phone: 022-26571160
E-mail: kavita_nath@logitech.com
Web site: www.logitech.com
Price: Rs 15,995

Contact: KYE Systems India Ltd
Phone: 011-41580611
E-mail: sales_india@
geniusnet.com.tw
Web site: www.geniusnet.com
Price: Rs 1,899

We test the latest hardware 
and software products available 
in the marketBazaarBazaar

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS

Logitech diNovo Edge
An expensive keyboard for the style-conscious
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The Sony NW-A805
player’s format and style

resembles that of many
compact phones, only this
one comes with three big
buttons. There are four other
direct buttons to navigate
through the interface
displayed on the crisp 2-inch
colour LCD screen.

The player has 2 GB of
internal memory, and no
expansion slots. You can play
audio and video, and view
images on it. Certain audio
enhancement features—
DSEE (Digital Sound
Enhancement Engine) and
VPT (Virtualphones
Technology)—are built into
the player. DSEE is supposed
to enhance quality, and VPT

means you get virtual
surround sound. A feature
called Dynamic
Normalization helps balance
out major volume jumps
between tracks.

The player comes with
canal earphones, which
isolate noise pretty
effectively. Speaking of
earphones, the cord is really
short; thankfully, an
extension cable is provided.
We also used the Bose 321
Series in-ear phones as a
standard to gauge quality.
Bass was decent, and so was
the treble. Using the Bose
earphones over the Sony
ones gave us just a tiny
improvement in quality—
meaning the Sony
earphones themselves are
pretty decent, and you won’t
have to go hunting for
separate ones.

You can use the player as
a storage device. The transfer
rates were around 1.29 MB/s
while transferring files

directly onto the embedded
memory. 

Charging takes a little
under three hours, and the
charge easily lasts for more
than a day with the
volume set to 50 per cent—
really good.

Similar to the Apple
players, all the media that
goes onto the player has to
pass through Sony’s
software—SonicStage and
Image Converter. The
media is converted to
the supported
formats. The software
lacks an attractive interface,
but gets the job done. You
get two extra pairs of caps
for the earplugs, and a stand
to place the player on.

Rs 9,990 is not exactly
cheap for a 2 GB player. You
do get a video player and an
image viewer, but neither of
which are very exciting on
the tiny 2-inch screen. It’s
not extremely compact
either. For the same price,
you’d be better off getting a

media player with a larger
storage capacity.

Specifications
Dimensions: 43.8 (W) x 88 (H) x
9.1 (D) mm; weight: 53 gm;
inbuilt memory: 2 GB

Sony NW-A805
Performs well; slightly expensive

Razer is all over the
gaming market. Mice,

mouse pads, keyboards—they
have it all covered. They’ve
now diverted some of their
focus towards regular
consumers, and the latest

are the Razer pro|tone m250
portable clip-on headphones.

Like all Razer products,
the m250s look great. The
backs have a brushed metal
finish. The headphones

themselves are sturdy, but
the cables are pretty thin
and can be easily damaged.
The cable is short as well,
which may be good for your
portable MP3 player, but not
so good if you plan on using
it at home on your PC. The

clips for the
headphones

have a layer of rubber, which
makes them comfortable for
long sessions even if they’re
clipped on tight. 

Coming to quality and
performance, the m250s

are really loud. The treble
is overpowering, while the
bass is very low and sounds
flat. Frequencies between
2.5 and 10 kHz are the
most prominent. There was
no distortion at the
insanely high volumes it
reached, though. The
disappointing bass
response is mainly because
of the frequency range—
which starts from 50 Hz,
instead of around 20 Hz
like with most headphones.
There is no noise isolation.

The Razer pro|tone m250
costs Rs 3,399, which is very
expensive, but then you need
to keep the performance in

mind too. The device would
be used for mobile
entertainment, and there
happen to be quite a few
cheaper alternatives that
offer better audio quality.
Some canal earplugs cost
around half what the m250
costs give better bass, and
offer noise isolation! If you’re
a Razer fan, you could make
this part of your collection; if
you’re not, look elsewhere.

Specifications
Weight: 38 gm; frequency
response: 50 Hz ~ 20,000 Hz;
connector: 3.5 mm; cable
length: 1.15 m, Maximum
Sound Press Level: 105 dB;
impedance: 32 ohms

Razer pro|tone m250     
Slightly overpriced

Contact: Net Place Technologies P Ltd
Phone: 022-40053901
E-mail: sales@
netplacetechnologies.com
Web site: www.razerpro.com
Price: Rs 3,399

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS

Contact: Sony India Pvt Ltd
Phone: 66006600
E-mail: sonyindia.care@
ap.sony.com
Web site: www.sony.co.in
Price: Rs 9,990

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS
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The D-Link DSL-2640T is a
three-in-one device—an

ADSL modem, a 4-port
router, and a wireless access
point all packaged in stylish
silver-grey plastic.

The D-Link DSL-2640T is
just what you need if you
have more than one
computer and need to share
your ADSL broadband
connection. It is ADSL2/2+
compliant, and is therefore
capable of theoretical
download speeds up to 24
Mbps. 802.11 b/g wireless
capability allows it to
transmit data at up to 54
Mbps. The 4-port fast
Ethernet switch lets you
connect four computers to it,
and you can also add a few
laptops to your home
network using the integrated
Wi-Fi access point.

You can set up the DSL-
2640T in a jiffy. The easy-to-
understand browser

interface has a Wizard that
puts you in the driver’s seat
and lets you configure the
router the way you want.
Security has not been
neglected either, with
support for enhanced
wireless security using WPA
and WPA2. The integrated
firewall with NAT, SPI, and
DoS capabilities further
strengthen the safety of
your PC from hackers. You
can even block out
offensive URLs or complete
domains.

Though we could not test
the ADSL performance, we
tested the Wi-Fi capabilities
of the device. Scores were
average compared to the
other two ADSL routers we
tested earlier this year. It
could transfer sequential
files at a rate of 1.22 MBps in
the closest zone, while it
managed 0.55 in the farthest
zone, putting it a shade

ahead of the ASUS WL-600G
but a step behind the
Netgear DG834G as far
as overall
performance is
concerned.

D-Link has
provided an
ADSL splitter
so you can
connect the
telephone line to the
router and still not miss a
call. The accompanying CD
contains a manual and a
Wizard that are good
enough to ease any of your
worries about installing the
device. In sum, this is a
decent ADSL router for

setting up a small office or
home network.

Specifications
ADSL/ADSL2 compliant; Ports: 1
x ADSL RJ-11 for 24/26 AWG
twisted pair telephone wire, 4 x
10/100 LAN RJ-45; Wi-Fi
standard: 802.11b/g

Keeping up with its
regular production cycle,

NVIDIA has added one more
powerful performer to its
roster—the GeForce 8800
GTX. Manufacturer Leadtek
was one of the first to secure
it, launching the WinFast
8800 GTX. A full DirectX 10
part, this promises
unprecedented performance
under Vista.

Leadtek has built the
card using NVIDIA’s
reference design. The
heatsink does a pretty good
job at cooling, and is not
noisy. The card is long, and
we mean long: its 10.5-inches
exceeded the width of our
D945XBX2 motherboard by
over an inch! Not many
cabinets will accommodate
this card. It requires two
Molex power connectors, so
you should make sure you
have an appropriate power
supply. There are two SLI
connectors on the card,

which essentially double the
SLI bandwidth for to-and-fro
data transfer.

The G80GTX core
features the Unified
Shader Architecture, which
has the capability of doing
physics computations on
the chip, so the CPU is not
much of a bottleneck.
There is 768 MB of 384-bit
wide GDDR3 memory at
900 MHz, yielding a (huge!)
bandwidth of 84.4 GB/s.
This is more than enough
for any game out there,
with enough headroom for
future games.

The
card comes

bundled with two
power connectors and a

VIVO cable, which is HDTV-
capable. The game bundle
consists of just two games—
SpellForce 2 and TrackMania
Nations.

The card delivers what it
promises, gauging from our
test results. The performance
difference between this card
and that of its lesser siblings
was not much at the lower,
CPU-limited resolutions, but
as we went up, cranking up

the sliders, this was the only
card that held its own
against the barrage of our
benchmarks. It scored 10879
in 3DMark06, and did 83 fps
in F.E.A.R. at 1600 x 1200 in
its full glory. Though a shade
slower than the stock NVIDIA
8800GTX, this is still one of
the fastest cards out there,
and with exceptionally good
image quality.

Price at Rs 33,000, the
card offers relatively good
value for money. DX10 is not
yet out, so we’ll have to wait
to look at the card’s DX10
performance.

Specifications
GPU: NVIDIA GeForce 8800
GTX; memory: 384-bit 768 MB
GDDR3 @ 900 MHz (effective:
1800 MHz); GPU clock
(Geometric): 576 MHz; GPU
clock (Shader): 1350 MHz;
memory bandwidth: 84.4 GB/s

D-Link DSL-2640T Wireless G ADSL2+ Router
Decent for a small network

Contact: D-Link India Ltd
Phone: 022-30616666
E-mail: sales@dlink.co.in
Web site: www.dlink.co.in
Price: Rs 4,300 (plus taxes)

Contact: TopNotch Infotronix
Phone: 9323546190
E-mail: mushtaq@zebronics.info
Web site: www.leadtek.com
Price: Rs 33,000
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Features
Ease of Use
Value for Money
Overall 
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Leadtek WinFast PX8800 GTX TDH
Fast, and we mean fast
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External casings are
widely used with laptop

hard drives as portable
data transfer solutions. The
X Craft 250 is an
eSATA/USB casing from
Cooler Master; it promises
to keep high-capacity
laptop hard drives cool.

Crafted in aluminium,
the core design objective,
like we said, is good
thermal dissipation. The
meshed screen running
along two sides takes care
of ventilation. The white
paint provides a quality
finish, as also decent
fingerprint resistance. 

Power-hungry laptop
drives are addressed by the
use of split USB cables. The
eSATA connectivity makes
for a high 3Gb/s transfer rate. 

The USB cable or the 5V
DC jack is used to power

the case in the 
eSATA mode.

Cooler Master
provides rubber
grommets for
attaching the
hard drive to the
PCB—a nifty
touch; it
also
provides
shock
resistance.
Mounting the hard
drive is quite easy; also,
Cooler Master has been
generous enough to
provide a little screw
driver, screws, and the
grommets.  

For our test, we used
the WD SATA 250 GB
2500BEVS as the internal
drive. The results were
quite competitive. A 0.7 ms
access time in SiSoft

Sandra, along with a 17.8
ms random access time in
HD Tach, highlights the
fact that the internal

controller will not be a
bottleneck in the drive’s
throughput. In the real-
world 1 GB assorted test,
the drive took 63 /47 / 89
seconds (to / from / within).
In the case of sequential 1
GB single-file transfer, the
drive took 45 / 36 / 84
seconds (to / from / within).
Transferring 1 GB of
assorted files
simultaneously to and fro
took 83 seconds.

The package bundle
consists of the drive, a nice
pouch, and the necessary
backup software. We think
it’s a good buy. 

Specifications
Dimensions: 81 x 19 x 136 mm
(W x H x D); weight: 140 gm;
interface: USB 2.0/1.1; eSATA

Contact: SMC International
Phone: 98100 26658
Email: himanshu@
amigointernational.biz
Web site: www.coolermaster.com
Price: Rs 1,560 (plus taxes)

Cooler Master X Craft 250
A cool data companion!

The satellites on the Bose
Companion 5—hereon

referred to as the BC 5—look
like a prop from a Star Wars
film set. However, the long
subwoofer looks a little like
a largish UPS. The matte-fin-
ished black and grey looks
elegant, and the stylish
satellites and classy control
pod all add up to a killer
designer-desk!

A word on the round
control pod—a tap on the
middle and the speakers
switch on, another tap—off.
The volume control opera-
tion is also ultra-slick. It
also features a headphone
jack and an auxiliary in
(for portable media players,
for example).

The BC 5 connects via
USB and not a 3.5 mm jack.
And this is the good and
the bad part of this set (you
decide which!). Good: you’ve
got an inbuilt sound solu-
tion (no sound card
required), which doesn’t
even require a driver under
Windows XP. This, coupled
with the proprietary
TrueSpace surround digital
processing, gives you virtual
surround sound from a
stereo speaker set. Bad: if
you have a good sound card
capable of better sound.

We listened to a few of
our favourite tunes and the
mandatory test tracks on
the BC 5 for a day. The first
gripe is the subwoofer—the
bass is “boomy,” too much
so for our liking. Second,
the bass doesn’t have that
classy wooden feel to it. On
a positive note, the satellites
are definitely punchy, and
will happily outdo the bun-
dled bass unit if allowed to.

The sound from the satel-
lites is particularly mellow
in the mids.

DVD movies will ben-
efit from this kind of bass;
audiophiles with their
music will hate it. The
sound really does seem to
surround you; whatever
acoustic technology Bose
has put to work is evi-
dently doing its job—
though it’s not as good as
a discrete 5.1 setup.

At Rs 21,000, the BC 5 is
costly. You get indisputably
great looks and sometimes
disputably good sound. Bose
builds lifestyle products for

the flamboyant, who pay as
much for the show as for
the go. If you fit the bill,
and can stomach it—buy the
BC 5. If you’re not part of
that minority, skip this one.

Specifications
Amplified 2.1 system; inter-
face: USB; wired control pod
unit; auxiliary in and head-
phone connects

Bose Companion 5
Class on your desk

Contact: Bose Corporation India
Pvt Ltd
Phone: 1-800-11-2673
E-mail: NA
Web site: www.boseindia.com
Price: Rs 21,900 
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This is yet another no-
nonsense digital
music player from

Creative. It is squarely
aimed at Apple’s Shuffle.

Dimensions-wise, the
Stone is small; it will
comfortably rest in your
palm. Finished in glossy
piano black, it looks good,
and the rounded edges add
in that “cute” factor.
Like the Shuffle, the
stone is devoid of a
screen.

The controls—
Play, Pause, Next,
Previous, and
volume—are placed
on a round crested
dial (similar to that on the
Shuffle) that fits flush
with the player’s surface.
Ergonomically, the dial
could have been raised a
little, and that’s about the
only gripe we have.

A little slider on the
side allows toggling
between repeat
modes. The same
slider can be used
to skip an entire
folder. The player
hooks up to a
computer
via

USB
and gets

detected as a
Flash drive.

Thankfully, there are no
software hassles when
transferring files (a pain
with the Shuffle). File
transfers are quite fast.      

The player did
commendably well in our

performance
tests. The bundled

earphones, though low
on bass, have a good mid
and high frequency
response; in fact, it’s really
good. We also tried the
player using our reference
Bose earphones, and
fidelity was right up there.
The volume level isn’t
particularly high, though.
Battery life, at eight hours,
is relatively good.

It’s quite strange to see
that Creative didn’t

integrate a voice recorder
or FM Radio in the Stone.
That said, the Stone
should be appropriately
priced—read affordable.
The one we got was a press
sample; pricing will be
disclosed in July. Like we
said, Creative definitely has
the Shuffle in the
crosshairs, but we do think
the Shuffle has an edge.

Specifications
1 GB; USB 2.0 interface;
Repeat All and Shuffle modes;
¼-inch earphone jack;
blinking battery indicator LED

Creative Stone 1 GB
Apple vs. Creative—again

Contact: Creative Technologies Ltd
Phone: 9833596972
E-mail: india_getcreative@
ctl.creative.com
Web site: http://in.creative.com
Price: Approx Rs 3,500

The Wizpy—the first
venture into hardware

territory by Japanese
company TurboLinux Inc.—
looks like an MP3 player, but
is much more: you can boot
right off it!

Encased in a beautiful
white polymer casing with
fine silver speckles, the
player is sturdy and scratch-
resistant. A black version is
also available, and looks
equally impressive. The
device is sleek enough to be
and easily slips into
any pocket. The
interface,
however, is not
very intuitive, but
you can get along
after a few minutes.

This is the first MP3
player that can boot into an
OS; you can take your office
with you wherever you’d
like. Any computer that
supports USB booting can
boot through the Wizpy into
TurboLinux Fuji, residing on
its 1 GB partition. This is a
full-fledged operating

system that comes
with its office suite,

and which even lets you surf
the Internet and check mail.
This partition is inaccessible
through other OSes, thus
providing security for your
data. If you do not have USB
2.0—or the ability to boot
this way—you can use the
accompanying mini disc to

boot into the OS. The
problem is that you can only
read NTFS partitions; you
can’t write to them. Instead,
you save your work on the
Flash memory of the Wizpy.
This will be a handicap
when large files are
involved.

The Wizpy plays several
music formats—such as
MP3 with ID3 and lyrics,
and OGG—and video
formats such as AVI. Audio
quality is excellent at
medium volume levels, and
the accompanying
headphones are good
enough. (At higher
volumes, the bass tends to
distort the mid and high
notes.) The 1.71-inch OLED
262K colour display is vivid.
You can read text files
using the inbuilt e-book
reader. FM Radio is there,

but it has a weak tuner
when compared to other
MP3 players. The Li-ion
battery lasts for up to 14
hours of music playback—
fairly good.

The Wizpy comes in 2
and 4 GB versions; we tested
the 4 GB. Of this, 1 GB is
used by the OS.

The price tag reads Rs
11,900, which might seem
high, but for the
functionality it provides, we
think it’s just right.

Specifications
Capacity: 4 GB (3 GB storage);
display: 1.71-inch OLED with
262K colours; OS: TurboLinux
Fuji; 7-band audio equaliser;
file formats: audio: OGG, MP3,
WMA, AAC; video: AVI, DivX;
image: JPEG; FM radio; text e-
book reader; interface: USB
2.0; bundled: TurboLinux Fuji
Mini CD, earphones, USB and
line-in cables

TurboLinux Wizpy 
Everything’s portable

Contact: TurboLinux India Pvt Ltd
Phone: 0124-4570300
E-mail: bd@turbolinux.co.in
Web site: www.wizpyindia.com
Price : Rs 11,955
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Overall 
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Defragmenting your drive
is an important part of

maintaining your machine,
and it’s synonymous with
Windows’ Disk
Defragmenter. We take a
look at a solution from
O&O—Defrag 10 Professional.

The interface is very
clean, colourful, and Office
2007 themed. The icons in
the toolbar give an
explanation of the features
when you move the mouse
pointer over them.

Defrag 10 Professional
starts by asking you
whether you want it to
manage your defragging
settings—it asks questions
like the type of machine
and what it’s used for:
work, gaming, home, etc. It
then creates suitable
schedules and defrag modes
for it. You can always
choose to manually defrag
your disks. An interesting
feature called offline
defragmentation defrags
your disk before the OS
boots up. You can set offline

defragmentation to run at
every bootup.

Like most system
maintenance utilities, this
one too lets you set
schedules for defragging.
You can set what type of
defrag you want for each
drive, and even choose to
defrag multiple drives at
once to save time.
Defragging can be stopped
when the system is running
in battery mode. Detailed
reports for the tasks are
generated in HTML.

You can choose from
one of the five types of
defragging. The COMPLETE
/ Access Method puts often-
accessed programs and
files at the end of the
partition and the least-
accessed at the beginning,
so future defragging will
be far more optimised and
will require the least
amount of movement.
Other modes allow you to
defrag by file names,
recently modified, or just
plain space optimisation.

Defrag 10 Professional is
really light on the system,
taking only around 15 MB of
memory while running. The
CPU utilisation depends on
the type of defragging you
select. The full-fledged
defrag mode made the CPU
utilisation spike between 5
and 40%. Defrag 10 Pro even

lets you set a limit on the
amount of resources.

Documentation is in the
Windows Help format, with
steps and explanations of
the features with
screenshots.

This is one very good
defragging utility. The
Windows defragger doesn’t
come close to O&O Defrag 10
Professional in features or
looks. $44.95 (Rs 2,000) is
quite worth it.

O&O Defrag 10 Professional
Heavy on features, light on resources

Web site: www.oo-software.com
Price: $44.95 (Rs 2,000)

Mundu IM will fulfil all
your instant

messaging needs—when
you’re not in front of a PC,
that is. It is an instant
messenger that runs on
mobile devices and
smartphones running Palm
and Windows Mobile.
Mobile instant messengers
might not be used widely
in India, and Mundu IM is
just one of many all-in-one
messengers available. So we
decided to try one: we used
Mundu on an i-mate SP5m
running Windows Mobile 5.

The interface is initially
rather plain, but lightens

up with colourful status
icons similar to those you’d
find on the full-blown
versions of the messengers
on a Desktop PC. The
software supports six
protocols—MSN, Yahoo!,
Google Talk, AIM, ICQ, and
Jabber, which should cover
almost all the commonly-
used ones. We faced
trouble connecting to MSN
and Yahoo!. Yahoo!
wouldn’t show the contact
list once connected, but
messages freely came
through. An online update
quickly rectified this issue,
but the MSN connection
trouble persisted. Further
updates will have to be
made to fix this.

You get the standard
features such as contact
adding, removing, and
blocking, and groups
support. Chatting using a

phone and a tiny keypad
can be a pain, so Mundu has
a feature called Quicktext,
which lets you send text
presets such as greetings.
You even get a buzz feature
like in most Desktop
messengers, only here your
mobile device vibrates!

E-mail alerts are
available as well. We were
able to get alerts for Gmail,
and even a small preview of
the mail, but Yahoo! Mail
didn’t show up in the e-
mail alerts. When you click
on the mail preview, it
opens up a browser taking
you to your mail account.

Like we said earlier,
there are many other all-in-

one IMs available, and
you’re bound to come
across some that are
costlier, and some that
have a time-based
subscription. Mundu IM
will only require you to
shell out a one-time fee of
$11 (Rs 500), which is very
good value for money. The
only real cost you bear is of
your mobile service
provider’s GPRS charges.

Mundu IM V4
An all-in-one IM for your mobile device

Contact: Geodesic Information
Systems Ltd
Phone: 022-28311849 / 28306837
E-mail: enquiry@mundu.com
Web site: http://messenger.
mundu.com
Price: $11 (Rs 500)
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone 9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone 022-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6700 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Corporation
Phone 080-25075000
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
No remote sensor at rear

Contact Acer India Pvt Ltd
Phone 9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,50,000

Digital Cameras
(High-End)
Sony CyberShot W50

Excellent image quality,
vibrant colours
Trouble focusing in low light
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price Rs 15,000

Linux
SSuuSSEE  LLiinnuuxx  EEnntteerrpprriissee
DDeesskkttoopp  1100..11  

Good software bundle
A little resource-heavy

Contact Novell India
Phone 022-28342244
E-mail apanjwani@novell.com 
Price Rs 2,650

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800 425 4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 4,000
MobiBlu DAH-2100

Good performance
Tiny screen for video

Contact J.J.Mehta & Sons
Phone 022-24306356
E-mail   info@jjmehta.com
Price Rs 4,000

MP3 Players up to Rs 10,000
Sandisk Sansa e250

Good performance, 
feature-rich
Tacky scroll wheel

Contact Rashi Peripherals Pvt Ltd
Phone 022-67090909
E-mail navinderc@

rptechindia.com
Price Rs 8,150

Internal DVD-Writers
Lite-On LH-20A1P

Fast, 20x writing to DVD+R
and DVD-R 
None in particular

ContactMediatech India
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@ 

mediatechindia.com
Price Rs 2,095

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 7,500

Graphics Cards (High-end) 
NVIDIA GeForce 8800 GTX

Blistering-fast
Runs slightly hot
CCoonnttaacctt Rashi Peripherals Pvt Ltd
PPhhoonnee 022-67090810
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 41,000 + taxes

Graphics Cards (Mid-range) 
XFX 8600GTS

Best of the mid-range cards!
Could do with more memory
CCoonnttaacctt Rashi Peripherals
PPhhoonnee 022-67090909
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 16,000

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular
Contact Champion Computers 

Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
good performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 4,500

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT JULY 2007
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Premium Cell Phones
Sony Ericsson CyberShot K550i

Excellent camera and UI
Sub-par reception
Contact Sony Ericsson Mobile 

Comm. Int. AB
Phone 022-39011111
E-mail questions.in@support.

sonyericsson.com
Price Rs 11,995

Basic Camera Phones
bleu 651X

2 MP camera, webcam
No Bluetooth

Contact Pratham Telecom
Phone 022-28769381
E-mail avinash@sagemindia.com
Price Rs 8,299

Intel High-end Motherboards
Foxconn 975X7AB-8EKRS2H

Inexpensive, good performer
None in particular

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail info@mediatechindia.com
Price Rs 10,750

Intel Mid-range Motherboards
Gigabyte GA-965P-DQ6

Good build quality and 
performance
Expensive 

Contact GIGABYTE Technology 
India Ltd

Phone 022-26526696
E-mail sales@gigabyte.in  
Price Rs 16,000

AMD AM2 Motherboards
ASUS Crosshair AM2

Great bundle and performance;
accessories for the enthusiast
None in particular

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 15,400

AMD 939 Motherboards
ASUS A8R MVP

Good performance
Skimpy bundle 

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 8,700

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-33-66
E-mail info@canon.co.in
Price Rs 5,999

Office Inkjet MFDs
HP Photosmart C4188 All-in-One

Good print quality
No fax

Contact HP India Sales Pvt. Ltd.
Phone 0124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone 044-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow (relatively)

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone 0124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Value Laptops
Compaq Presario v3225AU

Great looker, good performance
Sticky touchpad

Contact Hewlett-Packard India
Phone 0124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 32,990

Performance Laptops
HP DV6226tx

Funky looker, cool features 
Needs better graphics

Contact Hewlett-Packard India
Phone 0124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

125

Flash Drives
Transcend JetFlash 150 1 GB

Fast
Poor package bundle

Contact Mediaman Infotech Pvt
Ltd

Phone 022-23828100 
E-mail santosh@

mediamangroup.com  
Price Rs 1,500

Mice
Logitech MX Revolution

Flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail response@logitech.com
Price Rs 8,000

Mono Laser MFDs
Samsung SCX-4521F

Good performance and
quality
Low input tray capacity 

Contact Samsung India
Electronics Pvt Ltd 

Phone 011-26431313
E-mail vikram.negi@

samsung.com
Price Rs 21,990

PC Webcams
Tech-Com SSD-641-MP

Good image quality, 
inexpensive
No software bundle, 
poor build quality

Contact Shree Sagarmatha Dist 
India Pvt Ltd

Phone 011-26428541
E-mail contact@

techcomin-india.com
Price Rs 549

JULY 2007 DIGIT
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Gone For Good?
After I installed Vista, my DVD-ROM drive
disappeared. I tried several ways to get it to

work, but it doesn’t. What can I do?
Ankush Shah

This happens when an incorrect driver was
installed for the DVD-ROM. There are two

solutions you can try.

Method 1: In the Control Panel, double-click
System. Click on Device Manager in the
Hardware tab. Click the drive with the ques-
tion mark next to it. Click Uninstall in the
Action menu and click OK when prompted for
confirmation. Click “Scan for hardware
changes” on the Action menu. Your drive
should get automatically detected. If this does
not happen, try Method 2.

Method 2: Open the Registry editor and go to
the following key:
HKEY_LOCAL_MACHINE/System/CurrentCo
ntrolSet/Control/Class/{4d36e965-
e325-11ce-bfc1-08002be10318}

Click Export on the File menu, type “back-
upkey” in the file name dialog box, and click
Save. This will help you revert to the original
registry settings for this key, in case you make
an error. Now delete the values LowerFilters
and UpperFilters in the right-hand pane and
restart your PC.

Password Poser
I have Windows XP Professional SP2. I need to
change the administrator password, but when

I log on as Administrator and double-click User
Accounts in the Control Panel, the Administrator
account does not show up. So how do I change my
admin password?

Rasick Patel

Go to Start > Run, enter “mmc” and hit
[Enter]. This will start the Microsoft

Management Console. Select File >
Add/Remove Snap-in. Now click on Add and
select the “Local Users and Groups” snap-in

from the list, and click Add. Then click on
Finish, Close, and OK. Expand Local Users
and Groups and select Users. Right-click  on
Administrator in the right pane and click
Set Password. Click Proceed in the dialog
box that comes up, and type and confirm the
new password. Click OK.

No Option…
There is an option “Folder Options” under
the Tools menu in Windows Explorer, but it

isn’t there on my PC. What can I do to bring back
the option?

Karmit Singh

Open the Group Policy Editor by typing in
gpedit.msc in the Run dialog box.

Navigate to the following location:

User Configuration\Administrative
Templates\ Windows Components\Windows
Explorer

On the right side, set the “Remove the
Folder Options menu item” from the Tools
menu to “Not Configured”, by double-clicking
it and setting the appropriate option.

If you are using Windows XP Home, you will
not be able to run the Group Policy Editor, and
you will need to use the Registry Editor
method, as follows.

Open the Registry Editor. Browse to the
following key:
HKEY_CURRENT_USER\Software\Microsoft\
Windows\CurrentVersion\Policies\
Explorer

Find the NoFolderOptions key and change
the value to 0, assuming you have this key. If
you don’t, just create it. Restart your computer.

Plug-N-Play
I installed a certain program that disabled the
CD Autoplay feature. How can I re-enable it?

Rajesh Kumar

Open the Group Policy Editor by typing in
gpedit.msc in the Run dialog box.  Go to

Computer Configuration >
Administrative Templates > System and
double on Turn Autoplay off in the right
pane. The default is “Not configured”. Set it to
Disabled. This only works with Windows XP
Professional.

If you have XP Home Edition, open the
Registry Editor and navigate to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentCont
rolSet\Services\CDRom. 

Double-click the DWORD “AutoRun” in the
right pane and set its value to 1. Close the
Registry Editor and restart your computer.

Poof!
I use Yahoo! Mail. I received some important
mails, then accidentally deleted them. Can I

get them back?
VSujan Rai

There is no way to retrieve mail that has
been deleted from the Yahoo! Mail “Deleted

Items” folder. Yahoo! clearly states: “Messages in

Your Questions, Our Answers

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Slow burns, no
burns and missing
help! Digit to the
rescue again!

Change the Administrator password using MMC
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your Trash folder are subject to deletion at any
time.” Mail that is deleted can only be retrieved
for sure during the session in which it was
deleted; it could be lost forever after you log out
of the session.

Try and contact Yahoo! Customer Care at
http://help.yahoo.com/help/us/payforcare/payforcare-
01.html. We would like to state that you need to
be a paid subscriber to get help from here.

Pirates Burning (In) Hell!
I installed Nero 7 on my Windows XP computer
and registered it successfully. But after a few

days, it suddenly started functioning in trial mode,
and when I tried to enter the registration code, it said
the code was incorrect. I uninstalled and reinstalled
the application, but to no avail.

Shamit Kumar

This happens when you use a blacklisted
key to register Nero. It may work for a few

days, and it will stop functioning when Nero
finds out that the key is blacklisted. If you
haven’t purchased this copy of Nero 7,  please do
so at www.nero.com—it costs $79.99 (Rs 3,250). If
you do own a legitimate copy, please get in touch
with Nero support at http://support.nero.com.

Frozen Frame
I have a Pentium IV 3.0 GHz, 512 MB RAM,
128 MB graphics card (NVIDIA GeForce FX

5200), and Windows XP SP2. When I play games
like Cricket 2005, Need for Speed: Most Wanted,
and more, the games freeze after 10 to 15
minutes. Some older games also freeze. Why is
this happening?

Pugalenthi Iniabarathi

It is highly probable that your computer is
overheating —either the CPU or the graph-

ics card. Open the cabinet and look to see
whether the CPU fan is functional. Check if all
the fans in the cabinet as well as those in the
power supply are working. If possible, remove
the CPU heatsink, clean the contact surfaces of
the CPU and heatsink with a clean piece of
cloth, apply a thin coat of thermal paste such
as Arctic Ice, and replace the heatsink on the
CPU. Neatly arrange and tie up all the wires
and cables to allow free airflow. If possible,
purchase a rounded IDE cable and install it in
place of the flat ribbon cable.

Refer to Going With The Flow featured in our
January 2007 issue for more about cabinet
ventilation.

If the problem persists, the fault lies with
your graphics card, and there is little that can
be done except downloading (from
www.nvidia.com) and installing the updated driv-
ers for your card. If that doesn’t help, you’ll
need to get a new one.

Switch Glitch
I have an Intel 915G based motherboard
running Windows XP. When I try to play The

Sims 2, I get the following error.
“The ialmrnt5 display driver has stopped work-

ing normally. Save your work and reboot the
system to restore full display functionality. The
next time you reboot the machine a dialog will be
displayed giving you a chance to upload data about
this failure to Microsoft.”

Manav Gowda

Download and install the latest Intel graph-
ics drivers for your onboard graphics from

www.intel.com. If the problem persists, do the
following. Right-click on the The Sims 2 shortcut

Safe And Sound—And Secure
I currently have Windows XP Professional, and I want to
reinstall XP. I have many files encrypted in my NTFS parti-

tion, and I want to be able to access them after reinstalling
Windows. How do I do this?

Sarvesh Tonk

Many people commit the blunder of encrypting files in
an NTFS partition and then installing Windows afresh.

There is no way of recovering the encrypted files once this
is done. Therefore, making a backup of the encryption
certificate is of utmost importance.

In the Run dialog box, enter mmc and click OK. This will
start the Microsoft Management Console. Select File >
Add/Remove Snap-in. Now click on Add and select the
Certificates snap-in from the list, and click Add. Then

click on Finish, Close, and OK. Go to
Certificates—Current User > Personal
> Certificates. Click the certificate that
displays the words File Recovery under
Intended Purposes. Right-click the certificate, point to
All Tasks, and then click Export. Follow the instructions
in the Certificate Export Wizard to export the certificate and
associated private key to the Personal Information Exchanve
or .pfx format. Make sure you deselect Delete the
private key if the export is successful. You will
be asked to password-protect your keys (to verify when
importing later on). Save this .pfx file to a floppy disk or to
some other secure location.

Now, when you format, or if your keys get damaged, all
you need to do is double-click on the exported key and
follow the Wizard. You should get access to your files.

Question 

of the

Month

Illustrations Harsho Mohan Chattoraj
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Compress Videos And Add Audio Tracks

Rossi Fernandes

The vacations have come to have an
end, and there’s a large pile of

videos from your camera and camcorder
lying around, clogging up your drive.
Almost no digital cameras—and only
some camcorders—use compression for
videos. Compressing these large videos
using the right formats and codecs can
help bring down the size without
having to sacrifice on quality, which
we’ll show you how to do. We will also
show you how you can have multiple
audio streams in a video.

One of the easiest ways to encode
videos is to use MediaCoder (http://medi-
acoder.sourceforge.net/). You will also be
required to install Firefox
(http://www.getfirefox.com/), since
MediaCoder uses Firefox in certain
windows and interfaces. We’ve chosen
MediaCoder for many reasons: it doesn’t
require you to manually download the
codecs and tools required. It lets you
queue up multiple files or complete fold-
ers in a couple of clicks. You won’t need
to use command line programs and
parameters. And finally, it’s free!

Adding Videos
You start by adding the videos
you want to encode. With the

program open, click Add File or Add
Dir on the toolbar. Choose the files or
the folder and click Open or OK. Do not
attempt to encode already-compressed
videos—you’ll end up with larger files
and extremely high encode times.

Video Encoding Parameters
For encoding the video, you
need to decide upon the codec

and format. The codec is the software
that will encode the video. The format is
like a container that will store the data.
AVI is one of the more commonly-used
containers; XviD and DivX are codecs.

In our case, we’ll use the MP4
container and the x264 codec. (x264 is

an open source implementation of
H.264). x264 has an edge in quality over
XviD, which is more commonly used.
The disadvantage with using x264 is the
encoding time, which can be quite a bit
more than with other codecs.

After adding the videos to the queue,
click on the Video tab. Choose the
Backend as MEncoder. Set the Source as
Default. Then choose the codec as H.264
and the format as MP4. Set a suitable
bitrate or quality setting. For most digi-
cam videos, 800 Kbps is good enough for
the standard 640 x 480 resolution.

We’ve chosen MP4 because of
features like multiple audio streams.
You’re free to choose other containers,
but certain containers and codecs may
not be compatible with each other. Play
around a bit to see what works.

Audio Encoding Parameters
Click the Audio tab. Set the
source as MPlayer, and the

encoder as LAME MP3. LAME is a free
encoder that comes with MediaCoder,
and MP3 is flexible enough to support a
wide range of quality settings—also, it’s
compatible with most media players. In
the panel on the right, click on the
LAME tab to set the quality for the
audio. Choose the rate as CBR (Constant
Bitrate) if the source audio bitrates are
low. VBR makes more sense when you
have higher bitrates. The bitrate should
suit that of your video. A minute of
audio at a CBR of 320 Kbps will take
around 2.5 MB, whereas 128 Kbps (which

isn’t too much of a quality drop
compared to 320) will take around 1 MB.
Also, remember that if the audio was
recorded by your camera at 64 kbps, it
isn’t going to make it sound any better if
it’s encoded at 128 kbps. 

Adding Multiple Audio Streams
To add multiple audio streams—
for example, to add a commen-

tary—click on the Muxer tab in the left
panel, choose the multiplexer as
MP4Box, click Add, and point to the

audio files you want to add. Then click
Mux, and choose a temporary location
for the multiplexed file to be dumped to.

Encoding
Click on the Output tab and set
the Output Folder. Finally, click

Start. The time taken for encoding is
mainly dependant on your system
configuration, the quality and size of the
video, and on the codec you’ve chosen.

You’d probably want to send your
encoded video to friends. For formats
such as MP4 and codecs like H.264, the
viewer would need to install ffdshow
(http://ffdshow-tryout.sourceforge.net/), or
use a player such as VideoLAN
(http://www.videolan.org/).

An inter-
esting and
useful appli-
cation is
Gspot (www.headbands.com/gspot/). It
gives you information on pretty much
every format and the codecs being used,
along with information such as the
number of streams and their bitrates.

You can even encode videos to
compact Flash files with MediaCoder
and the steps we’ve just shown you.

rossi_fernandes@thinkdigit.com

Add commentary to your videos, and compress them effectively

Configuring settings for the video encoder

Setting up the audio encoder parameters

Adding multiple audio tracks using Muxer

Encoding in progress

GSpot gives information on
formats and codecs.
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on your desktop and select Properties. Add a
space and a “-w” at the end of the target field so
that it looks something like this:
“C:\Program Files\EA GAMES\The Sims
2\TSBin\Sims2.exe” -w

The path may, of course, vary depending on
where you installed the game. Click OK and try
and run the game.

Connection Negation
I have a 3 GHz Pentium 4 with 1 GB of RAM on
Windows XP SP2. I want to connect to the

Internet using my Soft V92 Data Fax Modem. When
I try to do so, I find that the “Connect using a
dialup connection” and the “Connect using a
broadband connection” options are disabled.

Mohit Budhrani

There are a number of reasons for this to
happen. First, make sure that the Remote

Access Connection Manager service is Started,
and that its Startup Type is set to Manual. On
XP, you can check this by going to Control
Panel > Administrative Tools >
Services. If this doesn’t seem to work, one the
following methods will do the trick.
Method 1
Open the Registry Editor. Locate and click the
following key:
HKEY_CURRENT_USER\Software\Microsoft\W
indows\CurrentVersion\Telephony\Cards

Delete NextID in the right pane. Exit the
Registry Editor and restart the computer. Start
the New Connection Wizard, and then create a
new dial-up modem or PPPoE connection. If the
issue is not resolved, try this:

Method 2
Open the Registry Editor. Locate and click the
following key:
HKEY_CURRENT_USER\Software\Microsoft\
Windows\CurrentVersion\Telephony

Delete the key. Exit the Registry Editor.
Perform an in-place upgrade of Windows XP,
that is, a repair installation of Windows XP as
follows. Boot using your Windows XP CD.
When the system prompts you to press [R] to
run the recovery console to repair Windows, do
not do so. Choose to install a new version of
Windows instead. The setup program will then
proceed and detect the old copy of Windows.
Now it will tell you to press [R] to repair it or
[Esc] to install a new version. Press [R]; setup
will then proceed to re-install Windows over
the old version while retaining all programs,
settings and data files. If this does not solve
your problem, proceed to Method 3.

Method 3
Open the Control Panel and under Phone
and Modem Options, set the area code and
other desired settings. If the My Location item
has not been created, the New Connection
Wizard to create it should automatically
appear. You can use this Wizard to enter the
area code and other settings. When you’re
finished with the Wizard, restart the computer.
The Connect using a dial-up modem option
should now be available to you.

Virus Hell
I installed Norton Antivirus 2005 and it
detected the virus Infostealer.Banker.D, but is

not able to remove it.
Vidya Charan

Follow these steps
to remove the

virus. First disable
System Restore. To do

this, open System from
the Control Panel, click
on the System Restore
tab, and check the box
next to “Disable System
Restore on all drives”.

Update the virus
definitions and the anti-
virus itself, then run a
full and thorough

system scan.
Delete the values created by
the virus in the Registry: in

the Registry Editor, delete
these keys:

HKEY_LOCAL_MACHINE\Software\Helper\”D
Name” = “[ENCRYPTED STRING1]”
HKEY_LOCAL_MACHINE\Software\Helper\”D
om” = “[HEX VALUES]”
HKEY_LOCAL_MACHINE\Software\Helper\”G
UID” = “[ENCRYPTED STRING2]”
HKEY_LOCAL_MACHINE\Software\Classes\C
LISD\”[TROJAN_BHO CLSID]”
HKEY_LOCAL_MACHINE\Software\Microsoft
\Windows\CurrentVersion\Explorer\Brow
ser Helper Objects\[TROJAN BHO CLSID]

Exit the Registry Editor. If for some reason
you are not able to open the Registry Editor,
download and run the tool developed to remove
these keys from :
http://securityresponse.symantec.com/
avcenter/venc/data/tool.to.reset.shel
lopencommand.registry.keys.html or
http://tinyurl.com/yrotz. 

Explorer Error
I use Windows XP Pro with SP2, and I
recently installed Internet Explorer 7 Beta.

It was working fine, but last week I found that IE
wasn’t opening. An error message is showing up,
stating this:

“iexplorer.exe—Entry Point Not Found : The
procedure entry point
InternetGetSecurityInfoByURLW could not be
located in the dynamic link library WININET.dll”.

Chandan Munshi

To fix the problem, do the following:
à Uncompress the IE7 installer file to a

directory like C:\IE7Inst
Restart your computer and use any live OS
CD such as WinPE or Ubuntu Live to boot
your computer.
Copy wininet.dll and urlmon.dll from the
IE7Inst directory to %windir%\System32\
Reboot your computer. 
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You know how frustrating it is when you come across sites that require
you to register even to browse through them. And what about down-

loading stuff? Sure, many sites don’t require you to register, but think of
sites like Adobe.com. There you are, intending to download the Adobe
CS3 trial from Adobe’s Web site. Go ahead, register! Spend five boring
minutes! And all for nothing in return, and we’re not even talking about
un-checking all the newsletter subscription boxes. 

Worse are sites that show up on Google and you find you need to
subscribe. Say you want to read through the Times Of India e-newspaper,
and there’s again a daunting registration process. Then there are some
questionable sites where you just don’t want to give away personal infor-
mation. Or even make up stuff… because your imagination just isn’t
working as you’re waiting to see the page! You’re probably now just as
frustrated with this rant…

Bugmenot.com offers respite. Just type in a Web site address in the
text box at Bugmenot.com, and you’ll see a list of usernames and pass-
words, along with the success rates for each of them. You can actually
use these and login to the site
you want to go to, and voila—no
need to register!

Bugmenot has accounts for
about 1,50,000 sites. You too can
do your bit for bugmenot.com by
registering using a non-person-
alised username and password
and added it to the site for
someone else to use. Bugmenot
also provides instant, disposable
e-mail addresses when one requires an instant address to receive at least
one mail from a site (read registration responses). This keeps spammers
at bay. E-mails gotten from Bugmenot stay for 24 hours. Just think of a
name and address and send it to Bugmenot. For example, dont-
bugme@bugmenot.com. 

To access this account, you just type in the address you gave, and click
“Read e-mail” at http://email.bugmenot.com! Incredibly useful, no?

Do It Yourself (And Don’ts, Too)

Bugmenot takes the headache out of
online forms

Digital Tools l 3 Incredibly Useful Sites

DIY allows you to use your creative abil-
ities (along with available tools, of

course) to give vent to your creative
desires. Step-by-step instructions makes
any complex DIY a piece of cake… but you
don’t want it to be a piece of cake every
time you take up a DIY. Ideally, one just
needs a helping hand; comments and crit-
icism can go a long way in making a DIY
project more enjoyable.

That’s what instructables.com is all
about—it provides a platform where
people can share what they’re doing, how
they’re doing it, and learn from and col-
laborate with others. The site has some of the coolest projects—
from a night-vision webcam to a rechargeable LED flashlight pow-
ered by magnets, how to open any padlock, and more. (We’re sure
that padlock bit has already gotten you interested.)

Projects are aided by photos
and videos, with less of an empha-
sis on text. Registering at the site
allows you to upload your own DIY
and collaborate with other projects
if you can contribute. The layout,
as is the case with every site we
feature in this space, is easy to
grasp. Comments on the pages
allow one to visualise how others
reacted to the project—whether it
was good or a waste of time or
whether there was a better method
to achieve the same results.

Overall, one wonderful site for those who like to do things
themselves—but please don’t go about opening padlocks.
Don’t even think about it. 

prakash_ballakoor@thinkdigit.com

www.bugmenot.com

www.instructables.com

Find the craziest of projects at Instructables
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www.webdesign.org

AWeb presence is necessary for many businesses. It’s
like an identity. But identity is just not enough to get

noticed; one’s Web site needs to be designed well to stand
out from millions, as you know very well. The attention
span of a casual surfer is nine seconds (according to BBC
News, the Science / Technology division), within which
one decides if the site is worth spending time on. We’ve
done a Fast Track to Web design in our July 2006 issue;
this site gives you more resources.  

Webdesign.org teaches you all the theoretical and
practical aspects
of an effective
and attractive
Web presence.
This site covers
Web Design
basics such as
design principles,
colour theory,
templates, and
tuning, which are
essential knowl-
edge for any Web designer. There’s a tutorial section on
Adobe Photoshop, and a section on vector graphics covers
tutorials on CorelDraw and Adobe Illustrator.

Animation adds dynamism to a site. A section on
Flash and Swish teach one how to get started on anima-
tion. The site also carries tutorials on 3D graphics, HTML
and CSS, and Web programming—PHP, ASP, and
JavaScript. The tutorials don’t stop at this: site mainte-
nance topics like Web promotion, domain registration,
and hosting services are also taken care of. Then there
are the little things like showcasing Web design, and a
site of the day and month. Well worth a visit or two—or
three or four or more!

Webdesign.org—handy advice for your site

Prakash Ballakoor

Forget registration forms. Open padlocks. And in nine seconds, get someone to stay at your site.
Cryptic? Read on!
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marking of tasks easy. This feature is
called Auto Format. We need to use the
Day/Week/Month view to see this feature
in action. Select View > Current
View > Day/Week/Month or
Day/Week/Month with AutoPreview.
Then right-click on any empty field and
click Automatic Formatting. Click Add
to add rules, and enter a name for the
rule. Click on the Condition button, and
enter any keywords that you want to find
in the tasks. Click OK and choose a colour
for that keyword. Press OK again, and the
tasks with the keywords you’ve chosen
will get highlighted with the colour.

Showing All The Navigation
Pane Buttons

The navigation pane at the left is the
easiest way to access the various
components of Outlook 2007. By
default, the number of items is limited
to only the two or three prominent
features. To show all the features
buttons, click on the drop-down icon in
the Navigation Pane at the left. Click on
Show more buttons, and an item will

appear on the Navigation Pane. Follow
the steps over and over till all the items
you need are added.

Additional Views And Features
Some of the more advanced views

don’t have icons on the toolbars: part of
Microsoft’s goal is to simplify the
interface of their applications. For
example, to choose the different views of
the features—Calendar, Notes, Tasks,
etc.—you need to select View > Current
View and choose the view of your choice.
The easier way to access these views is to
enable the Advanced toolbar. Right-click
anywhere on the toolbar and click
Advanced. With the Advanced toolbar in
place, you can easily access the other
views using the drop-down menu.

Avoid Repeating Text
You probably have our own little

ways of saying Hello or Goodbye, or
maybe a casual signature, which you
follow when you compose mails.
Knowing that you use that same set of
sentences over and over again, Outlook
2007 has a feature called Quick Parts,
which lets you save such sentences so
you can use them later. While writing a
mail, highlight the text you want to
save. Click the Insert tab on the Ribbon.
Click on Quick Parts and click “Save
selection to Quick Parts gallery”. To
access any of the selections you saved,
click on the Quick Parts button again
and choose a selection.

Setting Up Multiple Signatures
Sometimes you require to use

different signatures for different
purposes. Outlook allows you to create
and switch between signatures with a
couple of clicks. Click on the Insert tab
on the Ribbon, and click on the
Signature button. Here, click on the
signature of your choice. If you have no
signatures created, click on
Signatures… Click the New button to
create a new one. Give a name to the
signature and then enter the signature
details, and use the formatting tools
made available. Once done, click Save,
and click New again to create more
signatures. Click OK to save them and
return to the mail composing window.

Translating Selections
Microsoft Office has resources like

encyclopaedias that let you quickly
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SECRETS THAT KEEP YOU AHEAD IN THE RACE

Mail clients have become
rendered much less useful with
all the new online mail services,

and Microsoft’s Outlook seems like the
only one being updated at every MS
Office release. It’s much more than just
a mail client, as you probably know. In
the past, we’ve given you some tips on
the other applications in Office 2007.
Let’s now take a look at mail-related as
well as some not-so-obvious features of
Outlook 2007.

Automatic Formatting For
Calendar

The Calendar in Outlook allows you to set
colours to tasks according to keywords
you enter, which can make grouping and

Illustrations Harsho Mohan Chattoraj

Enable all of Outlook’s features in the navi-
gation pane

Quick Parts lets you add commonly used 
sentences to mails
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access large amounts of information.
One such resource is the language
translator. Outlook 2007, like other
Office 2007 applications, allows you to
translate text in mails to another
language without you having to visit
language translation sites. Highlight
the text in the mail you want to
translate, right-click, and select
Translate > Translate. In the pane
that opens, you can change the
language you want to translate to.

Allot Tasks To A Day
Certain appointments or tasks

sometimes have to be delayed. You don’t
have to re-enter the task to make the
change. Simply drag the task from the
Tasks window to the date in the
Calendar in the To-Do pane at the
right. Make any other changes required
to the task in the window that pops up,
and click Save, then Close.

Changing The Time Period For
Tasks

When you create new tasks using the text
field in the Task window, the task is set
for a default time and date. To extend the
task period from the default amount of
time, you can always double-click the task
and make all the necessary changes there.

An easier and interactive alternative is
available. First switch to the
Day/Week/Month view from View >
Current View. Here, you will see tasks as
highlighted blocks. Click the outer edges
of the blocks and drag it till the time you
want the task or appointment to be set.

Hide Panels
Outlook has traditionally been

short of working space due to all the
features. Outlook 2007 combats that by
allowing you to quickly hide panels
that are not required. The To-Do bar
and the Navigation panel, which take
most of the space, can slide away to a
minimal bar with just icons when you
click the Minimize arrow icon on each
pane. All the features can still be
accessed by clicking the little icons in
the pane. Clicking the headings for the
panes now only brings the panels out
temporarily; they automatically go back
when you click on something else.

Creating A Search Folder
Outlook has a feature called

Search Folder, which filters mails
according to the criteria you set. You no
longer have to manually search for a

certain set of mails; instead, just access
the Search Folder by clicking on it in
the Navigation pane. To create a
Search Folder, right-click on the Search
Folders icon in the left pane. Click New
Search Folder. Scroll down and select
the Create a custom Search Folder
option, and click Choose. Start by
giving a name to the Search Folder.
Click on the Criteria button to add
keywords. Enter the necessary details
and click OK. Click OK twice and the
new Search Folder will be created.

Import And Export News Feeds
Outlook 2007 comes with an

inbuilt RSS reader, which allows you to
keep track of changes made on sites
without your having to visit them. Click
on the RSS Feeds folder in the left
pane. A Web page will load with some
recommended feeds. You can click on
the links to add any of these feeds to
Outlook. To add your own feeds, right-
click on the RSS Feeds folder, and click
Add a New RSS feed. Enter the URL
for the feed and click Add. If you’ve been
using other RSS feed readers and want
to get those feeds into Outlook, first
export the feed list to the OPML format
using your usual RSS feed reader. In
Outlook, right-click on the RSS Feeds
folder and click Import an OPML file.

Click Choose and point to the OPML file.
Click Next, and choose the feeds you
wish to import into Outlook. Click Next
again and then Finish to finish the
import process.

Sending Mails To MS OneNote
Certain mails contain some

information you’d like
to note down for later
use. Microsoft OneNote—
an application that
comes with some
editions of Office 2007—
is meant to do just that,
take down notes. To
send a mail to OneNote,
right-click on a mail in
Outlook and click Send
to OneNote. OneNote
will automatically open
with the mail in it as a
new Note.

Creating And
Attaching Business Cards

Business cards in Outlook 2007 are like
real business cards. They contain
designations and other details regarding
one’s work profile. Outlook 2007 lets you
create and attach business cards to your
mails. Business cards can be created in
the Contacts section of Outlook. Business
cards are typically created for contacts
you’ve added to your contact list. 

To add new contacts and set
business cards for them, click on
Contacts in Outlook, right-click in the
main area, and click on New contact
to make a new contact. You can also
double-click on existing contacts to
make any changes to the details of
those individuals. Click on the
Business Card button in the Ribbon
and you can make changes to the
format of the card and the contact
details it holds. Click OK and then Save
and Close from the Ribbon to save the
changes. Then, while writing a mail,
click on the Insert tab. Click on the
Business Card icon and the business
card you wish to attach to the mail.

Time Zones
Planning appointment times

becomes a little confusing when you’re
handling contacts outside India, in a
different time zone. When you have an
appointment at 5 PM Hong Kong local
time, you need to find the time
difference and then calculate the time
here. The Time Zone feature in Outlook
does this for you. 

Start a new appointment by going to
File > New > Appointment. Click on
the Time zones button in the Ribbon
on top. A new field for location will
appear next to the start and end time for
the appointment. Use the drop-down

Easy altering of time periods for tasks

Hide panels to maximise your work area

Creating search folders allows real-time 
filtering of mail

Take down
rough notes of
important mail
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and set the location. Click Save and
Close. In the To-Do pane on the right,
the appointment will be visible in your
local time.

Force Spell Check
Outlook can force-check your mails

for spelling before they are sent out. Go
to Tools > Options. Click on the
Spelling tab, and check the box for
Always check spelling before
sending. Now when you write a mail
and press Send, Outlook will run a spell
check and prompt you to fix any errors
before sending out the mail.

Setting Colour Categories
Creating colour categories is an

easy way to filter out mail and mark
mails for reference. To set a colour
category, click in the blank checkbox

next to a mail under the Category
column. A default colour will be set to
the mail. To change this colour, right-
click on a mail, click Categorize and
choose a colour. Quick Click lets you
quickly set colours to multiple mails
after the other. The feature can be
found by right-clicking in the mail
window and then on Categorize.
Select a colour and left-click on all the
mails you want to set the colour to.

You can also set shortcuts to colours,
which makes setting colours even easier.
Right-click on a mail and choose
Categorize > All Categories. Select
the colours you’d like to use. Click on
each of the colours, and choose a
shortcut for each colour from the drop-
down menu on the right. Now you can
simply select one or more mails and use
the shortcut you’ve chosen for the
colour to assign the colour category to
the selection.

µTorrent

µTorrent (written as uTorrent because
the special character isn’t the easiest

to type) has made a name a name for
itself as being one of the best torrent
clients for Windows. Its size is under 200
KB, and it is filled with features to
compete with programs some 20 to 30
times its size! We look at some features,
tips, and tweaks to get the most of your
bandwidth and make life easier.

Optimum Bandwidth Settings
Most people tend to ignore their

bandwidth settings and keep the
allotted download rates high and
extremely low upload rates. BitTorrent,
like most other P2P applications, require
you to set a good upload rate to get
proportionate download speeds. 

The Speed Guide in µTorrent is an
easy way to set a right upload and
download speed, and other parameters.
Press [Ctrl] + [G] or go to Options
> Speed Guide. Choose your

connection speed, or the closest
connection speed, from the Connection
Type drop-down. Click Use Selected
Settings. The maximum number of
connections and other settings will be
automatically applied.

Setting Up Ports
One of the main issues most

people face is with open ports. With
BitTorrent, it’s even more essential as
you won’t get sufficient download rates
if people can’t access your machine and
receive data from you.

Some ISPs and routers block ports. If
you use a router, set it up to forward the
ports that you plan on using in
µTorrent. The Speed Guide is useful in
checking if the ports are open or not.
Go to Options > Speed Guide. Enter
a port under Current Port and press the
Test if port is forwarded
properly button. A Web page will
open, telling you if the port is open or
not. If the port is blocked, try using a
different port and check again. Some
ISPs only have a certain number of open
ports, such as port 80, which is used by
the HTTP protocol.

Encrypting Network Data
Some ISPs try to limit bandwidth

to P2P applications like BitTorrent.
Some of the clients—like µTorrent—have
Protocol Encryption, which 
makes detection and limiting by 
ISPs harder. 

You can enable protocol encryption
by going to Options > Preferences >
BitTorrent. Here, choose Enabled or
Forced from the Outgoing Protocol
Encryption drop-down. 

Removing The Connection
Limit For XP

Note: This tip involves modifying and
replacing a system file. Proceed at your own
risk, and back up TCPIP.SYS if needed.
If you’re using Windows XP SP2, your
“maximum half-open connection limit”
is most likely set to 10, as part of an
attempt to limit security issues. There
are patches that have been made that
remove this limitation, so many more
connections can be made which can give
you a boost in speed. One such patcher is
Event ID 4226 Patcher, which can be
found here: www.lvllord.de/?lang=en&
url=downloads.

Using The Web Interface
µTorrent has a feature called Web

UI, which allows you to control µTorrent
remotely and locally through a browser.
This is useful when you aren’t at home
and you still want control over
downloads. The Web UI allows you to do
pretty much everything you can with
the program itself.

Make Outlook handle time difference calcula-
tions for you

Setting color categories helps marking and
sorting mails effortless

Using the right bandwidth settings can speed
up downloads

TORRENT CLIENTS
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Go ahead, have some fun. Change Windows’ look and feel!

Rossi Fernandes

Windows Vista may rule when it
comes to modern interfaces, but

there are some who think Linux still has
an edge over Windows in the looks
department. Now, window managers are
software that change the look and feel
of your operating system. Wouldn’t it be
nice to have the functionality of
Windows we’re so used to, coupled with
the clean look that most Linux window
managers provide?

Blackbox is a minimalist and highly
customisable window manager. It has
been developed on a wide range of *nix-
based operating systems. There are vari-
ants like Fluxbox for Linux that have
branched from Blackbox. The well-
known ones for Windows are bbLean,
Xoblite, BB4Win, and Bluebox. The func-
tioning and theme support for these
variants are pretty much the same.

We used bbLean for this demonstra-
tion where we show you how to get up
to speed with Blackbox quickly, but the
steps should be the same for any of the
variants that you might use.

Setting Blackbox As The Default
Window Manager 
Download any of the Blackbox variants
(bbLean: http://bb4win.sourceforge.net/
bblean/). Installing is done by simply
unzipping the archive to a folder. To
make Blackbox the default window man-
ager, in a Run window, enter the location
of the Blackbox executable followed by
the -install parameter, for example,
C:\Blackbox\Blackbox.exe -
install. A confirmation window will
pop up, followed by a prompt asking
whether you want all the users of the OS
to use Blackbox. Click No if you only want
your account to be set to use Blackbox.
Reboot your computer for the changes to
take effect. When you reboot and log in,
Blackbox will load up instead of
Windows’ Explorer.

At any point, if you wish to remove
Blackbox as your default window man-
ager, follow the same step, using “-unin-
stall” as the parameter. You can also
right-click on the Desktop and select
Blackbox > Install > Uninstall.

Installing Styles
Themes—or styles—in any software
enhance the way it looks; Blackbox has
good style support. Adding styles to
your Blackbox installation is simple. It

involves copying of a few files here and
there. You normally get a set of themes
with any Blackbox flavour, and you can
easily find many more themes on the
Internet at Blackbox community sites
such as Boxshots (www.boxshots.org),
Deviantart (www.deviantart.com), and
Lostinthebox (www.lostinthebox.com).
Blackbox themes are extremely com-
pact when it comes to download size.
Two thousand themes can be com-
pressed to within 2MB! You can find
one such theme pack at Boxshots.
Download the themes and unzip the
archives if any. Copy the files into your
Blackbox\Styles folder. Now right-
click on the Desktop, click on Styles,
and then on the Style of your choice. It
will be applied immediately.

Customising Menus
Once installed, Blackbox automatically
creates shortcuts to commonly-used
folders such as Programs, Quick
Launch, drives, Control Panel, and so
on. To create any new shortcuts in the
menu, edit the menu.rc file in the
Blackbox folder using Notepad (or any
other text editor).

To create shortcuts to programs, add
new entries using the [exec] key-
word. For example, “[exec]
(Notepad) {c:\windows\
notepad.exe}” (without the quotes)
will create a shortcut with the name
“Notepad” pointing to notepad.exe in
the Windows folder.
Using the [path] keyword will let
you browse a path through the
Blackbox menu itself. For example,
“[path] (Games) {c:\Games}”.
Using the [submenu] keyword adds a
submenu to the Blackbox menu. For
example, “[submenu]
(Applications)” adds a submenu
called Applications. All further
entries that you add to the file will
fall under the submenu you just cre-
ated. Adding the [end] keyword ends
the submenu.

Installing And Configuring Add-ons
Similar to adding skins, Blackbox has
add-ons developed by the community
that adds new features to the software.
To add plugins to Blackbox, unzip the
plugin to the Blackbox\ plugins
folder. Now to make the plugin load
every time Blackbox loads, open the plu-
gins.rc file in the Blackbox folder using a
text editor. Here, add a new entry for the
plugin in this format: plugins\plug-

inname\plugindllfilename.dll
An example would be

plugins\bbRun\bbRun.dll. Restart
Blackbox by right-clicking on the
Desktop and clicking Restart under the
Blackbox submenu.

Settings For Blackbox
Not all the settings need to be changed
using a text editor. Some of the more
basic settings can be accessed by right-
clicking on the Desktop and then
selecting Blackbox >
Configuration. Here, you can change
the options relating to menus and looks.
Then right-click on the Desktop, then on
Blackbox, and select Restart to restart
Blackbox so the options are applied. 

You can also alter Blackbox settings
by making changes in the extensions.rc
file in the Blackbox folder using a text
editor like Notepad. Settings for any
plugins that you may install can be
modified by editing the .rc files in
their respective folders. In fact, the
themes in Blackbox, too, are text files
that can be modified to change the

look of the theme.
Many a time, colours need to be

altered within Windows so they better
suit the themes in use. You can do this
by right-clicking on the Desktop and
clicking Properties. Click the
Appearance tab and then on the
Advanced button. Here you can change
colour properties of some items. If you
want more control over the colours of
the items than Windows provides, you
can use a program called Jasmin Color
Changer (http://jote.pai.net.pl/jn/3dcc/).

Blackbox is great fun if you want to
customise Windows’ looks. Blackbox also
adds functionality such as virtual
Desktops, detachable menus, foldable
windows, and more—without sacrificing
system resources. Have lots of fun hours
tweaking Blackbox!

Quick access to settings in Blackbox
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To enable the WebUI, go to Options
> Preferences > Advanced > Web
UI. Click Enable Web Interface. Enter
a username and password. You can
download the Web interface itself from
http://forum.µtorrent.com/viewtopic.php?i
d=14565. Download and uncompress the
RAR file, and copy the ZIP file and the
sortabletable folder from it to the
Documents and Settings\ [your
username]\Application Data\
µTorrent folder. 

If you can’t see the path, you
probably need to enable showing of
hidden files and folders.

Internet Explorer isn’t said to work
for this, so to access the Web interface,
use Opera or Firefox. Open the URL
http://MACHINE_NAME_OR_IP:PORT/gui. For
example: http://127.0.0.1:5555/gui.
Remember, you need to use the same
port as the one you chose for µTorrent.

Settings Download Speed
Schedules

µTorrent has a scheduler that allows you
to turn downloads on and off, as well as
speed limits during certain periods of
time. Go to Options > Preferences >
Scheduler. Click Enable Scheduler.
Set the upload and download rate for
when the schedule is to be enabled. The
blocks in the scheduler view are hours of
every day of the week. Clicking on a
block once makes it light green and
enables the speed limits for that hour.
Clicking it again makes the block white,
which means downloads will be turned
off for this hour. Clicking it yet again
will turn it to dark green, and the
uncapped speed will be restored.

Applying Skins
Like many other apps we use today,

µTorrent lets you change themes and
skins. In the µTorrent preferences,
however, you will not find the option.
You can find a good collection of skins at
www.µtorrent.com/skins.php.
Download and copy the toolbar.bmp to
Documents and Settings\ [your
username]\Application Data\
uTorrent. Restart µTorrent, and you will
find the new, skinned toolbar in place.
To revert to the default themed toolbar,
delete the toolbar.bmp file. Follow the
exact same steps to set skins for the
status and tab icons.

Creating New Torrents And
Adding Them To Trackers

Torrent clients aren’t meant for only
downloading torrents; they also allow
you to create your own and upload
them to trackers. (More on this in just a
bit.) Select File > Create New
Torrent. Choose Add File or Add
directory to add a file or folder. Enter
the address of the tracker that you
want to upload to and a comment if
necessary. Click the Create and Save As
buttons to save and upload the torrent.
Give a name to the torrent file you just
created and click Save. You can then
pass on this torrent to friends for them
to download.

You need a public torrent tracker 
to upload your torrents to. There are
quite a few legal torrent trackers, and
some communities related to a
particular topic—a game mod or Linux
distro, for example. The address for 
the tracker can be found at the
respective sites. Note that it’s the same
with creating and uploading torrents
with Azureus.

Azureus

Many would say the next-best client
after µTorrent is Azureus. Some

would say Azureus is too much of a
resource hog which could be mainly
because it runs on Java. Azureus’ ability
to use plugins to improve functionality is
its biggest plus point. In this section we
dig through Azureus 3.x to find the better
features from the lot and ways to try and
reduce the amount of resources used.

Advanced Mode
Azureus initially asks you to choose

what mode you wish to run—Beginner,
Intermediate, or Advanced, and some
other network settings. Most of the
options and features are locked away until
you switch to Advanced mode. Some of
the tweaks and tips require you to use

modify some of these options. To enable
it, click on the Advanced button in the
toolbar. Select Tools > Configuration
Wizard. Click on English, then Next.
Choose Advanced, and complete the
remaining steps related to network
settings. You can also just change the
mode of the program by selecting Tools
> Options. Click on Mode, and you can
click the Advanced mode radio button.
Click Save, and restart Azureus.

Enabling Download Bars
It can be painful to keep opening

Azureus from the system tray to check
the download status. Azureus allows you
to have a bar for each download that sits
on top of other applications.

To enable the download bar for a
download, switch to Advanced mode.

Right-click on a download and click Show
download bar. You can then move the
download bar to the location of your
choice. You’ll notice it automatically
snaps to the edges of the desktop.

Ports And Connection Speed
Settings

Earlier, we’ve explained why ports and
connection rate settings are important.
The port settings in Azureus can be
accessed by selecting Tools > Options
in Advanced mode, and then clicking

Easy control over µTorrent through your browser

Setting download speed schedules in µTorrent

The µTorrent UI supports skins—not in the tradi-
tional sense, though. You can only change the
icons on the toolbar

Advanced mode allows access to hidden options

The Download Bar keeps you updated on down-
load status



82 DIGIT JULY 2007

Digital Tools l Tips & Tricks

Connection in the side menu. The
upload and download speed options are
visible in the Transfer menu.

Enabling Transport Encryption
We’ve talked of transport encryption

earlier. Azureus, too, gives you the option
of encrypting data. In Advanced mode,
select Tools > Options. You will find
Transport Encryption under
Connection. Check the box “Require
encrypted transport”. Also check the boxes
to enable non-encrypted incoming and
outgoing connections.

Disabling Plugins
Azureus may use plugins to add new

features to the program, but these plugins
also burden the system. You can disable
most of the plugins you don’t use. 

Click on Advanced to the right end
of the toolbar. Select Tools >
Options. Click on Plugins and uncheck
the plugins you don’t use. Note that
some of the plugins may be shared with
other plugins or Azureus itself, so avoid
disabling those. (In the Type column,
you can see if a plugin is shared.) Click
Save and restart Azureus.

Enabling The Torrent Tracker’s
Web Interface

Azureus has an inbuilt torrent tracker. In
Advanced mode, go to Tools >
Options, and under Plugins, click
“Tracker Web”. Make sure the Public
torrent details to <tracker_url> box is
checked.  You can now view information
on the torrents uploaded to your tracker.
You can alter other settings like setting
separate ports for the Web page, and CSS
themes for the Web interface. You can
find settings for the tracker itself under
Tracker > Server.

Create Torrents In Azureus
Now that the tracker itself is

running, you can also create new
torrents to share with others over the
Internet. Go to File > New Torrent.
Click on the “Use an external tracker”
radio button and enter the URL for the
tracker. Choose whether you want to
upload a single file or a folder. Click
Next. Here you can enter multiple
trackers. Click Next, and choose the path
of the file or folder of which a torrent is

to be created. Click Next, and enter the
path where you want the torrent file to
be created. Choose from the appropriate
checkboxes for whether you want to
open the torrent for seeding once the
torrent is created and if you want to use
the inbuilt tracker to host the torrent. 

Accessing Azureus Through A
Browser

Some plugins allow Azureus to be
accessed through a browser. This is
particularly useful when you’re away
from home and want to check on
download status and add or change
downloads. Swing UI is a plugin for
Azureus that lets you do that. Download
it from http://azureus.sourceforge.net/
plugin_list.php. Download the ZIP file,
and unzip its contents into the
Azureus\plugins folder. Next, in
Advanced mode, go to Tools >
Options. Then select Plugins > Swing
UI. Here, select the port for the interface
and the protocol to be used. We use port
5555 and the HTTP protocol. You can
also set a username and password to
make access limited to yourself. Click
Save and restart Azureus. Now use a
browser (preferably Firefox) and load the
URL http://YOURIP:PORT. (You can find
your Internet IP by visiting a site like
www.whatismyip.com. Those with ISPs
that use PPPoe (PPP over Ethernet) can
find their IP address by double-clicking
on the Internet dialup adapter’s network
icon in the system tray. Using services
like DynDNS (http://tinyurl.com/bte78) is
also a good idea if you don’t want to
keep remembering your IP.) If you set a
username and password, you will be
asked to enter it. You can now monitor
and control your downloads.

Using RSS For Starting
Downloads 

A useful feature that can help automate
downloads are RSS Feed downloaders.
These plugins download regular
updates from your favourite sites and
then pick up torrent files from them
and automatically download the files
depending on how you set the filters.
One of the plugins you can use is
RSSFeed Scanner. Find it at
http://azureus.sourceforge.net/
plugin_list.php. 

Download and unzip the file into
the Azureus\plugins folder. Start
Azureus, and you can configure the
feed downloader by going to Plugins
> RSSFeed Scanner. First add feeds
to the list by clicking the “+” icon in
the Feed URL panel. Enter the URL for
the RSS feeds and the location where
you want the torrents to be saved. You
can also choose to add filters so
Azureus will only download files of the
specified criteria. 

Enabling the Web interface for Azureus’ tracker

LINUX

On this month’s DVD, we’ve given you
Fedora 7. We’ll be using Fedora to

demonstrate the tips that follow, but
we’re pretty sure you can do the same
with other distributions.
Note: Some of the tips we are about to show
you might require you to be logged into root.

Adding Windows Fonts To
Linux

Many of us are used to Windows so much
that the sight of Linux’s fonts is
unbearable. It is possible to install
Windows fonts on Linux. Go to System
> Preferences > Look and Feel >
Font. Click on the Details button and
then on the Go to font folder

button. In the window that appears, copy
and paste the Windows fonts. Restart or
re-login to be able to use the fonts.

Advanced Command Line
Traceroute

Those who wish to find the route to a
remote server are used to the traceroute
command. There is an advanced version
of traceroute called mtr available on
Fedora and some other distributions.
mtr not only shows the route, but
refreshes pings to all the nodes up to the
destination machine, and also lets you
choose from different ways of showing
statistics. To use mtr on Fedora, go to

Copying Windows fonts into Linux’s fonts folder
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Virtual Machines
Get operating systems to run on your operating system!

Rossi Fernandes

Some of us get into that weird state
of mind where we want to just

install a software to play around with it
a bit. When you’re thinking of it,
there’s that bit of hesitation when it
comes to Linux, thanks to the general
fear of partitioning and formatting of
drives. What we’re about to do is, get a
Linux distribution running without a
single boot and without a single drive
partitioned or formatted. Impossible?
We’ll show you how!

VMWare has made a name for itself
in the virtualisation software business.
Of late, an open source virtualisation
program called VirtualBox has been
making waves. The way virtualisation
works in VirtualBox, like in VMWare
software, is that virtual components are
created. First, download VirtualBox from
www.virtualbox.org and install it.

Creating A New Virtual Machine
Remember, you can install multiple
operating systems on VirtualBox.
VirtualBox won’t just let you install an

operating system, it’ll also allow you to
run Linux LiveCDs without having to
reboot. Either way, you need to create a
virtual machine.

Click on the New button on the
toolbar. Click Next and give a name to
the operating system and the type
(Windows XP, Linux, etc.) you plan on
using. Click Next. Here, you choose
how much RAM you want dedicated to
the virtual machine. In the case of
large OSes, keep a fairly large amount
of memory.

Next, you choose the size of your disk
drive; in the case of a virtual machine,
you choose the size of the image. Click
New to create a new image. Click Next

and you can choose from a fixed or an
expanding image. A fixed image will
allocate space in advance—so if you have
limited hard drive space to offer the new
OS, choose this. In the case of an
expanding image, as the demand for
space increases, the image file will
increase in size, so you need to keep tabs
on it to avoid running out of space on
your hard disk. Click Next and enter a
name for image file itself, and the size
for it. Follow the next two steps to
complete the procedure.

Using An Image To Install
Every time you download a Linux ISO,
you have to burn a DVD or CD and install
it. There’s usually no other way to go
about it. VirtualBox allows you to install
off the ISO using emulation—the same
way Alcohol 120% works. 

Assuming you have the disk image
parameters set up, click the virtual
machine and click the Start button.
This is similar to powering up a real
computer by pressing the power button.
A window will appear asking you to
select the source to be used to install the
OS on our virtual machine. Click Next,
and choose whether you want to use the
CD / DVD drive or a floppy or even an
image, which is what we are using. To
choose an ISO image, click the Image
file radio button under Media source
and point to the location of the image on
your drive. The virtual machine will then
boot using the data from the disc image.
You can simply run the LiveCD (if you’re
using a Live CD image, of course) or
install the entire OS.

Saving And Restoring States
Save a machine state so you can continue
from where you left off Hibernate in
Windows is a feature that stores the
current state of the operating system,
which can be restored at a later time. The
Snapshots feature in VirtualBox does the
same thing. To save a session, close the

window for the virtual machine in use.
Instead of choosing “Power off the
machine”, click “Save the machine state”.
The next time you power on the virtual
machine, it will resume from the state
you left off at.

Adding Extra Hard Drives To A
Virtual Machine
In virtual computing, adding virtual
hard drives isn’t going to cost you
anything. If you run out of space on the
main image you created, you can
increase your virtual disk space by
adding additional images.

Click on the virtual machine and
then on the Settings icon on the
toolbar. Click on Hard Drives and
choose Primary Slave or Secondary
Slave. You can choose from one of the
created images, or click on the Select
icon to the right. Here, click New to
create a new image, and follow the
same steps you used in the creation of
the virtual machine.
You can, at any time, change storage
space resources by using the Virtual Disk
Manager. Select File > Virtual Disk
Manager. Here you can add, remove, and
release hard disk, CD / DVD images, and
floppy images. 

Running Full-screen Mode
Running an OS in a window mode just
doesn’t seem right. Set up the resolution
in the operating system properly and you
can switch to full-screen mode by
pressing [Right Ctrl] + [F]. To
switch back to window mode, press
[Right Ctrl] + [F] again. 

For this demonstration, we used
Damn Small Linux, but you can use
always full-fledged distributions like
Fedora (from this month’s DVD) or
Ubuntu. You can even run another
instance of Windows on VirtualBox, or
run a Windows virtual machine on
Linux! There are plenty of things you
can use VirtualBox for without having
to worry about messing around with
your current OS.  

rossi_fernandes@thinkdigit.com

Damn Small Linux, ready to run off a Virtual
Machine

Handling of images can be done by using  the
Virtual Disk Manager

Save a machine state so you can continue
from where you left off
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will be able to read and write from and
to the partition.

You can have this NTFS partition auto-
mounted on bootup using steps similar to
those you used for auto-mounting
network shares. Open the /etc/fstab
file in a text editor and add the following
entry at the end of the file:
/dev/NTFSpartition /mnt/ntfs
ntfs-fuse

Installing Java
Fedora doesn’t come with Java

installed; you’re going to have to
download it and install it yourself.
Download the latest RPM of the Java

Runtime or Development Kit from
http://java.sun.com/javase/downloads/inde
x.jsp. Next, go to Applications >
System Tools > Terminal. Navigate to
the location of the downloaded file. If you
downloaded the self-extracting .bin (like
we did), run it using ./filename.

Mounting ISO Images
ISO images are disc images of CDs

or DVDs. In places where you need to
access data on the images when there is
no DVD drive available, you can mount
the ISO as a filesystem in the same way
Windows users would using software
like Alcohol 120%.

First create a new folder where you’ll
be mounting the ISO. Go to
Applications > System Tools >
Terminal. Navigate to the location of
the ISO image. Use the command mount
-o loop -t iso9660 ISONAME.iso
/location.

Setting Up A Network Proxy
For machines that are behind

proxies, it doesn’t allow vital programs
like yum to access repositories over the
Internet. To enable a network proxy, go
to System > Internet and Network
> Network Proxy. Enter the details for

the different protocols and click Close.
You can enter an Automatic Proxy
Configuration address so the program
can pick up all the proxy details from
there. This network proxy configuration
should work for all applications
supporting proxy servers.

Disable Loading Of Modules
After a period of time, you’ll end

up having loads of processes starting on
bootup. There are many which most of
us don’t really require. You can disable
these to save loads of memory while also
reducing bootup time.

Go to System > Administration
> Services. Under the Background
Services tab, uncheck the boxes for the
services you do not want loaded at
startup. Click Save to close the window.
You can also start and shut down the
services from this window: click on a
service and click the Start, Stop, or
Restart button.

Installing And Using Wine
Wine stands for “Windows

Emulator”, and can run quite a lot of
Windows applications on Linux. Wine
doesn’t come with Fedora, so you need
to install it using yum. Start a terminal
and type in yum install wine. Once
it’s installed, use the File Browser to
browse through your Windows partition
or to the location of the Windows
binaries if you already know where they
are. Right-click on the executable and
click on Open with Wine Windows
Emulator. You can also alter the Wine
settings by going to Applications >
Wine > Wine Configuration. Here
you can choose which version of
Windows you want to mimic, and set
paths of important Windows folders.

Extract RPM Files To A
Particular Folder

RPM is a packet manager was developed
by Red Hat Linux. You can extract the
contents of RPM files into a directory of
your choice than just installing it. Start a
terminal by going to Applications >
System Tools > Terminal. Navigate
to the folder to where you want to
extract the RPM file. Type in rpm2cpio
rpmfile.rpm | cpio -idmv, and the
RPM will be extracted.

Let Yum Auto-update Fedora
Updating Fedora can be done by a

single command. yum will connect to
the Internet, and download and install
all the updates. Go to Applications >
System Tools > Terminal. If you are
already root, type in yum update. Use
this command carefully: users with
limited download connections could
have a problem, since there can be quite
a few updates. 

Applications > System Tools >
Terminal. Enter mtr followed by an IP
or name of the remote machine, for
example, mtr www.thinkdigit.com.

Mounting Windows Shares
Let’s face it—too many people use

Windows, so you’re going to have to
access Windows network shares some
time or the other. Samba is what Linux
uses to host shares and access remote
ones. To do this, go to Applications >
System Tools > Terminal. Create a
location where you want to mount the
network share by typing in mkdir
/mnt/netshare, where “netshare” can
be replaced by the name for the mount.
Then type in mount -t cifs
//MACHINEIP/SHARENAME
/mnt/netshare. Press [Enter], and you
might be asked for a password. The
mount -smbfs should work, but in
Fedora, you need to use the -cifs
parameter instead. Adding the -o
username=myusername,password=mypa
ss set of parameters to the mount
command authenticates password-
protected shares. This parameter needs to
be added between the mount command
and the share location. (CIFS is short for
Common Internet File System.)

To have this network share auto-
mounted on bootup, go to
Applications > Accessories >
Text Editor. Open /etc/fstab. At the
bottom of this text file, make an entry:
//MACHINEIP/SHARENAME
/mnt/YOURMOUNTLOCATION cifs
password=yourpassword 0 0

Accessing NTFS Partitions
Just like Windows shares will have

to be accessed through Linux at some
point or the other, you will require
access to Windows’ NTFS file system
too to move files around. Accessing
NTFS partitions in Fedora or other RPM-
based distributions can be done using
the ntfsmount command. Start a
terminal by going to Applications >
System Tools > Terminal. Create a
location to mount the NTFS partition,
for example, mkdir /mnt/ntfs. Next,
type in ntfsmount
/dev/NTFSpartition /mnt/ntfs.
This will mount the NTFS partition to
the /mnt/ntfs mount point, and you

mtr—a feature-packed traceroute application

The Java Environment installed and running on
Linux
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If you’ve seen the best real-time strategy games
like Warcraft III, thrilling first-person shooters
such as Half-Life, and have had multiplayer fun

with Counter-Strike and Quake 3 Arena, you love
them. Have you ever, though, given a serious
thought towards actually making a game? Will it
fetch you money, fame, and success? It can. A
career in games is a lucrative option.

Gaming is a no more a niche market.
According to the latest reports from IDC
India, India is one of the fastest growing mar-
kets for computers. Here, the PC ownership
ratio is 1:50, amounting to 22 million instal-
lations. In the past five to six years, India has
grown as a potential market for the global
game development biggies.

The Internet and Mobile Association of
India recently conducted a study on online
gaming. It found that the online gaming
industry here is worth Rs 210 crore. The study
also found that youth in the age group of 17 to
25 years are the key drivers of the online gam-
ing segment. Yet, the industry faces issues—
high cost of enabling proper infrastructures
in accordance with international standards,
recognition and support of game develop-

ment and related courses, and negative per-
ception among parents.

“The global game development market is
expected to grow to $42 billion (Rs 1.9 lakh crore)
by 2010 from $21 billion in 2006—a CAGR
(Compound Annual Growth Rate) of 18 per cent.
India is becoming an outsourcing hub for ani-
mation and game design and development,” says
Raman Madan, regional manager—Media and
Entertainment Software (APAC), AutoDesk, who
are into the business of software technologies
for the simulation, animation, media, and enter-
tainment domains.

Since 2002, game development in India has
picked up. Earlier, a number of India-based stu-
dios and companies were involved in developing
and testing game projects for companies in the
west. But in the past few years, gaming behe-
moths like Electronic Arts, Gameloft, and
FXLabs, along with the Indian players like Jump
Games, Dhruva Interactive, Trine Game Studios,
Lakshya Digital, Game Shastra, and others have
been active in the game business
in India. 

“The Indian gaming
industry is fairly nas-
cent, and immense
opportunities are
available for game

Be The Game
From playing
games to creating
them… level up!
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artists, game programmers, and for related
tasks as the development studios continue to
grow rapidly in India,” says Tony Garcia, CEO,
FXLabs Studios.

It’s All About Growth
India is looked upon as a talent-hunter’s para-
dise by companies into animation and gaming.
The game development industry also hires ani-
mation professionals from that industry.
According to a NASSCOM report, Animation and
Gaming India 2007, about 16,500 animation pro-
fessionals were employed in the animation
industry in 2006. This figure is expected to
exceed 26,000 by 2010.

Even so, finding highly-skilled profession-
als to match global standards still remains a
challenge. There are different areas in the
gaming industry, such as design, develop-
ment, testing, and distribution. Game develop-
ment borrows a lot from the animation indus-
try—the growth of the gaming industry is
closely tied with that of the latter.

Game Development: This involves the con-
ception and nurturing of a game, starting from
an idea and finally to a working game. “A per-
son seeking a career in game development can
pursue a bright career in the different func-
tions, which might be creative and/or techni-
cal,” says Reena George, general manager,
human resources, India Games. 

Within game development lie sub-segments
such as design, programming, production, visu-
al arts, and audio.

Game Testing: Testing is part of the general
game development process, but quite a few com-
panies and studios in India offer testing services
exclusively for games to western countries. Those
passionate about games and who have good
power of observation might want to choose this
option. A game tester plays games, observes its
working, and finds graphical, audio, and bugs
related to the programming. Although the job
profile of game testers appears rosy and has lots
of fun packed in, they are required to play games
for long hours. This might cause physical strain
to the eyes, numbness in the fingers, and more!

Business And Distribution: People from
the business studies and marketing manage-
ment domain fit this work profile best. Game
distributors promote gaming content.
Distribution strategies, dealing with content
providers, identifying target audiences, cus-
tomer feedback and management, etc. fall
under this job description. They share infor-
mation with client companies about gaming
habits, tastes, and the preferences of the tar-
get audience.

Let’s go on to the job functions to be per-
formed at each level within game development.

Loading Stage…
Each function in the industry has levels of
hierarchy. For a few of the common designa-
tions and sub-segments in game development,
refer the table Teams and Designations.

Design: A game designer is a jack of all
trades. He has a variety of interests and
understands the technical side—program-
ming and graphic design. An understanding
of psychology and its implementation can be
helpful. Knowledge of Artificial Intelligence
(AI), too, helps. Tasks here include conceptu-
alisation of a game, design documentation,
and working closely with other teams so as to
see whether the game is being developed in
accordance with the concept. The game
design team has a lead designer, who usually
evolves by working as a graphic designer or
game programmer.

Programming: Graphical elements such
as animated characters, game levels, back-
ground textures, and sound effects are coded
to work together with the game engine. Good
coding skills with command over program-
ming languages such as C++, Python, Java,
Flash, and other software used in game pro-
gramming are required.

Being well-versed in programming with
OpenGL and DirectX is essential. Knowledge of
physics and AI is very beneficial. A programmer
should have a balance of technological and cre-
ative abilities. “Gaming is about technology,
action scripting, animating, etc., but equally, it is
about game play, creativity, and an understand-
ing of consumer likes and preferences,” informs
Carlton D’Silva, creative director, Hungama, who
are into the media and entertainment business—
viz. gaming portal hungama.com—and also pro-
motions marketing .  

Visual Arts: Candidates from the fine arts,
animation, and the visual arts / visual commu-
nication fields are best suited for the visual arts
team. Character and background designing and
2D / 3D modelling and animation are the major
activities in this segment. This team works
towards constructing the visual elements and
the user interface for a game. Students trained
on animation software packages also get
recruited into this segment. Knowledge of soft-
ware packages meant for graphics like
AutoDesk Maya, 3ds Max, Motion Builder,
Adobe Photoshop, Corel Paint, and others
makes up the technological side of the equa-
tion. For more about animation, turn over to
Life @ 24 fps in Digit, April 2006.

Teams And Designations

Job Title
Game designer, level designer, technical designer, script writer
Game programmer, AI programmer, network programmer,
R&D—engineering programmer, physics programmer, tools
programmer, graphics programmer, animation programmer,
technical writer, software architect
Concept artist, texture artist, material specialist,
environment artist, storyboard artist, 2D/3D modelling
specialist, texture specialist, 2D/3D animator
Game producer, executive game producer, line producer,
localisation producer, network game producer, multiplayer
producer, advertising producer
Musician, SFX (sound effects) artist, sound engineer, sound
programmer
Sales, marketing, and other top management profiles such as
chief executive officer, chief operating officer, vice
president— design, programming, production
Game tester, platform specialist (PC, console, mobile phone,
handheld)

Functional Area
Design and Creative
Programming

Visual Arts

Production

Audio

Business and Other

Testing

With prestigious
international
developers setting
up development
centres on Indian
shores, the scope
of opportunities
is simply vast”

Ninad Chhaya
Executive vice
president
Operations and
production
Jump Games
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Production: At the core, a project is lead
by a producer who supports the project. Like a
typical project manager, the production man-
ager’s tasks involve budgeting, meeting the
requirements of various departments, docu-
mentation of reports, and keeping track of
project progress. Knowledge of and exposure
to design, programming, and visual arts help
in their work. 

Audio: Professional music composers, can-
didates with a sound engineering degree, and
SFX artists can work in an audio and sound
effects team. The background score and the spe-
cial effects are added to match the graphics,
gameplay, and storyline of the game. Sound
engineers and artists should have had hands-on
skills working with software like Sound Forge,
Cubase, Bink, Miles, and such.

We’ve already spoken about game testing. It
is very similar to software testing and valida-
tion. Individuals from a software testing and
validation background would be a perfect fit
for this segment.

Candidates with a business management or
management studies degree are the ideal
choice for business functions within the gam-
ing industry. Besides activities towards growth
and expansion of the business nationally, they
look at international tie-ups.

Essential Gear
Many game development companies encourage
their employees to play games in their free
time, or even during office hours. “The gaming
industry firmly believes that those who don’t
play games can’t visualise for better game
ideation,” says Rohit Sharma, CEO, Zapak.com,
a casual gaming portal.

“Passion for gaming is treated as a value-add
in reference to the specific function in game
development. A good balance between a pas-
sion for gaming and the capability to perform
the assigned task helps bring out the best”,
adds George.

We’ve already spoken about the required
educational backgrounds. “Surprisingly, the
game masters come from varied backgrounds—
from microbiology to commerce,” says Naveen H,
national manager for gaming, Sify, an online
portal that also offers Web domain services and
runs game-dromes. 

A graduate degree or a diploma is essential
for any professional segment. If you’re looking at
a serious education in gaming, several universi-
ties in the US, the UK, Australia, and other coun-
tries offer specialised degree and diploma cours-
es in specific aspects of game development. 

“Producers could benefit hugely with an all-
round knowledge of art, programming, and
design along with project management,”
informs Sharma.

Certification
The demand-supply gap in the industry is very
wide as of now. “No exposure, lack of knowledge
about gaming as a profession, and unavailability
of good training schools are the factors that
affect the demand-supply gap in the gaming
industry,” says D’Silva.  

No courses focusing specifically on game
development are available. “India could defi-
nitely benefit from courses for game-related
functions, especially if they are well-struc-
tured and offer an insight into how games are
developed, how technology enables the indus-
try, and also provide a background into the
industry and the career options within it,”
says Raman.

What’s required is collaboration with
international animation and gaming insti-
tutes, along with government recognition of
curricula for graduate and Masters programs
meeting global standards.

Rewards And Credits
Any rewards and/or credits, like in any other
occupation, are given on the basis of individ-
ual performance as well as performance in a
team effort.

Here is a snapshot of how much you can
expect to earn. Though it is a niche market of
about 50 employers, the remuneration varies
across organisations. The ranges mentioned
below are aggregated, indicative, and on a
per-month basis. 

These figures can be expected to go up by 10
to 50 per cent on the basis of the market situa-
tion and demand-supply ratio.

Future Prospects
Gaming is expected to be the next big thing in
the entertainment industry. “India, with its
cost-effectiveness and availability of skilled
resource pool, is already a preferred destina-
tion among the global players. Now, with pres-
tigious international developers setting up
development centres on Indian shores, the
scope of opportunities is simply vast,” says
Ninad Chhaya, executive vice president—opera-
tions and production, Jump Games, who offer
game content development services. According
to the NASSCOM report, Animation and Gaming
in India 2007, the Indian gaming industry for
the year 2006 was nearly Rs 48 crore, and by
2010, it is expected to surpass Rs 424 crore.

With all three major gaming consoles now
available in India, the three companies produc-
ing the consoles will look for local game devel-
opers who can work on projects at a global scale.

Industry stalwarts and the available fig-
ures say it out loud—game on, people. Grab
your controllers! 

samir_makwana@thinkdigit.com

Gaming is about
technology, action
scripting, and so
on, but equally, it
is about gameplay
and creativity”

Carlton D’Silva
Creative Director
Hungama

Approximate Remuneration Matrix (per month)

Entry Level
Rs 10,000—30,000
Rs 12,000—25,000
Rs 15,000—35,000
Rs 12,000—30,000
Rs 10,000—15,000
Rs 6,000—20,000

Rs 10,000—30,000

Middle Level
Rs 30,000—45,000
Rs 25,000—40,000
Rs 35,000—60,000
Rs 30,000—50,000
Rs 15,000—30,000
Rs 20,000—45,000

Rs 30,000—50,000

Top Level
Rs 45,000 and above
Rs 40,000 and above
Rs 60,000 and above
Rs 50,000 and above
Rs 30,000 and above
Rs 45,000 and above

Rs 50,000 and above

Department
Design
Production
Programming
Visual Arts
Audio
Business devel-
opment and
allied operations
Testing
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hile the world’s waited for Vista, the alter-
natives—Linux and Mac OS X—have had
the time to garner some attention; fans

of those systems have lost no opportunity to tempt
you to forsake Microsoft and join their ranks.

In light of these developments, it’s about time
we took a look beyond all the hype, the cheeky
advertisements and the fanaticism, and found
out which of these systems wins the productivity
war. More professionals are going mobile these
days, so we’ll be looking at how they fare as
laptop platforms. A lot of things will hold true
for desktops as well, naturally. In the ring are
Windows Vista—any new laptop you buy today
will come with it; OS X Tiger on a MacBook Pro;
and SUSE Linux Enterprise Desktop (SLED—a paid
distribution, or distro), as well as Ubuntu, which
is widely regarded as the best free Linux distro.
You can also buy support for Ubuntu in India—
we’re looking at solutions where people get paid
to solve your problems.

Our Methods And Madnesses
We spent a couple of weeks with each plat-
form, and went about our daily business—surf-
ing the Internet, e-mailing, creating and edit-
ing documents, tinkering with new applica-
tions, and generally getting our lives organ-
ised. And so it begins…

Into The Interfaces
Working in Vista isn’t too different from
working with XP, though it’s better in
many ways. There’s a taskbar item for
everything, so no more using [Alt] +
[Tab] to hunt for dialog boxes that lost
focus. Buttons are more indicative—the
confirmation dialogs in Vista say “Perform
Action” and “Don’t Perform Action”
(depending on the action, of course), so
you don’t need to read a lecture.

You no longer need to hold down [Ctrl] or
[Shift] to select multiple files—you can
enable checkboxes in Explorer’s Folder Options,
and do exactly what that implies: check the files
you want to select, or use the checkbox at the
top to select all files. [Alt] + [Tab] is bigger,
and features application thumbnails. If you
have a graphics card that can handle it, there
are pretty effects too.

Mac OS X delivers a substantial culture shock
to first-timers. Desktop icons are to the right of
the screen, the control buttons have gone over to
the left, and application menus have moved to the
top of the screen rather than within the window
itself. Then there’s the Dock, a Quick Launch
toolbar and taskbar rolled into one. Application
icons jump when it is starting or if it has a mes-
sage for you.

Still, after a couple of hours of poking and
prodding, OS X’s design becomes easy to work
with. Some things continue to bother us,
though—most notably the fact that selecting a file
and hitting [Enter] renames it! To run the file,
you have to use [Command] + [O] or [Com-
mand] + [Down Arrow].

OS X isn’t the most keyboard-friendly plat-
form either, so we found ourselves using the
touchpad more often than we’d like. We’re used
to using [Alt] + [letter] combinations to
get to menu items, but you can’t do this with OS
X: you have to access the menu bar using [Ctrl]
+ [F2] first ([Ctrl] + [Fn] + [F2]on a Mac-
Book or MacBook Pro) and then use the arrow keys
to navigate to the menu you want. While its Finder

function has support for drag-and-drop,
you can’t use shortcuts like [Command]
+ [C] to copy files. These instances can
be quite frustrating.

Both SUSE and Ubuntu are based on
the GNOME Desktop Environment, but
they’ve customised it differently. SUSE
prefers the Windows-style look—taskbar
at the bottom of the screen, a start menu
with your favourite applications that

You’re the professional on the move. You need a hassle-free platform to go about your daily
business. Will it be Vista, Mac OS X or Linux? Read on

W

No-nonsense Notebook
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even responds to the Windows key. There’s a
search text box in the start menu à la Vista,
though searches aren’t “live” (as you type). There
aren’t any cascading menus: your applications are
presented to you, neatly categorised, in a window.
There’s even a search box to filter your selection;
effectively, you have two-click access to all the
items you need.

Ubuntu, too, takes the two-click approach.
Applications are only a sub-menu away, though
preferences and administration options are two
steps away.

GNOME’s Nautilus File Manager is very
Explorer-like, just lacking eye-candy. GNOME also
features taskbar buttons for every item on the
screen. Overall, we prefer the taskbar-button
approach that Windows and Linux have.

Pretty Pretty
OS X was the first to woo potential customers
with shiny graphics, and “ooh”-inducing transi-
tions; Microsoft followed suit with the Aero
effects in Vista, and Novell started its own XGL
project for 3D effects in Linux. Cool effects can
make working slightly more pleasant, but does
all this fanciness really help?

One of the supposedly utilitarian features of
Vista’s Aero is Flip 3D, which “uses the dimen-
sion of visual depth to give you a more compre-
hensive view of your open windows, helping you
sidestep chaos even as you juggle myriad open
files and programs.” After starting Flip 3D, you
scroll through open windows like a Rolodex. But
remember that Flip 3D causes entry-level
graphics cards (NVIDIA’s 6600 and thereabouts)
to stutter a bit.

OS X has a good number of tricks up its sleeves;
moving over the icons in the Dock enlarges them
and the surrounding icons proportionately,
making your desired icon easier to click on. Hit
[F11], and all windows slide into the edges of
your screen, revealing the Desktop. Hitting [F9]
starts Exposé, which arranges all your windows on-
screen—hover over them to find out what they are,
and click on them to switch. On a MacBook or Mac-
Book Pro, you’ll have to hold down the [Fn] key
and then hit [F9]—quite off-putting.

With SUSE and Ubuntu, you can either enable
Desktop Effects from their respective administra-
tion menus, or install Beryl, a window manager
built specifically to take advantage of all that XGL
has to offer (the default used otherwise is
Compiz). In all cases, workspaces are arranged on
a 3D cube. If you hold down [Ctrl] + [Alt],
click on the Desktop and drag, you can view the
cube as if you were holding it in your hand—

imagine an actual rotating cube, with one
window on the left, a document window on the
top, and so on! Before XGL, you would switch
between workspaces by moving your mouse
cursor over the Workspace Switcher and using the
scroll wheel—no keys to hold down, and consid-
erably less mouse movement. 

The verdict on the experience: in descending
order, it’s OS X, Vista, and Linux. The effects in OS
X feel like a part of the OS, as opposed to the
“slapped-on” feel of the other two. Apple devel-
opers know exactly what hardware the OS is
going to run on (viz. the latest iMacs, MacBooks,
etc.). Vista and Linux need to run on anything
from a Pentium 4 to a Core 2 Duo system, so the
option to turn off effects is a must.

Graphics aren’t everything, though.

They Call Me The Seeker
Integrated search is a very handy thing to have on
your PC—let’s look at our contenders’ offerings.

Vista’s new Start Menu is commendable—no
more infinitely cascading menus; menu items
expand and collapse in the left pane of the Start
Menu, and perhaps the most important addition is
the Search box. Type in the first letters of the appli-
cation or file you want, and Vista will search for it
as you type, and display the results right there. It
even supports searching for the first few letters of
each word—“win me pl”, for example, will bring up
Windows Media Player. This has almost completely
replaced Start > Run for us. The search box is
also present in Windows Explorer, so instead of
navigating through folders, you just enter the file-
name in the search box and Windows searches for
the file in real-time. You can also search by docu-
ment content, and add “tags” to files (like “vaca-
tion goa” for your Goa photos) to enable quicker
searches. All very nicely done, though the indexing
service does sometimes suck up resources.

The thing that started it all was OS X Tiger’s
Spotlight, which indexes all the files on your Mac.
It’s accessible through a simple shortcut ([Com-
mand] + [Space]; remember, we’re on a laptop
and don’t want too much touchpad activity). You
can also add “Spotlight Comments” to files—the
precursor to Vista’s tags—for quick searches.

When you install Beryl on Ubuntu, you get to use the “transparent cube” to see
all your applications. It’s nice, but still not a great boost to usability

This is a pretty silly thing to have to deal with in OS X—if
you have minimised many documents of the same type,
the only way to tell them apart is by hovering your mouse
over them—more undesirable trackpad activity
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SUSE comes with Beagle Desktop Search pre-
installed, and there’s a search box in the start
menu as well. While Beagle is a competent tool—
it indexes your files, e-mail, address book, and
even sticky notes—it doesn’t give you results as
you type. You need to install Beagle separately in
Ubuntu—the pre-installed search tool is about as
fast as XP’s default search.

And now to the heart of the matter.

The Applications
You have an OS, and it naturally follows that
applications must exist for it. With Vista, the
question doesn’t arise—so we’ll talk about OS X
and Linux. 

That there aren’t applications for OS X and
Linux is a myth, but the likelihood that you won’t
find a Mac or Linux version of your essential tools
is quite high. There’s often an alternative, but

then you need to assess the quality of that alter-
native before making a switch.

In the office suite department, you can opt for
either Microsoft Office 2004 or OpenOffice.org for
the Mac (the latter for Linux, too). If you’re used to
the Office 2007 interface on Windows, however,
it’s like going back in time, so we’d recommend
waiting till Office 2008 releases for the Mac later
this year. Read about more software for OS X in
this month’s Fast Track. Applications for the Mac—
especially the paid ones—feel tightly integrated
with OS X and are quite easy to figure out.

You can also run Windows applications on OS
X and Linux using CrossOver—we recommend
this option over Wine because you pay for the sup-
port, and if you’re working with applications that
handle critical data, you want a minion who’s
paid to solve problems you encounter. On the
Mac, you can also use BootCamp or Parallels
desktop to run XP or Vista, so you can run Win-
dows-only applications when you need to, and
switch back to OS X for the rest of your work.

Weighing these alternative methods to run
Windows applications against the alternatives
depends on how many Windows-only applica-
tions you can’t live without. You’d feel like quite
the jackass if you bought a MacBook Pro for over
a lakh only to find yourself using Windows XP on
BootCamp more often than OS X. Ditto for Linux—
you’ll rest easier running Windows applications
on Windows.

Getting Them, Throwing Them
On Windows, applications leave traces behind,
and there’s the task of removing those traces—
like cleaning your Registry. What do OS X and
Linux offer?

To install an OS X application, you just down-
load a .dmg (disk image) file, mount it by double-
clicking, and drag the application to the
Applications folder to your hard disk—that’s it!
Some applications come with installers, but the
former is what you’ll encounter more often.
When you’re done with an application, just drag
it to the Trash and it’s gone! All this sounds too
good to be true, and it is. The application as it
appears to us—a .app file—is actually a folder,
much like the application folder in your Program
Files directory—complete with executables, set-
tings and so on. There’s no system registry, so
when you delete the .app file, the application is
gone. However, a lot of applications store infor-
mation—particularly user-specific settings—in
the Library/Application Support folder (the OS X
equivalent of the Documents and Settings folder
in Windows), and these files remain even when
you’ve deleted an application—you’ll have to man-
ually remove these.

With SUSE and Ubuntu, you can install soft-
ware through online repositories. This works
better than installing through downloaded pack-
ages because of the evil of dependencies. Appli-
cation A won’t run if you haven’t installed library
B, and library B is incomplete without libraries C
and D. Both distributions have their own official
repositories, but they aren’t configured with the
SUSE install, because the software available isn’t
part of your support contract. You have to add the
OpenSUSE repositories manually, and this isn’t
pleasant—it took us many tries to even get a con-
nection to the server, and the operation would
fail even then. Ubuntu is much better—you can
start installing applications seconds after your
first login, and the selection is vast.

In both cases, dependencies are automati-
cally installed—the flip side is that you need a
fairly fast Internet connection and a large
download limit.

The Security Angle
Security has been a priority in Vista’s develop-
ment, we’ve been told time and again, but the
number of exploits mushrooming for the new
OS says a lot more. True, it takes security a bit
more seriously—users aren’t logged in as Admin-

Keynote is one of those “killer apps” on the Mac. It’s a brilliant alternative
to PowerPoint, and is much easier to use

Vista even makes you authorise its own Control Panel
applets before they make major changes. UAC isn’t fool-
proof, and it can get on your nerves but it’s a good thing to
have regardless
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istrator on the first run, and User Account Con-
trol (UAC) ensures that every application making
changes to the system is authorised to do so. UAC
can be a bit of an annoyance sometimes, and the
fact that there’s an option to turn it off is its first
flaw. In Linux and OS X, any application that’s
making modifications to the system needs you to
enter the root password, so even if malicious
code does enter your machine, it can’t do any-
thing without root access.

The *nix architecture—on which both OS X
and Linux are based—is inherently more secure.
Nobody can argue with that. If you’re going the
Vista way, don’t forsake your anti-virus and anti-
spyware tools anytime soon.

The Laptop Experience
Most of what we’ve talked about thus far
applies both for laptops and Desktops, but there
are a few things exclusive to laptops. If you own,
or plan to buy, a tablet PC with Vista, you’re in
for a treat. Tablet support has been built into
Vista from scratch, so it doesn’t feel like the
hack that Windows XP Tablet PC Edition felt
like. You can use your handwriting to enter text
in any field that accepts it—the handwriting
dialog is always waiting in a corner of the
screen. Handwriting recognition is impressive
to start with, and gets better as it learns your
nuances. You can also assign “Pen Flicks” for
common tasks like copying text or executing a
keyboard shortcut. 

When you go the Mac way, you get to enjoy
the great touchpad features. The touchpad
driver responds to touches from two fingers as
well, so while you can use a single finger to
move the mouse cursor and tap to click, using
two fingers lets you scroll and tapping with
two fingers becomes a right-click. As you start
getting used to this, the single click button at
the bottom of the touchpad starts to seem
redundant.

Linux users have some respite, though—there
is a Linux driver written for Synaptics touchpads
(nearly all laptops use them) that lets you use
multiple fingers—find it at http://tuxmobil.org/
touchpad_driver.html—assuming  your hardware
supports it.

The Bottom Line
Just like on Desktops, Vista is the safe choice. It’s
Windows, so it’s familiar territory, applications
are in abundance, you’ll get it pre-installed on a
nice, reasonably-priced laptop today, and the
tablet PC experience is another feather in its cap.

Between the two Linux distributions, we
recommend Ubuntu, with paid support to
help you through your growing pains (find
the Indian support firms at
http://www.ubuntu.com/support/commercial/mar-
ketplace/asia). It’s quite gentle on the first-time
user, but you need to tweak a lot of options to
make it suit your needs—too many—and some-
times even simple things like installing Post-
Script fonts to work with a Windows
application under Wine can turn out to be
mammoth tasks. When things go wrong with
Linux, they usually go horribly wrong.

In terms of the overall experience, OS X on a
MacBook or MacBook Pro comes up tops. You
don’t have to worry yourself about the latest
viruses (unless there’s a new Mac virus), you
don’t have to “spring clean” if it starts to get
sluggish—which it doesn’t, regular format-rein-
stalls will be a thing of the past, and the
touchpad experience sets it apart from the com-
petition. It’s quite the idiot-proof OS as well—
and it still stands strong. The only trouble is the
price—an entry-level MacBook costs Rs 67,000,
and the MacBook Pro starts at Rs 1,15,800. If
you’ve got the money and have no Windows-
only applications tying you down, head to the
nearest Apple retailer. 

nimish_chandiramani@thinkdigit.com

Decision Maker
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Want to print, scan, fax, copy all
at once? Enter the Jacks of all
Trades; join us as we search for
the Master

One Thing 
Too Many
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Jayesh Limaye

W
e had assumed last
year that inkjet
MFDs would soon be
on their way out in

the face of the falling prices of
laser devices; turns out this was-
n’t to be. In fact, the market
teems with as many inkjet
devices as it did a year ago. Inkjet
printers still rule the photo-print-
ing roost: laser printers can only
dream of coming even close.

For our test, we divided the
contenders into Home, Office,
and Professional, based on their
price and the features they offer.

HOME MFDS
“MFDs are not really meant for
home use”: that’s what you’re
told. But with prices rivalling
those of inkjet printers, we do see
MFDs making their way into
homes.

The MFDs in this first catego-
ry cost below Rs 6,000, and lack
features such as fax, since this is
not of much importance to
home users. We selected five
MFDs here—from Brother (the
DCP-130C), Canon (the PIXMA
MP160), Lexmark (the X1270),
and two from HP (the Deskjet
F380 and the Photosmart C3188).

Features
Printing
An MFD’s primary and most
important function is printing.
The Brother MFD uses piezoelec-
tric technology to fire ink drops
onto the paper surface, as
against the thermal technology
employed by Canon, HP, and
Lexmark.

The Brother and Canon
MFDs come with four separate
ink cartridges—one each for
black, cyan, magenta, and yel-
low. This is economical if you
end up emptying the tank of one
colour. With a two-cartridge sys-
tem (one black and one for all
three colours), you’ll have 
to replace the one colour car-
tridge even if the other colours
haven’t been spent.

Barring the Canon PIXMA
MP160, which has an input 
tray paper capacity of just 20
sheets, the other MFDs accom-
modate 100. Though this is not
very important for home use, 
a higher capacity certainly 
doesn’t hurt.

Scan, Copy, Fax
All the MFDs feature 48-bit
flatbed scanners capable of scan-
ning A4 size documents. A scan-
ning resolution of 600 x 1200 is
the most common, but the HP
MFDs have better resolutions of
600 x 2400 and 1200 x 2400—the
Deskjet F380 and the Photosmart
C3188 respectively.

You can scan directly to a des-
tination on your PC—like an e-
mail or image management
application—from the Brother
DCP-130C and Lexmark X1270,
something the rest of the MFDs
in this category can’t. These two
devices also come with image
editing and OCR software.

Copying is a breeze with all
the MFDs supporting colour as
well as black-and-white copying.
Except for the Lexmark, all the
MFDs support multi-copying.
The Brother DCP-130C supports
99 copies in this mode, the high-
est among the MFDs across all
categories.

Fax and Automatic
Document Feeding (ADF) are
absent on all the MFDs, but they
will not be missed much.

Build Quality And Other
Features
The Canon MP160 has a delicate
scanner lid, which therefore
seems easily susceptible to dam-
age. The Lexmark didn’t seem too
sturdy either, but the scanner lid
is a tad better than the Canon’s.
The Brother and HP have com-
mendable build quality. It is
relieving that none of the MFDs
have trays sticking out, so there’s
no possibility of breaking one.

The Brother DCP-130C has the
smallest footprint and is very
compact, but is still the heaviest.

While the HP F380 and the
Lexmark do not feature any LCD
interface, the Canon MP160 has a

7-segment display—something is
better than nothing! The Brother
has a one-line LCD display that
provides you with all the neces-
sary information, while the HP
Photosmart C3118 has an icon-
based display, also very easy to
understand.

The Brother DCP-130C comes
loaded with media features such
as support for a variety of mem-
ory cards and PictBridge. The HP
Photosmart C3188, being a prop-
er photo MFD, has buttons to
reprint photos as well as 
proof sheets. Interestingly, it 
features memory card slots but
not PictBridge!

Performance
Printing
The Canon PIXMA MP160 prints
really fast—our normal-quality
text document printed in 9.3 sec-
onds flat. It was also the fastest
in printing our combi-document
at normal quality. Even while
printing at the highest speeds, it
prints exceptionally well. The
edges of the text are crisp, and
the ink doesn’t blot the paper
even at high quality.

When printing at the best
quality, the HP F380 and
Lexmark are the slowest. The
Lexmark is the slowest at photo
printing as well. The Canon
MP160 and HP C3188 have excel-
lent photo print quality, but the
Brother produced a print that
looked faded—its “photo MFD”
title doesn’t reflect in its quality. 

Scanning And Copying
While 200 dpi black-and-white
scan times is around the same
for all the devices, the difference
becomes more evident at higher
resolutions and in full colour.
The Lexmark slows down the
most in this case, while the
Canon is the least affected.

The scans produced by both

J U L Y  2 0 0 7

Canon PIXMA MP160
Performance plus good value

HP Photosmart C3188 All-in-One
A value photo MFD with good features
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The Test Rig
Our test machine is fairly entry-level—an Intel Pentium 4 560 3.2
GHz processor on a Gigabyte GA-965P-DQ6 motherboard with 1
GB of 533 MHz DDR2 RAM, an NVIDIA GeForce 7600GT graphics
card, and a 120 GB 7200 rpm ATA IV Seagate Barracuda hard
disk. We used Windows XP with SP2 as the OS.

Media used
Text/combi-document printouts: 100 gsm (grams per square
metre) paper from Berga (A4 size)
Photo printouts: 160 gsm glossy photo paper from Novajet
(A4 size)

Features
We look for features such as PictBridge, memory card readers,
fax, input tray capacity, number of cartridges, and so on for the
device in general. For the scanner, we consider the maximum
scan resolution, bit depth, scanner type, and the presence of
automatic document feeders (ADF). For the copier aspect, we
look for the ability to work as a standalone device, the maximum
number of pages that can be printed in multi-copy mode,
reducing or enlarging a copy, and more.

The Printer Tests
We use a text document to test the raw print speeds of the
printers of the MFDs. To test the ability of the MFDs to handle the
various aspects of a regular document, we create a combi-
document with a mixture of black text, graphs, and images. We

test print quality at Normal and Best quality for the combi-
document, and only Best for photo prints. We also clock the time
taken in each case.

The Scanner Tests
To test the scanners for speed, we scanned an A4-size image five
times and average the time taken for each scan—the scanners
start out cold, so we need to compensate for the warm-up time.

We imported the same image at 150 dpi and 600 dpi in
Adobe Photoshop CS2, and scanned a full text document in black-
and-white at 200 dpi. The scanners then underwent a test to
determine colour differentiating abilities using the Kodak IT8
card with different shades of colour—each a little different from
the preceding one. Next, we used the resolution chart—a chart
with five boxes with parallel lines packed very close, and each
subsequent box with lines packed more densely. We scanned the
resolution chart at 300 dpi. This test gives us a measure of the
scanner’s capability to capture minute details—whether it’s able
to discern between the lines or not. Last was an OCR test to check
the scanner’s ability to differentiate light and dark areas: a print
article was scanned into ABBYY Fine Reader Pro 8.0 PE, and
checked for wrongly - interpreted letters. We counted the number
of mis - spelled letters in each case.

The Copier Tests
Here we copied the text document in black-and-white, and the
combi-document in colour, and rated the MFDs on their speed
and print quality.

How We Tested

the HP MFDs seemed to have prob-
lems distinguishing between adja-
cent shades in the light and the
dark colours. The rest produces
scans of acceptable quality.

The copy quality of the Canon
is the best, followed by the HPs.
All in all, none of the MFDs are
particularly disappointing, and
copies are good enough to save
you a trip to the photocopy cen-
tre in a crunch situation.

OFFICE MFDS
MFDs have always been used more
in offices, where space-saving is
important. It is therefore no won-
der that half the number of MFDs
we’ve tested fall under the Office
MFD category.

All falling in the price range
of Rs 6,000 to Rs 10,000, nine
MFDs feature in this segment:
two from Brother (the DCP-330C
and MFC-240C), the Canon
PIXMA MP460, four from HP (the
Officejet 4355 All-in-One,
Officejet 5610 All-in-One,
Officejet 5680 All-in-One, and
Photosmart C4188 All-in-One),
and the Lexmark X4270.

Features
Printing
The HP and Lexmark MFDs have
two ink cartridges, while the

Brother, Canon, and Epson have
four each. The input paper tray
capacity for all of them is 100,
and this is more than enough for
a moderate-size office with mod-
erate workloads.

Scan, Copy, And Fax
For the price, the HP Officejet
4355 and Lexmark X4270 pack
in a lot of features. The 4355
boasts of a good scan resolution
of 1200 x 1200 dpi. The Lexmark
X4270 is a direct competitor, but
has a lower scan resolution of
600 x 1200 dpi. The gripe in
both cases is that these feature a
sheet-fed scanning element and
are therefore slower than their
flatbed counterparts. There is

also the chance of documents
getting crumpled inside the
scanner. Fax, complete with
handset, is also part of the par-
cel in these two MFDs. The HP
4355 can create up to 200 copies,
the largest number in this
entire test.

The HP C4188 and 5610 fea-
ture high-resolution scanning at
1200 x 2400 dpi, enabling them
to pick up even fine print from
documents. The Brother DCP-
330C and HP C4188 have flatbed
scanners, while the HP 5610 has
the option of a sheet-fed scanner
too. A sheet-fed scanner, in con-
junction with an automatic doc-
ument feeder (ADF), relieves you
from the task of feeding a num-
ber of pages to be scanned—sim-
ply stash the paper in the ADF
and the device will automatically
pick the papers one by one, and
scan them in proper order.

The Epson MFD doesn’t have
fax, and the Canon PIXMA MP460
has neither fax nor ADF.

Build Quality And Other
Features
The HP Officejet 4355 and
Lexmark X4270 are extremely
compac. They are built ruggedly
overall, but the trays that pro-
trude out of them are a little

HP Photosmart C4188 All-in-One
Performance matches features
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BRAND 
MODEL
* So10 = Score of Ten

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 30)
Performance (Out of 50)
Price Index (Out of 20)
Features
Printing
Printing Technology
Input Paper Tray Capacity
Number of Cartridges
Scanning
Maximum Optical Resolution
Bit Depth
Scanner Type (Flatbed/Sheet-fed/Both)
"Scan to" Option (✔ /✖ )
Automatic Document Feeder (✔ /✖ )
Copying
No. of Copies In Standalone Mode
Fax
Handset Provided (✔ /✖ )
Build Quality
Ruggedness of Flaps (So10)*
Overall Ruggedness (So10)
Menu Ease of Use (So10)
Weight
Dimensions (W x D x H)
Display Interface Type
Memory Card Reader
Network Connectivity
Other Features (if any)
Performance
Printing
Speed Tests
Text Print (Black) Normal / Best
Combi Document Normal / Best
Photo Printout (Best)
Image Quality Tests (So10)
Text Quality / Aliasing (Black, Normal)
Text Quality (Black, High)
Image Quality (Combi-Document, Best)
Colour Saturation / Aliasing
Highlights On Fruit / Shade Gradations
Quality of Photograph
Text Readability
Yellow Text on Black Background
Photo Image Quality
Colour Reproduction / Fine Details
Specular Highlights / Contrast
Reproduction of Textures
Scanning
Black Scan at 200 dpi
Colour Scan at 600 dpi
Copying
Black / Colour Copy Speed
Black / Colour Copy Quality (So10)
Warranty

Scoreboard — Home Inkjet MFDs
Brother

DCP-130C

5,940
+ Rugged build

– Faded colour prints

61.15
16.42
32.91
11.82

Piezoelectric
100 sheets
4

600 x 1200 dpi
48-bit
Flatbed
✔

✖

99

NA

6
6
5
7.1 kg
398 x 360 x 150 mm
Mono LCD
CF, MS, MS Pro, SD, MMC, xD

✖

PictBridge

33.3 / 66.8 sec
38.1 / 81.9 sec
330 sec

6/5
6

6 / 8
5 / 6
6
8
8

5 / 8
6 / 5
7

14.1 sec
51.2 sec

29.2 / 40.5 sec
6 / 6
1 year

Canon
PIXMA MP160

5,999
+ Good performance

– No memory card reader

61.76
10.53
39.53
11.70

Thermal
20 sheets
4

600 x 1200 dpi
48-bit
Flatbed
✖

✖

20

NA

4
4
3
6.3 kg
445 x 381 x 183 mm
7-segment LCD
None
✖

PictBridge

9.3 / 35.7 sec
33.1 C80/ 90.3 sec
235 sec

7 / 8
6

8 / 8
6 / 8
7
8
8

6 / 8
7 / 7
7

17.9 sec
34.3 sec

24.6 / 69.1 sec
8 / 8
1 year

HP Deskjet 
F380 All-in-One

4,999
+ Good print quality

– Slow print speed

53.16
10.39
28.72
14.04

Thermal
100 sheets
2

600 x 2400 dpi
48-bit
Flatbed
✖

✖

9

NA

6
6
NA
4.5 kg
440 x 259 x 170 mm
None
None
✖

None

26.4 / 125.2 sec
67.7 / 144 sec
408.3 sec

3 / 5
5

5 / 8
7 / 7
7
5
8

6 / 6
7 / 7
6

14.1 sec
78 sec

34.3 / 84 sec
7 / 7
1 year
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HP Photosmart 
C3188 All-in-One

5,999
+ Good photo quality

– No PictBridge

61.64
15.11
34.83
11.70

Thermal
100 sheets
2

1200 x 2400 dpi
48-bit
Flatbed
✖

✖

50

NA

6
6
5
5.08 kg
434 x 290 x 162 mm
Icon-based Mono LCD
SD, MMC, SM, MS, MS Pro, xD
✖

RePrint & Proof Sheet buttons

21.1 / 41.2 sec
48.9 / 95.6 sec
426.8 sec

7 / 7
6

6 / 8
7 / 8
7
8
8

6 / 8
8 / 7
7

15.5
73.8

24.8 / 55.4 sec
7 / 7
1 year

Lexmark
X1270

3,900
+ Inexpensive

– Slow photo print speed

53.53
10.64
24.88
18.00

Thermal
100 sheets
2

600 x 1200 dpi
48-bit
Flatbed
✔

✖

1

NA

5
6
NA
4.4 kg
496 x 396 x 244 mm
None
None
✖

None

19.5 / 158.7 sec
123.3 / 320.8 sec
483 sec

6 / 6
5

5 / 6
4 / 4
5
5
8

5 / 4
5 / 6
5

14.1
125.4

26.2 / 243.1 sec
6 / 6
1 year
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BRAND 
MODEL
* So10 = Score of Ten

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 30)
Performance (Out of 55)
Price Index (Out of 15)
Features
Printing
Printing Technology
Input Paper Tray Capacity
Number of Cartridges
Scanning
Maximum Optical Resolution (dpi x dpi)
Bit Depth
Scanner Type (Flatbed/Sheet-fed/Both)
"Scan to" Option (✔ /✖ )
Automatic Document Feeder (✔ /✖ )
Copying
No. of Copies In Standalone Mode
Fax
Handset Provided (✔ /✖ )
Build Quality
Ruggedness of Flaps (So10)*
Overall Ruggedness (So10)
Menu Ease of Use (So10)
Weight
Dimensions (W x D x H)
Display Interface Type
Memory Card Reader
Network Connectivity
Other Features (if any)
Performance
Printing
Speed Tests (Seconds)
Text Print (Black) Normal/Best
Combi Document Normal/Best
Photo Printout (Best)
Image Quality Tests (So10)
Text Quality / Aliasing (Black, Normal)
Text Quality (Black, High)
Image Quality (Combi-Document, Best)
Colour Saturation/Aliasing
Highlights On Fruit/Shade Gradations
Quality of Photograph
Text Readability
Yellow Text on Black Background
Photo Image Quality
Colour Reproduction/Fine Details
Specular Highlights/Contrast
Reproduction of Textures
Scanning
Black Scan at 200 dpi
Colour Scan at 600 dpi
Copying
Black / Colour Copy Speed
Black / Colour Copy Quality (So10)
Warranty

Scoreboard  — Office Inkjet MFDs
Brother

DCP-330C

8,690
+ Fast at scanning

– Slow printing performance

62.19
16.56
35.08
10.56

Piezoelectric
100 sheets
4

600 x 2400 dpi
48-bit
Flatbed
✔

✖

99

NA

6
6
6
7.3 kg
398 x 360 x 150 mm
Swivel Colour LCD
CF, MS, MS Pro, SD, MMC, xD
✖

PictBridge

33.9 / 67.3 sec
36.4 / 81 sec
326.7 sec

6 / 7
7

6 / 8
5 / 6
6
8
8

5 / 8
6 / 5
7

13.4 sec
51.5 sec

29.5 / 41.2 sec
6 / 6
1 year

Brother
MFC-240C

9,900
+ Dual-type scanner

– Slow performance

62.41
17.66
35.48
9.27

Piezoelectric
100 sheets
4

600 x 1200 dpi
48-bit
Both
✔

✔

99

✖

6
7
5
8 kg
398 x 370 x 180 mm
Mono LCD
CF, MS, MS Pro, SD, MMC, xD

✖

PictBridge

33.8 / 63.7 sec
37.3 / 80.6 sec
325.5 sec

6 / 7
7

6 / 8
5 / 6
6
8
8

5 / 8
6 / 5
7

13.8 sec
51.3 sec

29.4 / 40.7 sec
6 / 6
1 year

Canon
PIXMA MP460

9,995
+ Good performance

– No fax, yet expensive

66.32
14.81
42.33
9.18

Thermal
100 sheets
4

1200 x 2400 dpi
48-bit
Flatbed
✔

✖

99

NA

5
5
6
7.1 kg
445 x 419 x 264 mm
Swivel Colour LCD
CF, MD, MS, MS Pro, MMC
✖

PictBridge

9.5 / 31.1 sec
33.1 / 92.8 sec
215.1 sec

7 / 8
7

8 / 8
6 / 8
7
8
8

6 / 8
7 / 7
8

16 sec
70.1 sec

24.1 / 67.6 sec
8 / 8
1 year

Epson
Stylus CX3900

6,799
+ Fast in B/W scanning

– No fax or ADF

57.67
12.88
31.29
13.50

Piezoelectric
100 sheets
4

600 x 1200 dpi
48-bit
Flatbed
✔

✖

99

NA

5
5
NA
5.8 kg
430 x 345 x 172 mm
None
None
✖

None

30.4 / 42.1 sec
93.3 / 133.1 sec
322 sec

5 / 5
5

7 / 8
5 / 6
7
6
8

5 / 6
7 / 4
7

13.5 sec
126.9 sec

36.6 / 103.2 sec
6 / 6
1 year

HP
Officejet 4355 All-in-One

6,999
+ Fax with handset

– Slow at photo printing

60.20
17.77
29.31
13.11

Thermal
100 sheets
2

1200 x 1200 dpi
48-bit
Sheet-fed
✔

✔

200

✔

4
5
5
5.5 kg
417 x 203 x 330 mm
Mono LCD
None
✖

None

20.7 / 129.2 sec
69.3 / 145.2 sec
402.5 sec

5 / 6
5

6 / 8
7 / 7
7
5
8

6 / 6
7 / 7
6

17.3 sec
94.3 sec

36.3 / 87.6 sec
7 / 7
1 year
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flimsy. Unlike the 4355, whose trays can
be folded when not in use, the tray of
the Lexmark has to be dismantled and
stored separately—a bit of a pain. The
Epson is also built fairly well, though its
scanner lid is a little fragile. The
Lexmark comes bundled with a 4-port
USB hub.

The HP Officejet 5610, Photosmart
C4188, and the Brother DCP-330C are all
built very well—good enough to bear the
rigours of office use. However, the HP
5610 has protruding trays that, though
not flimsy, get easily dislodged from the
MFD with the slightest of force. The HP
5610 is a no-frills, rugged office MFD with
a mono LCD, while the C4188 is a photo
MFD with special features such as a mem-
ory card reader, the reprint function, and
a special side input tray to store 4 x 6
photo papers. Both the HP C4188 and the
Brother DCP-330C have a swivel colour
LCD. The C4188 has a Photo Fix function,
which lets you apply effects to images on
memory cards and digicams to improve
print quality.

One feature we like about all the HP
and Brother printers is that their car-
tridges replacement compartments are

conveniently placed
on the front left cor-

ner, so you don’t need
to poke your hands
about inside the bay.
This is a good design

improvement, and we might well see an
increasing number of printers and MFDs
incorporating such a design. 

The Brother MFC-240C and HP 5680
have Mono LCD screens, while the Canon
MP460 has a swivelling colour LCD that
lets you view photos from a memory card
or camera connected to the PictBridge
port, and even resize them. Just like the
HP 5610, the 5680 is a no-frills MFD just
for office use, and therefore does not fea-
ture a memory card reader or PictBridge.

Performance
Printing
The Epson CX3900 is one of the slowest
at black-and-white, normal-quality text

CANON PIXMA MP460
Quick copies, crisp prints

J U L Y  2 0 0 7
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HP

Officejet 5610 All-in-One

8,999
+ Fax with ADF

– Expensive

56.22
15.49
30.53
10.20

Thermal
100 sheets
2

1200 x 2400 dpi
48-bit
Both
✔

✔

100

✖

5
6
5
5.9 kg
435 x 418 x 235 mm
Mono LCD
None
✖

None

17.3 / 129.8 sec
65.4 / 144.6 sec
392.8 sec

7 / 7
6

6 / 4
7 / 7
7
6
8

6 / 6
7 / 7
7

16.5 sec
111.7 sec

31.2 / 68.7 sec
7 / 7
1 year

HP
Officejet 5680 All-in-One

9,999
+ Fax with handset

– Expensive

59.68
19.09
31.42
9.18

Thermal
100 sheets
2

1200 x 2400 dpi
48-bit
Both
✔

✔

100

✔

5
6
5
6 kg
435 x 418 x 235 mm
Mono LCD
None
✖

None

17.1 / 123.8 sec
65.6 / 141.9 sec
390.9 sec

7 / 7
6

6 / 8
7 / 7
7
6
8

6 / 6
7 / 7
7

17.1 sec
182.8 sec

32.8 / 68.5 sec
7 / 7
1 year

HP Photosmart 
C4188 All-in-One

7,999
+ Superb print quality

– No fax or ADF

67.34
15.44
40.43
11.47

Thermal
100 sheets
2

1200 x 2400 dpi
48-bit
Flatbed
✔

✖

50

NA

6
6
7
5.4 kg
434 x 290 x 162 mm
Swivel Colour LCD
SD, MS, MS Pro, SM, MMC, xD

✖

Photo Paper Cassette

16.2 / 38.8 sec
32.9 / 91.7 sec
221.3 sec

7 / 7
6

6 / 8
7 / 8
7
8
8

6 / 8
8 / 7
8

9.3 sec
71 sec

24.7 / 37.3
7 / 7
1 year

Lexmark
X4270

7,500
+ Fax with handset

– Below-par print quality

57.24
16.83
28.17
12.24

Thermal
100
2

600 x 1200 dpi
48-bit
Sheet-fed
✔

✔

30

✔

4
6
5
3.87 kg
546 x 370 x 248 mm
Mono LCD
None
✖

4-Port USB Hub

15.1 / 171.1 sec
130.3 / 354 sec
1130 sec

5 / 5
5

4 / 6
4 / 4
4
5
8

5 / 4
5 / 6
5

9 sec
176.2 sec

15.3 / 150.7 sec
7 / 7
1 year
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prints, but it takes the same
time at the best quality, leaving
the HP 4355 and Lexmark lag-
ging behind. The Lexmark is the
slowest of all the MFDs at photo
printing, taking an agonising 18
minutes! These three, the 
lowest-priced in the lot, display
black text print quality at 
par with each other, while in
the colour print department,
the HP and Epson are better. 
The Lexmark produces prints
that appear sprinkled with 
ink droplets.

Amongst the Brother DCP-
330C and the HP C4188 and 5610,
the HP MFDs are the fastest at
normal-quality text printing, but
the 5610 is the slowest of the
three once you enable colour and
turn up the quality. Text prints
are good with all the MFDs, but
the HP C4188 is the best with our
combi-document and photos.
The Brother MFD does print well,
but the colours appear faded—as
with all MFDs from Brother.

The Canon PIXMA MP460 is
clearly the fastest, and even
manages excellent photo quality
in that time. This one is proba-
bly more suited for a small
photo studio rather than for an
office. It doesn’t disappoint
with text and combi-document
printing, either.

Scanning And Copying
The Lexmark X4270 scans really
fast—taking just 9 seconds for
black-and-white—but is one of
the slowest when it comes to
colour scans. The HP 4355 and
Epson were slower than the

Lexmark in the black-and-
white scans.

The HP C4188 scans fast in
black-and-white, but is a little
slow at colour. Still, it captures
the shades of the colours on the
IT8 card very well. The scanner
on the Brother DCP-330C is also
good, and the HP 5610 falters
while distinguishing between
adjacent shades in the dark and
light colours.

The HP 5680, though looks
similar to the 5610, takes up to
twice the time to scan a full-
colour photo at 600 dpi. The
fastest among the 5680, Canon
PIXMA MP460, and the Brother
DCP-240C is the Brother, taking
just 13.8 seconds for a black-and-
white scan. It also captures the
most detail in the scanner test
among the above three, followed
closely by the MP460. 

The MP460 copies at good
speeds—though not at the
fastest—and the quality of the
copies is so good, it’s difficult to
distinguish between the original
and the copy at first look! The
rest copy with acceptable quality,
and none of them elicit any com-
plaints. The Epson and Lexmark
are the slowest at colour copies,
so they aren’t suitable for mak-
ing copies of your colour presen-
tations if you’re in a hurry.

PROFESSIONAL MFDs
The MFDs in this category sport
special features such as the abil-
ity to print photographs at pro-
fessional quality, networking,
and more. Prices typically start
at around Rs 15,000 and can go

This is not about any particular category of MFD, but about all the MFDs in
general and our experiences with them.
HP has a Dial-a-Cartridge system in many cities. If you run out of ink,

you can dial a toll-free number and order a cartridge, which arrives at your
doorstep.

A general nuance about HP MFDs is the long time they take to install the
software. On our test rig, it took us 15 minutes on average for all the HP
MFDs in the test. Though this is a one-time affair, HP needs to pay some
attention to this—it’s plagued us for a few years now. 

Brother MFDs are good for offices—that’s what they’re meant for—but a
peculiar thing we noticed is a seeming Obsessive Compulsive Disorder: they
waste around two minutes cleaning the cartridge every time they’re
switched on for a photo print. And despite that, the colours are faded—we’re
left wondering what kind of cleaning was done. Another issue we faced with
Brother was that none of their MFDs could pick up the 160 gsm photo paper,
so we had to replace it with the lighter 110 gsm paper to get things moving.

All the MFDs come with software suites that include photo editing as
well as OCR software. These are more than sufficient for general need.

Footnotes

up to Rs 25,000 and beyond.
Naturally, these fall outside 
the realm of SoHos and 
small businesses.

The heavyweights here are
the Brother MFC-440CN, Canon
PIXMA MP600, Epson Stylus
Photo RX650, and the HP
Photosmart C6188 All-in-One.

Features
Printing
Two of the MFDs, the Brother

and the Epson, feature piezo-
electric printing, while the HP

and Canon MFDs are based on
thermal inkjet printing technol-
ogy. The Brother and Canon have

the usual four (Cyan, Magenta,
Yellow, Black) ink cartridges
each, but the HP and Epson have
six (Black, Cyan, Magenta, Light
Magenta, Cyan, Light Cyan,
Yellow). The extra cartridges
should increase the accuracy of
colour reproduction, and our
tests will verify if this is indeed
the case.

Scan, Copy, And Fax
The Brother MFC-440CN is
expensive—probably thanks to
the network feature and the
huge 400-page fax memory,
which lets you receive faxes even
when you run out of paper. It
has a scan resolution of 600 x
1200 dpi, which is the lowest of
the lot. The HP C6188 boasts of a
high scan resolution of 4800 x
4800 dpi, while the Epson scans
at 3200 x 6400 dpi. The fax
MFDs—the HP and the Brother—
feature ADFs and both flatbed
and sheet-fed scanners, while

HP Photosmart C6188 All-in-One
Master of all trades!
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BRAND 
MODEL
* So10 = Score of Ten

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 35)
Performance (Out of 55)
Price Index (Out of 10)
Features
Printing
Printing Technology
Input Paper Tray Capacity
Number of Cartridges
Scanning
Maximum Optical Resolution
Bit Depth
Scanner Type (Flatbed/Sheetfed/Both)
"Scan to" Option (✔ /✖ )
Automatic Document Feeder (✔ /✖ )
Copying
No. of Copies In Standalone Mode
Fax
Handset Provided (✔ /✖ )
Build Quality
Ruggedness of Flaps (So10)*
Overall Ruggedness (So10)
Menu Ease of Use (So10)
Weight
Dimensions (W x D x H)
Display Interface Type
Memory Card Reader

Network Connectivity
Other Features (if any)
Performance
Printing
Speed Tests
Text Print (Black) Normal/Best
Combi Document Normal/Best
Photo Printout (Best)
Image Quality Tests (So10)
Text Quality / Aliasing (Black, Normal)
Text Quality (Black, High)
Image Quality (Combi Document, Best)
Colour Saturation/Aliasing
Highlights On Fruit/Shade Gradations
Quality of Photograph
Text Readability
Yellow Text on Black Background
Photo Image Quality
Colour Reproduction/Fine Details
Specular Highlights/Contrast
Reproduction of Textures
Scanning
Black Scan at 200 dpi
Colour Scan at 600 dpi
Copying
Black / Colour Copy Speed
Black / Colour Copy Quality (So10)
Warranty

Scoreboard — Professional Inkjet MFDs
Brother

MFC-440CN

14,850
+ Network-ready

– Slow

64.55
23.80
31.75
9.00

Piezoelectric
100 sheets
4

600 x 1200 dpi
48-bit
Both
✔

✔

99

✖

6
7
6
8.4 kg
398 x 370 x 180 mm
Swivel Colour LCD
CF, MS, MS Pro, SD, MMC, xD

Ethernet
PictBridge

33.8 / 67.1 sec
37.1 / 82 sec
333.3 sec

6 / 7
7

6 / 8
5 / 6
6
6
8

5 / 8
6 / 5
7

13.7 sec
50.9 sec

33.1 / 39.9 sec
6 / 6
1 year

Canon
PIXMA MP600

17,995
+ Excellent print quality

– No fax or ADF

73.62
21.16
45.04
7.43

Thermal
150 sheets
4

2400 x 4800 dpi
48-bit
Flatbed
✔

✖

99

NA

7
7
8
10.1 kg
450 x 389 x 194 mm
Swivel Colour LCD
CF, MD, MS, MS Pro, MMC

✖

PictBridge, IrDA

7.8 / 33.5 sec
19.7 / 45.2 sec
113 sec

7 / 8
8

8 / 8
7 / 8
7
8
8

8 / 8
8 / 7
8

19.2 sec
53 sec

15.6 / 32.1 sec
8 / 8
1 year

Epson
Stylus Photo RX650

25,799
+ Can manipulate images

– Expensive

58.86
21.13
32.55
5.18

Piezoelectric
80 sheets
6

3200 x 6400 dpi
48-bit
Flatbed
✔

✖

99

NA

7
7
7
9.3 kg
450 x 414 x 210 mm
Swivel Colour LCD
CF, MS, MS Pro, MS Duo, MS
Duo Pro, MD, SD, MMC, xD
✖

PictBridge, IrDA

29.9 / 77.7 sec
33.1 / 83.4 sec
289 sec

5 / 6
6

7 / 8
7 / 7
7
6
8

5 / 6
8 / 6
8

22.4 sec
181.6 sec

36 / 35.9 sec
6 / 6
1 year

HP Photosmart 
C6188 All-in-One

15,999
+ Good performance, Photo Fix

– None in particular

75.50
27.47
39.68
8.35

Thermal
100 sheets
6

4800 x 4800 dpi
48-bit
Both
✔

✔

50

✖

7
8
8
12.99 kg
450 x 385 x 247 mm
Swivel Colour LCD
CF, MD, MS, SD, MMC, xD

Wi-Fi, Ethernet
PictBridge, Photo Tray

26.1 / 36.2 sec
29.5 / 97.3
128.8 sec

7 / 8
7

5 / 8
7 / 8
7
6
8

8 / 8
8 / 7
8

9.1 sec
69.2 sec

17.9 / 29.8 sec
7 / 5
1 year
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the non-fax MFDs—the Epson
and the Canon—have only
flatbed scanners.

Needless to say, all support
multi-copying: the Brother,
Canon, and Epson can do 99
copies each, while the HP stops
at 50.

Build Quality And
Other Features
All the MFDs here are very
ruggedly built. The only chink
in the armour of the Brother
MFC-440CN is its weak input
tray. Brother MFDs have been
the heaviest in the other cate-
gories, but in this category, it is
the lightest (though by no
means light) at 8.4 kg. The HP is
the heaviest at just under 13 kg.
The weight is a pain only during
the initial setup and isn’t a prob-
lem later, since these MFDs are
not likely to be moved around.
Each MFD features a swivelling
colour LCD screen that lets you
preview images and even apply
effects to them.

The control panel on the
Canon MFD is hidden under the
LCD screen, and also has a
unique rotary control wheel
(similar to that on the iPod),
which we found very intuitive.

The HP Photosmart C6118, a
photo MFD, has the reprint func-
tion, which lets you restore and
make copies from an original
photo. The Epson RX650 is the
only one that also supports cre-
ation of photos from negatives.
The HP also has a Photo Fix func-
tion, which can apply effects
like red-eye reduction to
scanned photos, and photos
from memory cards and digi-
cams, before printing.

PictBridge and memory
cards were standard fare,
though the Epson RX650 sup-
ports more memory card stan-
dards. The Canon and Epson fea-
ture IrDA, so you can print
directly from an infrared device
like your camera phone.
Bluetooth would have been bet-
ter, since this is de facto now,

and faster and more popular
than infrared. The HP and
Brother feature Ethernet ports.
HP goes one step further and
supports Wi-Fi (802.11g) that
bestows upon Laptops and PDA
phones the convenience of wire-
less printing.

Performance
Printing
The Canon MP600 seems to have
an insatiable hunger for paper—
sheets went in, and normal-
quality black-and-white prints
popped out in just 7.8 seconds!
The slowest is the Brother. The
others fall in between.

The print quality of all the

MFDs here is exceptional except
for the Epson. This one’s photo
prints are clear and sharp, 
but overall, the prints have a
yellow tinge.

The Canon and the HP are the
best in terms of print quality
across the tests, and should be
every professional photograph-
er’s dream come true.

Scanning And Copying
All the MFDs here are good at
scanning, but the HP Photosmart
C6188 is exceptionally so. It pro-
duces the best scans we’ve seen
in this test, and takes just 9.1 sec-
onds for a black-and-white scan.

The Epson
Stylus Photo
RX650 is the
slowest, tak-
ing over 22
seconds for
the same
job. It also
took over 3
minutes to
complete a

colour scan—quite obviously 
the slowest.

As before, the Canon MP600
is the fastest and best copier—it
reproduces even the finest of
details with great accuracy. 

Which One To Buy?
In the Home category, the
Canon PIXMA MP160, with the
best print, copy, and scan quali-
ty, and fast at that, is the Digit
Best Buy Gold winner. With its
print quality, memory card
reader, and Photo Reprint func-
tion, but no PictBridge, the HP
Photosmart C3188 All-in-One
takes the Digit Best Buy Silver in
that category.

The populous Office cat-
egory was the most compet-
itive. The HP Photosmart
C4188 All-in-One has photo-
printing features like a
photo paper cassette and a
colour LCD and memory
card reader, and also per-
forms well—especially in
photo printing. At Rs 7,999,
this one gets the Digit Best
Buy Gold. With its speed
and excellent print quality,
the Canon PIXMA MP460
takes the Silver, let down
only by its stiffer Rs 9,995
price tag.

It’s ironic that the win-
ners don’t have fax—if

that’s essential, we recommend
the Brother DCP-330C and MFC-
240C. The Lexmark X4270 and
HP 4355 are good if you’re on a
budget, and if your workload 
is moderate; the HP 5610 
and 5680 will handle bigger
workloads better.

Photo printing, Ethernet,
Wi-Fi, memory card reader, fax,
you name it—the HP Photosmart
C6188 All-in-One has it all.
Performance matches features,
here, and at Rs 15,999, it is a
very attractive choice for any-
one setting up a photo studio.
Without a doubt, this is the
Digit Best Buy Gold winner in
the Professional category.

The Canon PIXMA MP600 is
stylish, and specialises in photo
printing. It produces life-like
photo prints—better than those
by any other MFD in this test.
This one manages to deliver
excellent results at the fastest
speeds. With a very intuitive
interface, this MFD gets the
Digit Best Buy Silver in the
Professional category. 

jayesh_limaye@thinkdigit.com

Canon PIXMA MP600
Amazing, life-like photo prints
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PhoneCompany E-mailBrand
Brother

Canon

Epson

HP

Lexmark

Brother International (India) Pvt Ltd

Canon India Pvt Ltd

Epson India Pvt Ltd

Hewlett-Packard India Sales Pvt Ltd

Cyberstar Infocom

40988900

1800-345-33-66

1800-425-00-11 

0124-2566111

9343661888

info@brother.in

info@canon.co.in

sales@eid.epson.co.in

kakuni.mahto@hp.com

sangeeta.nandy@cyberstarindia.com

Contact Sheet—Inkjet MFDs
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Trend

Blogging is a great tool for communication and collaboration. It
can be used by domain experts to communicate with customers
and the world at large, as we do with the Symantec security

Weblog. It can also be used by employees to collaborate as we do with
our internal blog. Then, most employees at Symantec use wikis or
Microsoft SharePoint for collaboration within or across groups. 

Social networking sites help our employees keep in touch with
individuals or groups both inside and outside the company, and to
continue to make new and useful contacts that will ultimately help
them in being more productive.

Web 2.0 technologies are very productive when used appropriately,
but as with any technology, there is always the possibility of misuse.
It would be prudent to be watchful, and we are. There are a number
of policies that govern the exchange of information and the
monitoring thereof.

Still, our employees enjoy considerable flexibility in terms of how
they use their computers, the Internet, and the intranet. Everything
we do at Symantec is ultimately about enabling people to work and
play freely in a connected world.

The goal of providing a blog-space for
employees has been to ensure that
people become part of conversations

occurring around the industry. Sun employees,
through their blog posts, are now
participating in dialogues, be they about
technology or otherwise, in a way that
transcends geography and time.

Sun’s effectiveness at knowing what its
community is saying has been improved
immensely by the blogging process. Blogs
serve as a good tool for internal
communication as well. For the top
management, blogging can be a powerful and
highly credible tool to communicate with
employees. Blogging serves as an effective tool
to attract talent. With companies vying with
each other to attract the best talent, we have
to prove we are a more vibrant, interesting,
and open company. These blogs reflect the
quality of the people and that’s the quality of
the company. Blogs have authenticated the
Sun brand as much as or more than a billion-
dollar ad campaign could have done.

Blogging allows employees to get to know
each other better, to gain a broader
understanding of their co-workers.

Sun has embraced other Web 2.0 means,
like YouTube videos, podcasts, and Second Life,
to get the message across about our solutions.

Santosh D’Souza
Chief Technology Officer
Sun Microsystems, India

Basant Rajan
Chief Technology Officer
Symantec Corporation, India
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From a business perspective, is blogging and social networking of any value—to a company?
Should employees be encouraged to indulge in these “Web 2.0 activities”?

Web 2.0 And
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Bhavin Turakhia
CEO
Directi

Blogging and business social networking are crucial parts of business
today, particularly in the hi-tech industry. It would be wise for
companies to use the movement to their benefit. We want our

employees to be smarter, well-read, articulate, and well-connected. Web
2.0 helps this cause.

There would certainly be part of employees’ time going into non-
productive purposes. However, when companies encourage blogging and
tell them what areas would help business and the branding cause, at
least a reasonable part of the time spent could be productive. 

Social networking including professional networking can open up the
minds of employees. Traditional channels like conferences and seminars
provided opportunities for people to connect with related people. Online
communities, technology forums, and special-interest groups all form
various social networking opportunities. The value of such social
networking is manifold—the most important for us is branding.

Small and medium companies should see blogging and social
networking as an equaliser, because on the Web, no-one knows the size
of your office. Bigger companies can also benefit, but they probably have
the need for regulatory mechanisms.

Jay Pullur
Founder and CEO
Pramati Technologies

We as a company are firm believers in the individual’s power of
expression. It’s liberating to be able to speak your mind and have
others comment on it. Personal trust and responsibility are

integral parts of our culture and blogging has helped us spread that.
The policy of allowing blogging by employees has re-enforced our

culture of personal trust and responsibility. Hence, at a macro level, it
has helped.

We do not have a formal monitoring mechanism for employee blogs.
We may have the need in the future as it gets bigger in scale. 

Regarding access to social networking sites for professional
purposes, we are working on creating a business community partnering
with a popular social networking provider. We think this will act as a
social glue and help people relate to each other more as people. 

We are big believers in the power of collaboration and how the new,
new Web makes it possible. It ties in very well to breed innovation, which
is our fundamental need.

Rajul Garg 
Vice president
Corporate and People
Development,
GlobalLogic

As told to Prakash Ballakoor (prakash_ballakoor@thinkdigit.com)

At Directi, blogging has enhanced the communication give and take
among various audience verticals. Employee blogging manages to
reach out to a larger credible audience, and allows employees to

express themselves in the most creative of ways.
A blog by a company employee gives an inside view of the company

and would hence positively affect the company’s brand image. At Directi,
we have employees who write blogs for creative expression, and others
who try to address technical and soft issues they face in their work
domain. This transforms a nameless and faceless organisation into one
with a personal and very live face.

Negative comments about companies on blogs should be accepted in
the right spirit and an attempt must be made to mutually understand
issues and correct them.

Social / Business networking, too, most definitely works for us. It
helps in popularising products and services to the right target audience.
Moreover, social networking gives a much-needed personal side to
business deals and also opens up thousands of prospective sales leads.
Companies must encourage employee social networking.

Businesses
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Asfaq Tapia

In most organisations, training is usually
one-sided: you have a trainer teaching a skill-
set the company deems important, while

most participants happily dream of quitting
time and martinis. Fortunately, there is a quiet
revolution taking place. Companies are
exploring innovative ways to make training
interesting, which means value for the money
they spend on training.

Avatar Training
Traditionally, we have always had human train-
ers teaching a class. These days, however,
avatars are assuming the role of imaginary
coaches, co-workers, or customers in computer-
based training modules designed to teach spe-
cific skills.

An avatar is a computer-generated simula-
tion of humans that may be photo-realistic, or a
cartoon character with head-and-shoulder
views that come and go as the computer-based
training module runs its course.

The Advantages
Avatar-based training can pool in all the
resources and experience of human trainers
and deliver an identical training session every
time, thereby ensuring the optimal training
experience in every session—something even
the most experienced trainers are not capable
of achieving. Another advantage of avatar-
based training is that the training module
can be run at the convenience of the trainee’s
time, and can be viewed over and over for
reinforcement. The training can also be used
in large organisations, where employees are
scattered across continents.

Accenture is developing various avatar-
based training modules, and recently
deployed one at British Telecom, the UK’s
largest telecommunications provider. The
programme helped train 4,500 sales-
people in just four weeks, as opposed to
the eight weeks a traditional training pro-
gram would have taken. Then, a training
module developed for NASA allows the
trainee to observe living and working
conditions in the polar regions of Mars,
with an avatar explaining various
details of the conditions on-screen.

Avatars can be made to identify
with the trainees, in terms of ethnicity
and age—so soldiers can be trained by
a military avatar, and a younger audi-

ence can have a teenage avatar. With powerful
off-the-shelf graphics technology available, mil-
itary and space exploration training avatars
move and look a lot more realistic than ever
before. However, animating an entire training
module could cost anywhere between Rs 50,000
and lakhs of rupees right now. With an increased
demand for these services, however, costs should
fall rapidly.
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Tired of seeing your trainees dozing off at training sessions? Maybe you’re going about it the
wrong way. Here’s presenting some radical new ways to impart training

Smart Training

Avatar-based training is touted to be the future



110 DIGIT JULY 2007

Digital Business l Smart Business

110DIGIT JULY 2007

Simulated Training
Most of us have played or heard of The Sims, a
computer game that allows a gamer to create vir-
tual characters that interact amongst themselves
to reach a common goal. As if giving credence to
its fun factor and its popularity (it remains the
largest-selling PC game of all time), companies
are gradually looking at simulated approaches
to creating training modules, wherein partici-
pants enter a virtual world to learn skill-sets
with a replica of themselves interacting with
other participants to perform a certain task or
objective.

A recent IBM study found that 56 per cent of
customers lacked the skills to combining IT tech-
nical understanding with business process
acumen. (IBM refers to this as “T”-skills). Based
on this data, they have designed a 3D educa-
tional game simulator, called Innov8, which
bridges the gap between IT engineers and busi-
ness leaders in an organisation. 

Innov8
The Innov8 simulation gives the participant the
feeling of playing a game, but also teaches events
or processes such as business operations. It has
proved to be a very successful method of
retraining or developing new skill sets. The game
is played with a joystick controller and allows
participants to visualise how an end-product will
function in the customer’s organisation. While
playing the game, participants can literally see
how the business processes will function, iden-
tify bottlenecks, and explore alternative sce-
narios before the Service Oriented Architecture
(SOA) is deployed.

Naveen Gupta, VP, technical sales and sup-
port, Software Group, IBM India, says, “Innov8 is
a reflection of the way people learn today—it’s
got to be interactive, visual and fun.  At the end
of the game, players are assessed with a score on
how well they did, so it’s competitive as well.”

Innov8 is a prototype right now—IBM expects
the final version to be completed by September
2007. IBM plans, when it is ready, to deploy the
platform over a wide array of industry sectors. It
predicts that Innov8 could be used to train
middle- or top-level management on Business
Process Management and SOA concepts. It can
also be used in Higher Education to assist stu-
dents develop T-shaped skills, thereby making
them better managers.

Since it is a game, Innov8 is extremely inter-
active. Players must achieve certain tasks before
they can get to the next level. Completing each
task gives them a better understanding of busi-
ness processes. In the future, IBM plans to make
online versions for gaming environments such
as Second Life, where trainees can participate
simultaneously in one session from all across the
world. IBM plans to release Innov8 as a free
download, so anyone can start playing.

Networking Magic
Another method large organisations are
employing is to network their teams working in
various parts of the world for better communi-
cation during product development. As a result
of this networking, skill-sets across various
teams and geographic locations can be honed
and shared by all teams across the board. 

Jazz (www.jazz.net), a joint project between
IBM Rational and IBM Research, is designed to
build an “open-commercial community” plat-
form that is scalable and extensible based on
project requirements, and helps programmers
seamlessly integrate tasks across the software
lifecycle. In simple words, Jazz allows program-
mers to build software more effectively while
making the entire process of developing soft-
ware more fun! 

How Jazz Works
Most code written for a project is tagged with
an author’s name using Jazz. It’s easy to iden-
tify which programmer needs assistance: all
code can be viewed in real-time by all the teams
involved in the project. Once the author is
identified, he can be put through a training
module to improve the skill-sets he lacks. The
training thus happens in real-time. Jazz also
integrates messaging protocols into the plat-
form, thereby enabling easy communication
between teams.

Since Jazz is in its early stages right now,
access to it is only open to employees of IBM
Rational’s customers and partners, and a few
select others by invitation. The final release
date for the platform is yet to be announced.

In the future, IBM plans to use Jazz inter-
nally to regulate its own software development
lifecycle. It also plans to take a community
approach to building various plugins and
enhancements for Jazz, so as to make it uni-
versally usable, and not just restricted to cus-
tomers in the IT sector.

Companies are
gradually looking
at simulated
approaches to
creating training
modules

A scene from the very popular The Sims 2

Visual role-playing in training helps build skill-sets faster
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Online Virtual Simulations
The popularity of online virtual worlds like
Second Life (www.secondlife.com) has opened up an
unforeseen avenue for training. Increasingly, a
large number of corporate businesses are har-
nessing this avenue to open shop online.

Second Life is a virtual world—a 3D space on
the Internet totally created and evolved by its
users. The inbuilt content creation tools let you
make almost anything you can imagine, in
real-time or in collaboration with others.
Second Life uses Linden dollars, a form of cur-
rency, which can be bought with real-world
money. The ability to design and resell 3D con-
tent, be it virtual land plots or digital art, etc.,
means you can build a real business entirely
within Second Life.

Training?
Companies have already started harnessing
Second Life to advertise their products and show-
case their content on their individual islands
there, but what could be done in the future is
use Second Life as a training medium to impart
skill-sets to a wide audience from varied geo-
graphic locations. Alternatively, companies
could start using Second Life as a testing ground
for employees—monitoring their selling or run-
ning of the business to see how they perform in
the virtual world, before giving them a promo-
tion that would see them doing the same in the
real world.

Using Second Life as a lower-cost testing
ground could see venture capitalists trying out
new business ideas online instead of risking
large sums of real money. Perhaps we’re not too

far away from the day when senior management
interviews would consist of a three-month tryout
period in Second Life.

Feasibility 
As of today, there are only a few pioneering
companies leasing out their virtual land to
conduct goal-specific training for corporate
trainees. Not many companies in India are
delving into the virtual world for a variety of
reasons. Paramount among them is the pro-
hibitive costs of high-speed Internet access,
which is required when playing any online vir-
tual simulation game. Currently, avatar
training holds the most promise, but with
time and “free” or cheaper broadband, who
knows... Perhaps the time is ripe for the pio-
neers amongst you to invest in a “Second Life
Employee Training Corporation.” 

asfaq_tapia@thinkdigit.com
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Companies could
start using
Second Life as a
testing ground
for employees—
monitoring their
selling or running
of the business to
see how they
perform

A scene from Second Life



Technology Beyond Work
Leisure
Digital

When you’ve conquered Olym-
pus and become a God—
complete with castle in the

skies—what else is left? Why, taking
over the Heavens, of course. God of
War 2 (GOW2) continues the story of
Kratos, the hard-nosed Spartan who,
the last time we saw him, had worked
his way up and defeated Ares to
become the new God of War. Unfortu-
nately, Zeus doesn’t appreciate
Kratos’ designs on his throne, and
betrays him into becoming a mortal
again. Kratos must now seek the
Sisters of Fate, and exact his
vengeance upon Zeus. It’s no modern
classic, but GOW2’s story is still one
of the most entertaining we’ve seen—
hate, vengeance, divine politics and
blood. Lots of blood.

I am, I must admit, one of those
Unfortunate Souls who haven’t expe-
rienced the original God of War. That
said, the sequel makes no assump-
tions—you’re still trained to learn
Kratos’ various moves and abilities,
and right at the beginning of the
game, you get to use all of his godly
powers—only to have them stolen
from you by Zeus, of course. You also
don’t need to know too much of the
story—just the bit that you read in the
first paragraph. 

Where other action / adventure
games are content with starting
small, GOW2 throws you into the
action right away, and you get to face
off with the first boss—the Colossus
of Rhodes—rather quickly. The action
varies between intense and insanely
frenzied, and is gloriously gory and
brutal. You’ll also have to work
through a few puzzles, but they aren’t
too tough and don’t get on your
nerves the way they do in so many
such titles. 

It’s not just the action that’s
amazing—what takes you in with
GOW2 is how big everything is. The
environments are expansive, ranging
from the insides of huge statues to
having to command a fleet of horses
the size of Everest. Most of the bosses
are insanely huge—as are the battles
with them—and the satisfaction of
watching something 3894529345234
times your size crumble at your feet
can’t be described in words.

God of War 2 takes the first ever
10/10 I’ve dished out—it’s hard to find
a flaw with this game! While many in
the genre are competent, this was the
only one that didn’t keep me running
around aimlessly for ten minutes
trying to figure out what to do next.
The graphics and soundtrack are bril-
liant and load astonishingly fast on
the PS2—even saving a game isn’t the
torturous experience it’s become in
other PS2 titles. The action is more
fun than you could imagine, and even
the fixed camera angle doesn’t get in
the way of enjoyment. PS2 owners,
take note—if you don’t play this game,
you’ll be missing the best thing to
happen to the PS2. Ever. 

nimish_chandiramani@
thinkdigit.com
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Rating: 10/10
Platform: PS2
Developer: SCE Santa Monica 
Publisher: Sony Computer Entertainment
Distributor: Milestone Interactive
Contact: sales@milestoneinteractive.com
Price: Rs 1499/-
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W hile every other
title that comes out
these days throws

around the term “genre
redefining” quite loosely on
their boxes, Chris Taylor’s
Total Annihilation literally
created the 3D Real-time
Strategy (RTS) genre long
before Blizzard and Star-
Craft came along to steal
their thunder. Ten years and
a handful of RPGs later,
Chris Taylor returns to the
genre with Supreme Com-
mander, a game that is, like
its predecessor, years ahead
of its time.

Set in the distant future,
with three opposing factions,
as usual, warring for control,
Supreme Commander takes a
radical yet fun turn by letting
the three single-player cam-
paigns stand alone, instead
of using them to tell a single
connected story, as in Star-
Craft or Command & Conquer
3: Tiberium Wars. But what
really sets the game apart is
its sheer scale, and a unique
ability to use multiple moni-
tors to manage your war-

mongering. However, you are
forced to constantly manage
every little detail on the bat-
tlefield—juggling mass and
energy resources, getting
hapless engineers out of
harm’s way, and repelling the
huge armada that decided to
wreak havoc on your sea
units. Supreme Commander
is one game where you can-
not expect your missions
to start and end in a five-
minute Blitzkrieg, à la Tiberi-
um Wars.

For such a complex
game, Supreme Commander
manages to provide excellent
controls that allow you to
queue up multiple tasks for
units, direct them along com-
plex routes to their destina-
tions and set up complicated
attack manoeuvres, all with a
few mouse clicks and the
omnipotent Shift key. Unfor-
tunately for you, however,
the enemy AI can and does
the same and more often
than not, you will suddenly
find yourself being attacked
on every front by hundreds of
artillery units that soften

your base up for the rampag-
ing Experimental Unit to
come and finish you off. 

The sheer scale of the
game, however, does take its
toll on system performance,
and playing the game at the
highest settings can bring
frame rates down to a
pathetic crawl if you zoom
into the battlefield in the
middle of a serious firefight.
This is the only RTS that has
managed to bring an Intel
Core 2 Duo / 8800 GTS sys-
tem to its knees at the high-
est settings, and most play-
ers would have to tone down
the quality and split the
screen in half in order to play
properly. But if you are one of
those with pockets deep
enough to afford two
widescreen monitors and a
high-end Core 2 Duo / DX10
SLI powerhouse, there’s no
better strategy game than
this one. For the financially
and tactically challenged,
however, there’s always
Tiberium Wars.

Krishnan Rajagopal
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Rating: 9/10
Developer:

Gas Powered Games
Publisher: THQ

Distributor:
E-Xpress Interactive

E-mail:
sales@e-xpressindia.com

Price: Rs 699/-

XFX GeForce 8800GTX,
Intel Core 2 Duo E6600,
4 GB RAM, Windows
Vista Ultimate x64, WD
250 GB (x2) - RAID 0

DIGIT’S GAMING PC



Racing simulations? I’m
game! But what’s this…
Test Drive Unlimited

(TDU)? Nooo!!! Yet another
arcade racer where you go
around racing cars like a
madman with a hundred
gazillion decals supposedly
for street cred? Not quite so
with TDU. Stick around for a
bit and we’ll see if this high-
ly-anticipated racer is any
different.

To be honest, you’ll nor-
mally find me playing simu-
lations like Live For Speed,
GTR2, Richard Burns Rally,
rFactor, and such. I’ve
played pretty much every
Need for Speed, but haven’t
been very impressed with
the releases post the
Porsche Unleashed / Hot
Pursuit 2 era. 

TDU is really quick to get
going with. There aren’t any
formalities to complete.
Select a character, get a
base to run store your price-
less rides a.k.a. a home.
Then buy yourself a car that
fits your tight budget and
you’re off. 

The game is based in
Hawaii, on an island that
seems to have no bound-
aries. There’s a good mix of
landscapes—you get to drive
through little residential
areas, towering buildings
and long highways passing

through densely-vegetated
areas. You come across race
events while roaming
around, and you can always
use the map view to jump to
those locations.

The cars feel a little
sluggish and refuse to turn
in easily. The acceleration
and braking isn’t over-exag-
gerated. Unlike the newer
NFS titles, TDU actually has
a proper cockpit view, which
gives it a bit of an authentic
feel. You even get to ride
two-wheelers—but unlike in
real life, the bikes here have
a complementary “reverse
gear,” and it works! 

The typical gameplay in
most racing games can still
be found—lap-style races,
sprint races, against the
clock, etc. No drifting and
drag racing though. The AI is
fairly easy to beat. There are
cop chases as well. The cops
don’t seem to mind you driv-
ing at three times the
allowed speed limit, though,
but crash into other
motorists and you’ve had it. 

It appears bits and
pieces of Crazy Taxi have
made their way into TDU as
well. Random top models
are to be given rides to their
destination. Drive ruthlessly
or reach your destination
late and you’re going to get
a brief sounding from them. 

The game does look—it
could well be one of the
best-looking racers for the
PC today. The only other PC
racer that looks better
would be Colin McRae Rally:
Dirt. The models are well-
detailed, and the textures
are pretty decent consider-
ing the size of the environ-
ments. There’s no excess
radial blur and flashy effects
you find in NFS, although
you can pump up the blur a
bit from the settings.

Performance isn’t too
great. At 1280 x 1024 with
maxed-out details and 4x
FSAA on a GeForce 7900GTX
matched with a Core 2 Duo
X6800, I got around 35—40
fps. The detailed models and
textures may be good, but
the game doesn’t feel very
refined—there arequite a
few graphics glitches.

The car sounds
are decent, and the
horns honk like the
ones you would find
in cars from the
’60s. You also get a
radio with multiple
stations to give you
company when
you’re cruising down
long highways.

Test Drive
Unlimited is, ulti-
mately, a fun game.
It’s one of those

games you can jump into for
half an hour and then go
back to whatever you were
doing. The recent Need For
Speed releases are focused
on style, customising your
rides, and fancy presenta-
tion. The new Pro Street
announcement seems to
suggest they’ll still follow
that path. In Test Drive
Unlimited, it’s just plain no-
nonsense racing, the way it’s
meant to be. It can’t be
called a hardcore arcade
racer, but it’s no simulation
either by any means. It’s
somewhere in between,
inclining towards the arcade
bit. Now if you’ll excuse me
I’m in a hurry: there’s a pas-
senger in my McLaren F1
waiting to be dropped some-
place…

rossi_fernandes@
thinkdigit.com

Rating: 7/10
Developer: Eden Games

Publisher: ATARI
Distributor: Milestone
Interface Software Ltd

e-mail: sales@
milestoneinteractive.com

Price: Rs 999/-
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Digital Leisure l Virtual weapons in real life

Second Skin
Homo sapiens isn’t the swiftest crea-
ture on Earth. Most of us are limited by
how much weight we can lug around. 

In games such as S.T.A.L.K.E.R. and Half-Life 2,
the powered exoskeleton is an external skin-like
framework attached to a solider. It incorporates a
unit that supplies energy for physical movement
and other functions that the exoskeleton per-
forms. In the Metroid series of video games,
released in stone-age 1986, Samus Aran, the lead
character, wears an exoskeleton enhanced with a
cannon attached to the arm. The suit gives the
player special abilities like rolling into a ball or
performing very high spinning jumps. And yes, it
also allows the player to stay underwater or in
the vacuum of space almost indefinitely!

With this thing around, joining the armed
forces would be so much cooler…

And now, the United States Defense
Advanced Research Projects Agency
(DARPA) is investing $50 million to
develop an exoskeletal suit for
ground troops. Imagine turning
ordinary soldiers into super-troops
who can leap tall objects in a sin-
gle bound and run at high speeds
(unsaid reference to Superman
purely coincidental). The details
of this program are “blacked
out” and classified, and informa-
tion about these wearable machines
is hard to come by. However, DARPA has
set some expectations for these exoskele-
tal machines. Here’s what they are expect-
ed to do for soldiers:

Increased strength: This one is a no-
brainer… We’re excited about the
prospect of soldiers being able to remove
large obstacles from their paths without
using heavy machinery. In the future,

the exoskeletons will include heavier body
armour and protection from ballistic explosions
from grenades and rocket launchers too.
Coincidentally, in the 1960s, GE in collaboration
with the US military jointly developed an
exoskeleton named “Hardiman,” which made
lifting 300 pounds feel like lifting 15 pounds! 

Increased speed: Akin to making our bots
run around like rabbits on an unknown map, sol-
diers are often expected to carry up to 150
pounds of supplies in their backpacks over long
distances. Even the most hardened of troops can’t
get very far carrying that much on their backs…
It’s not yet clear as to how fast DARPA’s exoskele-
ton will be able traverse over different terrain,
but an independently-developed body amplifier,
christened the “SpringWalker,” has been tested to
move over terrain at speeds faster than 16 kmph
(the average walking speed is 3.5kmph)! 

Leap great heights and distances: Imagine a
marching legion of troops wearing these
exoskeletons, jumping over a wide crevice in a

mountain. and moving forward relentlessly!
It’s yet unclear as to just how far or high

soldiers will be able to jump, but offi-
cials would like the exoskeleton to give
soldiers these Superman-like abilities. 

Communications integration: The
exoskeletal machines will also feature
sensors and GPS receivers. In the
future, every soldier on the battlefield
will have mission-centric information
like the terrain they are crossing and
how to navigate their way to specific
locations in the war zone right inside
their helmets. DARPA is also
rumoured to be developing fabrics
that could be used with the exoskele-
tons to monitor heart and breathing
rates so any health-related issues can

be detected on time. Of course,
instant medkits haven’t
been developed yet... 

A Command & Conquer
soldier in full armour

Just one example of what the
future solider might look like

Video games
have always had
over-the-top
weapons. Is there
anything similar
in the real world?

Asfaq Tapia

I
f you’re reading this magazine, you’ve prob-
ably played video games at least once in your
life, be it on those old Sega controllers or on
today’s mean consoles. Over the years, games

have evolved from the simple but highly addictive
Dave to Contra and on to today’s near-realistic-
physics-and-animation games and massively

multi-player online (MMO) games like Gears Of
War. As these games have developed, so have the
weapons: from the simple “gun” in Dave, we’ve
evolved to the “Big F***ing Gun” in the Quake
series, and the “Gravity Gun” in Half-Life 2. We
thought we’d dig into classified data to see if any
real-world weapons in development today are
similar to those in video games. Could these have
been… inspired by the games? In any case, without
further ado, our expert findings:
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Run And Gun
If you’ve played games like Halo 2, Command &
Conquer: Generals, or Ghost Recon, you’ve doubtless
marvelled at the aircraft in the battle scenes.
These planes are supposed to be flying at speeds
of over Mach 10!

“Force Application and Launch from
CONtinental United States” (a.k.a. the Falcon
Program) is a research and joint development
program of DARPA and the United States Air
Force for a high-speed strike vehicle capable of
attacking anywhere on the planet in less than two
hours! Operating at Mach 11 and a cruise alti-
tude of 90,000 ft, this mean machine is going to
be a reusable two-stage system comprising an
unmanned boost vehicle used to take off at high
speeds, and a manned hypersonic aircraft used
in the second stage for the strike.

The unmanned
boost vehicle has a gas-
fuelled turbine engine.
It requires a conven-
tional runway and
accelerates the strike
vehicle, which is
attached to the boost
vehicle, to Mach 4 and
60,000 ft. Once this
altitude and speed is
reached, the manned
strike vehicle then

Instant Gratification
This weapon was made famous in the Quake
genre, which allowed players a one-shot-kill on
opponents at the speed of light… now who
wouldn’t want this baby? 

The concept behind the Rail Gun in Quake III
Arena, in case you’re still wondering, is about fir-
ing a bullet that travels at the speed of light to
zap your opponents instantly.

We can already hear cries of “Crap!” from the
physics majors, but get this: a weapon like this is
being worked on. DARPA has been researching

this for 10 years, and work continues. They are
working on projectiles that do not contain
explosives, but have extremely high
kinetic speeds, which would, in
theory, make their kinetic energy
superior to the energy output
of a shell filled with explosives
of greater mass. This would
then enable solders to carry
more ammunition and also make
the carrying of weapons on tank or fighter craft
or boat safer. By firing their shells at far greater
velocities, DARPA’s “Rail Gun” will have greater
range—and will not be affected by wind drift.
Read: bypassing the physical limitations of con-
ventional firearms.

Then get this: there is a working prototype at
the University of Texas at Austin’s Institute for
Advanced Technology, capable of delivering
tungsten-armour-piercing bullets with kinetic
energies of nine million joules—that’s like ram-
ming a one-ton truck into a wall at 80 kmph! The
only problem is that since the shells are fired at
an extremely high velocity, the rail of the gun
suffers from extreme damage, and has to be serv-
iced after every shot.

Nevertheless, we can’t wait to see this one
in action!

detaches itself from the primary boost vehicle
and uses a scramjet-technology-based engine to
reach its final cruise condition of Mach 11 at
90,000 ft. Schumacher just developed a com-
plex… and with good reason!

The total range of the system is a purported
10,000 nautical miles. The hypersonic strike
vehicle has an un-refuelled range of 5,000 nau-
tical miles, which very impressive—Mumbai to
Singapore in less than half an hour! The hyper-
sonic attack aircraft has the capability of engag-
ing a target very accurately, using precision-

guided missiles from a distance of 1,450 nautical
miles away.

Expect to see it developed by end of 2007, and
a demonsration by 2009.An artist’s impression of the Hypersonic Attack Aircraft

DARPA’s impression of the Hypersonic Attack Aircraft—
looks cooler, we say!

...and the University of Texas, Austin’s answer

Quake 4’s Rail Gun...

Digital Leisure l Lead Feature
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Can’t Touch This
Would you like to go into battle without any
armour? No? Surprising—we feel the same way!
However, the force-field type protection systems
are going to do just that in the near future.

The force-field / force-shield concept has been
floating around in academia for ages. It has been
showcased in the Star Trek series, and more
recently, Halo 3 featured this protective system
wherein a solider could shield himself / herself
(who says girls can’t be soldiers?) from attack by
forming a protective “bubble shield,” as they call
it, around them.

Taking a cue from this, the RAFAEL
Armament Development Authority of Israel,
together with Israel Aircraft Industries’ Elta
Group, have developed the TROPHY Active
Protection System (APS)—essentially a shield sys-
tem for the armoured vehicles that protects

against incoming attacks. TROPHY intercepts and
destroys incoming missiles and rockets with a
blast similar to a shotgun-like explosion just
before they hit the asset. Specifics of the materi-
als and mechanics used in this explosive inter-
ceptor device are not available, but TROPHY is
designed to form a “beam” of fragments that will
intercept any incoming missile threat that gives
off a lot of heat, like rockets, at a range of 15 to 35
metres from the targeted platform.

Since this system was designed to work in an
urban environment, the direction, for-
mation, and energy of the fragments
used are made to ensure low collateral
damage, and the lowest possible risk to
nearby troops. The TROPHY system can
simultaneously engage in multiple
threats arriving from different direc-
tions, and is effective on stationary or
moving platforms. The development
program of TROPHY proposes an updat-
ed countermeasure unit to be available
in the future, to protect against threat
perceptions that only rely on kinetic
energy to inflict damage against a tra-
ditional heat-based propulsion system.

As of April 2007, the TROPHY-APS
has been deployed on tanks such as
the Israeli Merkava Mk4. The develop-
ers claim that a system like TROPHY
would reduce or eliminate the need
for heavy armoured protection for
combat vehicles.

Laser Tag!
Right since the days of the first video games,
directed energy weapons have captivated our
imagination like no other form of weaponry
out there. What fun would a game be if you had
to shoot planet-destroying aliens with a .32
Beretta?

Almost all first-person and third-person sci-
fi games use directed energy weapons like
lasers as standard fare. There are pro-gamers in
games like the Quake series (OK, this is our last
mention of Quake!), the Halo series, Gears of War,
and Command & Conquer who specialise in the
use of these weapons. In these games, a direct-
ed-energy weapon
zaps energy in a par-
ticular direction
instead of like a pro-
jectile, for the desired
blood and gore effect.

The story so far in
real life, however, is
different. Almost two
decades since its
inception in video
games, these “lasers”
have remained in the
realm of the Star Wars

movie category. The
only worldwide pro-
gram that comes close
is the Tactical High
Energy Laser (THEL),
which was designed
and built by the Israeli
government and is now
being funded by the US
Army Space & Missile
Defense Command. The
THEL is a high-energy
laser weapons system
that uses a heady mix of
laser beam generation
technologies and beam-

focusing technologies to merge with existing
radar sensors and communication networks to
provide a new defence theatre to ground-level,
immobile assets. It can fire up to 60 shots with-
out reloading, and if it meets design specifica-
tion goals, the probability of kill of an absolute
100 per cent at a range of 4 km is guaranteed!

There is also talk of a mobile version of the
THEL, conveniently baptised the M-THEL: the
Mobile Tactical High Energy Laser, obviously,
which can be mounted on a artillery vehicle
and moved to forward posts if required.Some wonderful moments with laser guns in Halo

The Bubble Shield in action in Halo 3 The TROPHY-APS System
incorporated into a battle tank

Some wonderful moments with laser guns in Israel

Digital Leisure l Lead Feature
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Mecha-medic!
Playing games like Command & Conquer and Age of
Empires would never have been possible without
those mobile repair stations at the battlefield.

What fun is it if you have to wait a few hours till
you re-spawn your armies for your next con-
quest? We hate trainers and cheat-codes…

As if taking a cue from the games them-
selves, scientists at the United States Air Force
are building a mobile facility that could be
located just near the battlefront—where sol-
diers can be patched up, or parts repaired or
manufactured in real-time. Medkits, anyone?

The system has been christened Mobile
Asset Repair System (MARS). This facility can be
based on land—or in the middle of an ocean.
The facility will include a set of Flexible
Manufacturing Systems (FMS) and robotic arms
that can be linked electronically to commercial
suppliers of specific military equipment. A
wide array of parts can thus be manufactured.
The manufacturers feed in the specifications of
the required part—remotely—to the FMS, which
then produces it. The manufacturing materials
necessary for MARS to operate are proposed to
be obtained from the countries in which the
system will eventually be deployed.

An artist’s impression of the Mobile Asset Repair Systems of
the future

Plasma Rifle
A constant source of enjoyment in any game—
from the BFG10k gun in Doom II to those used
in Unreal Tournament, and Quake (sorry, we
couldn’t resist!), plasma rifles are the absolute
future in weapons inventory, and are normal-
ly accompanied by bulky-looking guns spew-
ing out obscene amounts of green or blue
pulses of energy in a game.

Plasma-based weaponry is theoretically
any group of weapons designed to use highly
charged, energy-rich ionised gas or “plasma”.
The idea behind the plasma rifle is that the
energy is aimed not directly at the target but
a little ahead of it. Since the beams would
travel at the speed of light, they would, in the-
ory, be able to intercept any target flying at
sub-sonic or even hyper-sonic speed. A cloud
of highly-charged ionised air forms at the tar-
get focus area. When it enters the cloud, any
object—such as a missile or airplane—is
deflected from its current course and breaks

down due to the large
air pressure differ-
ences between the
outside atmosphere
and the interior of
the f lying body. So
much for the Star Trek
nay-sayers!

In real life, howev-
er, the plasma gun has
only come as close as
the Shiva Star, an
ongoing project for a
high-powered plasma
beam, with plans of it

being used as a tactical
weapon in the Strategic
Defence Initiative used

to protect the USA from nuclear ballistic mis-
siles. It has been in research since the early
1990s at Kirtland Air Force Base in the US. The
Shiva Star is a system that can presumably be
mounted on a satellite or spacecraft in order to
shoot down incoming missiles with projectiles
of plasma travelling at very high velocities,
thereby damaging the missile’s guidance sen-
sors. Work on this has languished, though:
costs are running high.

With all these technologies in place, we
can imagine an army recruiter in the future
asking what games you’ve played. But then
again, who needs humans if researchers take a
cue from the Worms series and clone the ulti-
mate Ninja Sheep, capable of throwing explo-
sive Ninja stars across vast distances! Nukes
suddenly seem so passé… 

asfaq_tapia@thinkdigit.com
The Plasma Gun in all its glory!

An artist’s impression of the Shiva Star System

Digital Leisure l Lead Feature
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FirstEscape

The shrinks at The
American Medical
Association are

moving to officially
recognise “Internet/video
gaming addiction” as a
disorder. What this means
is that lawyers will, in the
future, attempt to blame
“gory video games” for
crimes ranging from eve-
teasing to mass murder,
and use the medically-
recognised disorder to
bolster their defences. The
pharmaceutical companies
must be smacking their
lips right now, what with a
new product line and
another set of different
coloured pills to pump into
unsuspecting bodies. 

When it comes to
complaints, the online
multiplayer game EverQuest
tops the charts, with
relatives of gamers
complaining that playing
that game is far too
addictive to be safe among
teenagers. Some people are

even referring to it as
“EverCrack”... Disgruntled
spouses of EverQuest players
have actually set up a
group to voice their
concerns and share their
experiences! The
description of their group
says, “EverQuest Widows is
a forum for partners,
family, and friends of
people who play EverQuest
compulsively. We turn to
each other because it’s no
fun talking to the back of
someone’s head while
they’re retrieving their
corpse or ‘telling’ with
their guild-mates as you
speak.” In paranoid
America, there have been
centres set up to “treat”
gamers with video game
addiction. Sites like On-Line
Gamers Anonymous
(www.olganonboard.org) are
solely dedicated to
providing help to gamers
who cannot prioritise their
daily responsibilities vis-à-
vis their game playing

needs.
However, Sony Online

Entertainment, the
company behind EverQuest,
denies any wrongdoing,
stating: “I guess our
standpoint is the same as
all kinds of products--you
have to be responsible in
using it. You don’t see
disclaimers when you get
in a car saying ‘Don’t run
over people.’ People have to
exhibit their own good
sense, and if they have
kids, they need to pay
attention to what they’re
doing.”

What is still baffling us
is: is it possible to become
completely dependent on a
game? And if so, exactly
what are the symptoms of
sudden video game
withdrawal?

What can we say...
gamers will be gamers,
Americans will be
Americans, and shrinks
will be shrinks. That’s
about it.

Last month’s winner is G Arun Bala, Kalavakkam
How he did it:
“I got inspired for this design from Digit 6th
anniversary issue’s CD/DVD interface. Unlike others
using some freebie tools’ themes, widgets and
object docks built by third party while earning
credit themselves for the work of mere application
of tools, the passion for making a desktop became a
near reality when I saw your CD/DVD interface. The
cool Web 2.0 graphics with Vista look made a great
impact. Rather customising and using a desktop,
why not create one—which in my perception holds
high, and thus I designed this from scratch.”

Baby Monitor Picks Up Unlikely Signal
In the past, people have gotten hold of radio stations and
broadcasts from neighbours’ baby monitors. Now,
recently, a Palestine mom got quite a shock when her
baby monitor started picking up broadcasts from NASA’s
International Space Station. Hawking’s “baby universes”?

HEROINWARE

Gaming Now Officially A Disease!

My Desktop

Whatever 
Happened To…

We dug up an article on
the Net dating back to

July 2000, which begins thus:
“The old adage goes ‘There
ain’t no such thing as a free
lunch.’ Long distant phone
carriers may be wishing the
same thing could be said
about long distance phone
calls. Menlo Park-based
Dialpad.com  offers free long
distance phone calls to any
telephone number in the
United States, via your
computer and the Internet.”

Yes, back in 2000,
speaking to someone using
the Internet (!) was a brand
new thing. Dialpad only let
you call numbers in the
United States, but from
anywhere, and people flocked
to the site in droves to
register and call, call, call,
even just for the fun of it.
(There was Net2Phone back
then as well, but they
charged.)

And then VoIP took off in
a big way. You know the rest.
IMs began integrating voice
chat. Skype happened,
including cheap calls to
phones. Today, type anything
VoIP-related into Google and
you’ll see ads upon ads upon
ads: “Worldwide Internet
Calls. Low Rates. Sign Up
Today.” “Internet Phone Calls
at Low Rates. Inexpensive,
High-Quality Service.” The
companies are running out of
sensible domain names.

We never noticed: Yahoo!
acquired the company in
2005. Now, dialpad.com
redirects to Yahoo! Voice, Web
2.0-themed and all. Few
remember Dialpad.

“Branded” Mobiles
Hummer launched a range of phones a while ago, and
now Levi’s has announced a mobile phone. Designed by
Mode-Labs and built of steel, it will match the clothier’s
apparel range. Specs remain secret, but with the phone
will be offered a chain to hook it up with, of course, jeans.

Send in your Desktop with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the
subject ““MMyy  DDeesskkttoopp””,, and tell us your postal
address, too.

Participate in this contest and win next month 
Software Architecture
by Frank Buschmann

Published by

Dialpad.com



RETIRED HURT

Wii Causes
“Wiiitis”

Sales notwithstanding,
there have been quite a
few reports about how

Nintendo’s Wii has been the
cause of a number of
untoward incidents. First
there were the straps that
got broken all the time,
causing you to insure
everything in the house
(including yourself). Then
came the candle-stick hack
that tickled our ribs, and
now it’s got its own medical
condition—”Wiiitis.”

For once, Nintendo is
well out of the controversy.
Dr Julio Bonis of Boston in
the US woke up one fine
morning to a very sore
shoulder. What surprised
the doc was that he had
done absolutely nothing
physical in the days prior to
the injury, and had been a
complete couch potato.
That’s when he remembered
his new Wii. Bonis, it turns
out, had been playing Wii
Tennis for hours on his
darling console. When he
diagnosed his problem, he

decided it wasn’t tennis
elbow he was dealing with.

The doctor dashed off a
letter to the New England
Journal of Medicine
explaining the injury and
its symptoms, and
suggesting a remedy for the
case: “The treatment
consisted of ibuprofen for
one week, as well as
complete abstinence from
playing Wii video games.
The patient recovered fully.”
He also suggested the injury
be labelled more specifically
as “Wiiitis.”

Well done, Dr Bonis, you
warm the cockles of our
shoulder... err... hearts. 

ROYAL MAIL

Spam Queen

We all have relatives
who couldn’t care a
damn about

computers. Some amongst us
also have relatives who
discovered computers and
the Internet, like them, and
now seem addicted! Imagine
how irritating it can be when
your uncle or aunt starts
sending you forwards you
read two years ago! We look
upon with pity at the plight

of Princes Henry and
William when we discovered
that the Queen, aged 81
when this was written, has
taken to the Internet with
full gusto, and regularly
bombards the inboxes of the
young princes along with the
rest of her immediate family.

In true blue-blooded
fashion, the Queen dictates
her e-mails instead of writing
them. Having said that, the
monarch is pretty tech-savvy:
she owns a mobile phone
and an iPod. Just last year she
made her annual Christmas
Day message available for the
first time as a podcast. We
just hope, for the princes’
sake, that she lightens up on
those forwards...

An aside: it’s “Queen’s
English,” meaning her own.
So does she use spell check?

I SEE LITTLE PEOPLE

Lilliputians
On Vista
DVDs

ASpanish blogger,
Kwisatz, was
supposedly the first

to spot a photograph of
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Brian Kernighan and Dennis
Ritchie wrote The C
Programming Language in
1986. The version described
in that book became a sort
of standard, and was even
named “K&R C”. Developed
in 1972, C is the most
widely-used language in
application and OS
development even today.

Ritchie, a researcher in
the Software and Computer
Science Laboratory at Bell
Labs, once wanted to be a
physicist, but his
undergraduate experience
convinced him otherwise.
Following in his father’s
footsteps—he’d written a
significant book on
switching circuits—Ritchie
joined Bell Labs. Soon after,
he wrote a compiler for
ALTRAN, a language and
system for symbolic
calculation, and a key
program in the creation of
UNIX. Subsequently, he
helped Ken Thompson with
UNIX. He then added data
types and new syntax to
Thompson’s B language,
which evolved into C.

Kernighan studied
engineering physics as an
undergraduate. With his
first computer, the IBM 650,
he learnt a bit of FORTRAN,
which got him hooked to
programming: we’ve read
that he was a terrible
programmer! His thesis was
titled Programming in
artificial intelligence, and he
went on to attend graduate
school. After that, Kernighan
worked at Bell Labs with
Thompson and Ritchie, and
contributed significantly to
UNIX, which is written in C.
In 1983, Ritchie was awarded
the Turing Award for
generic OS theory.

People Who
Changed

Computing

Kernighan

The C Evangelists

Airwaves Afloat! 

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn  oorr  bbeeffoorree  tthhee
2200tthh ooff  tthhiiss  mmoonntthh  to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and win next month: 

Professional
XNA Game Programming
by Benjamin Nitschke

Published by

Last month’s winner:
Utkarsh Arora
Gurgaon

Ritchie



Splat.. biff... poop!

Here’s the end to your hair-
ripping frustrations over

stupid Web sites: horrible
layouts, pesky ads, and all the
other stuff that makes you go
wild. Head to www.netdisaster
.com, a fantastic place to vent
your fury.

Here’s how it works: enter
the URL of a site you detest,
and you’ll immediately be
able to crucify it visually.
Spray-paint the page black.
Call upon a dinosaur to stomp
on it, fry eggs on it, and what-
not from the “Disaster”
options. Check out the
“Massive” and “Self-repair”
options—these allow massive
damage to be done to the
page, and repair the damage

you’ve already inflicted,
respectively. Also use the
sound effects for the ultimate
site-disaster experience. And
yes, don’t miss out on the
“Dirty disaster” options: make
a cow drop dung or a dog
poop on the page. Gross, but
it’s out there, and we thought
we should let you know.

I/O

Microsoft has stooped to
the level of putting up a

spoof iPhone video on
YouTube… believe it. But still,
you’ve got to admit it’s funny.
At the MEDC 2007 (Mobile
and Embedded DevCon), the
company unveiled their new
“iPhone killer” mobile phone
video. The video went on

about a phone named
“oFone”: a circular display,
three keypads, the facility to
place keys anywhere you like,
and a lot more.

Mel Sampat, who happens
to be a program manager at
Microsoft, claims that even “a
four-year-old” can program
APIs for the oFone. The thing
has three separate keypads,
so three people can game
simultaneously. And when you
get bored of that, it can act as
a decent boomerang (it looks
like one). Besides going about
their serious business of
making M-dollars, the folks at
Microsoft do have a decent
sense of humour. The iPhone
spoof is at http://tinyurl.
com/2rhe59.

three faces embedded in
the hologram on new Vista
DVDs. What’s special about
the photograph is that it’s
only a square millimetre in
area, making it too small to
see without magnification.
The picture shows three
guys standing together,
smiling at the camera.

Following the
announcement, conspiracy
pundits immediately went
into overdrive, proclaiming
it an Easter egg. Some state
they have inside information
that Microsoft is running an
internal enquiry regarding
how the image got there,
which meant that this
wasn’t known until now,
and wasn’t approved, and
some heads are going to roll.

Unfortunately, all the

excitement was put to rest
when Microsoft’s Nick
White posted about it on
the Vista team’s blog—
”Conspiracy theorists
will be disappointed, the
photo is only one of
multiple images
contained in the
hologram design, all of
whose inclusion serves to
make it more difficult to
replicate a Windows Vista
DVD.” 

The three lucky men in
the photo, said White, are

members of Microsoft’s
anti-piracy team who had
worked on the holograms
for the Vista OS. There are
other images too in the
hologram, some of them
belonging to art
masterpieces in the public
domain, added White.

ENHANCED CHARITY

Surgeons
Against
Silicone

In the beginning was a
Web site called
MyFreeImplants.com,

asking the fairer sex, “Have
you ever wanted bigger
breasts? But couldn’t afford
the expensive costs of

surgery? Here is your
opportunity to earn Free
Breast Implants!”—and
enticing men with “Help
the girl of YOUR dreams get
the body of her dreams.
Develop a connection with
a girl of your choice and
help her earn Free Breast
Implants!”

Then, the British
Association of Aesthetic
Plastic Surgeons (BAAPS—if
only they knew we’d be
reading this in India) found
out, and all hell broke loose.

The BAAPS states that
the whole process of asking
for donations for breast
implants is demeaning,
and takes away the
important considerations
and decisions that need to
be taken into account
before going in for the
surgery. BAAPS president
Douglas McGeorge says,
“This is a wholly
inappropriate way to
proceed with what should
be a serious decision made
by a fully informed patient.
The site’s promise that
there are ‘no right or
wrong’ cases is
frightening—clearly there is
no proper medical
assessment of candidates,
which at best could lead to
disappointment, at worst,
to someone’s health being
endangered.”
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Codenames
Passing off these names in a
conversation will make you look
like you’re in on the inside
information of some of the
hottest products today!

Zephyr: The codename of the
recently-released Xbox 360 Elite
edition, the all-black Zephyr is
an update over the Xbox 360,
sporting an HDMI port and a
hard disk bumped up to 120GB.

FASN8: The recently-announced
Quad FX platform from AMD,
the FASN8 (pronounced
“fascinate”) is the first AMD
Silicon Next-gen 8-core platform
from the company. It promises
to put in eight physical cores of
2-Phenom FX processors on a
single motherboard that
supports HyperThreading.

F3: Sun’s new open source
product family, JavaFX, consists
of JavaFX Script and JavaFX
Mobile. This environment has
the ability to run under any
browser or operating system
that supports Java. The reason
it’s so interesting is that JavaFX
Script focuses on user
experiences with interfaces that
have rich animated media, while
other scripting languages are
more oriented towards building
Web pages.

Bearlake: Intel’s next-
generation chipsets, the P35
supports 65 nm process nodes,
the most advanced semi-
conductor fab technology. Due
to this, the chipsets use lesser
power and are more
economical. The P35 chipsets
will support DDR3 RAM, too.

Parivartan: A project by our
Government to network towns
and villages by making all
vehicles function as free Wi-Fi
nodes. The more the traffic, the
faster the network becomes!

Usage: I love my Zephyr. Life
will be rosy when I can browse
the Net with F3 on a FASN8 or
Bearlake system. Doing all that
on the road sound too good to
be true—let’s pray that
Parivartan takes off!

Wild Wild Web
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EEscscapeape

We agree with BAAPS—
aside from the medical
complications, we can’t
begin to imagine the
complications that could
arise from a loony donor
getting unrestricted access
to someone’s profile and
all their personal details.
The site allows donors to
“purchase any personal
products the ladies may
have for sale” and even
“receive custom photos of
your favourite girls (you
may even request specific
outfits),” which makes the
process even scarier.

Still, from what we
know of America, young
women there save up for
boob-jobs as though it were
a routine procedure. So
strictly speaking, men
sponsoring the thing
shouldn’t create too much
hubbub. What’s interesting
is that it’s happening on
the Net—sign of the times,
we say.

MECHA-MARRIAGE

Best Bot

Arobot recently presided
over the marriage
ceremony of a couple

in South Korea. Believe it.
The bridegroom, Seok

Gyeong-Jae, is one of the
engineers who designed the
robot for Hanool Robotics.
The firm brags that after its
marital duties were
completed, the robot was
“upgraded” to perform other
duties. Details of these
“other duties” are sketchy,
but we can only imagine
that the bot must have been
busy socialising with guests
at the drinks table or setting

the dance floor afire with 
a partner.

If you don’t need Tiro
(the robot in question)
administrating your
nuptials, he is also available
for hire as a robot Master of
Ceremonies (MC), complete
with “sweet female voice,”
for rent at a mere $215,000
(Rs 88 lakh).

Now, we definitely didn’t
see this coming, but just so
things like this don’t
surprise us in the future,

let’s predict where we might
see robots. Delivering a
sermon... what kind of God
would they speak about? A
funeral service... what kind
of death would they refer
to... dead batteries? How
about news anchors...? That
one’s a possibility—only,
they’d sort of look funny in
those formal outfits.

Actually, let’s leave it
to the Koreans and the
Japanese to figure all such
things out. 

Paul Stamatiou
http://tinyurl.com/27nhst
iPhone on 29th June, But Not for ME
Yesterday,… Geoff Ramsey, CEO of eMarketer’s
funniest remark was when he told us that the “Fear
of Google” was so prevelent that it even had a
three-letter acronymn: FOG. Anyway, I’ve been
hearing more and more about FOG all weekend…
Here’s a few examples:

Why did the stock market drive shares of Yahoo!
up so fast on total rumors that Microsoft was buying
Yahoo!? Easy, we wanted it to happen. “We” being
journalists who are living in FOG land. Bloggers
who’d like to see Microsoft be interesting again…
Several people on the boat were hoping that
Microsoft would buy Yahoo! simply to keep
competition going in the advertising market…

Matt Mondok
http://tinyurl.com/yro8ac
Microsoft, Mozilla execs respond to Safari on
Windows announcement
For companies like Microsoft and Mozilla, Safari
coming to Windows means that one more
competitor will be thrown into the Windows
browser battlefield. While neither company has
expressed dismay with Apple’s decision to put

Safari on Windows, on Monday executives from
both Microsoft and Mozilla expressed a lack of
concern for their new (Windows) foe.

Mozilla vice president of engineering, Mike
Schroepfer, said that he’d like to see Apple push
open standards for the web.

“We are excited to see the resurgence of
interest in browsers. We encourage Apple to put
their weight behind open standards and the open
Web to help ensure all browser users, regardless of
operating system or browser, can enjoy the best
possible Web experience.”

David Chartier
http://tinyurl.com/36jdjm
Leopard’s new menu bar is hideous
I’ve been spending (time) looking through the other
new features of Leopard. After I found that non-
transparent menubar mod, however, I can’t get
over how hideous that new menubar really is. I also
hate to say it, but Apple’s secrecy with this UI
change until now screams ‘Cupertino borrowed one
of Redmond’s photocopiers’ (the new Windows
Vista, for those who haven’t seen it, contains what
many—including myself—consider to be a literally
dizzying overabundance of transparent window
borders and menus).

The iPhone, Safari for
Windows, Leopard.
Predictable topics,
interesting posts.

Obituary: Mayur Bhatia
Nothing shocks one quite as much as

the passing of someone right in the
midst of one’s group. The death of Mayur—
due to an internal organ dysfunction—has
shaken us not only because it was so
unexpected, but also because he was such
an extremely gentle, soft-spoken, shy,
lovable little guy.

Mayur was the youngest amongst us.
When he joined our team, he seemed a
misfit because he’d speak only when
spoken to—and we mostly spoke to him
about work. What a surprise, then, that we
found he was a gamer—an avid one who
could kick anyone’s butt at Quake 3. In
general, he’d be engrossed in his work to an
extent that people had to physically shake
him by the shoulder to get his
attention! Ultra-focused,

lost, and technologically very
knowledgeable describe him best.

Yes, he was exceptionally
knowledgeable—specifically about system
tweaking, networking, and, of course,
gaming. His after-hours were generally
spent on the Sify LAN in Thane (near
Mumbai); he was well-known in the gaming
circles there.

Always eager to try his hand at new
things, be it a feature article or a game
review or a product review, he was quite the
ideal worker—perhaps a little too ideal. We
now wish we could have gotten to know him
better, that he could have opened up a bit,
felt a little less stiff while around us...

We can only take our comfort in the idea
that God takes young those He loves

the most. Rest in peace, Mayur.
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A Four-point Agenda
Dear Team Digit,
Congratulations for hitting a Sixer, and I
wish you guys will definitely break the
record of Herschelle Gibbs one day (I
wish you guys will hit more than a 100
sixes in a row), but please do be aware of
the Shane Warnes and Mutthiah
Muralitharans.

Thanks for coming up with the idea
of such a fantastic magazine, and the
Sixth Sense section rocked! Wikipedia, at
such a time when i had to complete my
school assignments, was such a help I’m
sure I’ll get an A grade with it. You guys
are doing a really good job by letting
people opt for freeware instead of going
for pirated stuff. It doesn’t only sound
nice, it is really working.

Your reviews of the latest PMPs has
really helped me in selecting the right
one for me, both pocket-wise and
feature-wise. But I would like to make a
few suggestions for your mag:

1. Folks, it’s India, an agriculture-
dependant and developing country, you
guys have to admit that there are techno
crazy people like me who read Digit, are
comp crazy but neither avail a computer
system and broadband, that’s a Mercedes
for a daily-wage worker.

2. I would request you to come up
with a Fast Track on 3D animation ,
Photoshop, and Visual Basic. For school
students like me, a Fast Track on core
languages such as C, C++, and Java
would be really useful.

3. A RAM review.
4. Please give product reviews of

inexpensive hardware for those who
cannot afford higher price stuff.

Best wishes, ’n’ keep the good work
going!

Harsh Kumar 
Jharkhand

Dear Harsh, 
Thank you so much for your mail, appreciation,

and also your suggestions. It does make us aware
that our magazine reaches far-off places, and we
need to be sensitive to the needs of people like
you too. We have taken note of your suggestions.
Do keep us sending your valuable feedback. 

— Executive Editor

DVD Demands
First of all, a big thank to you for
producing one of the best computer
magazines in the world. Hats off to your
articles, your products review, and for
everything. All are best—your CDs and
DVDs (now dual-layered, thanks for this,
but the DVD was not detected in my
combo). Just a couple days before I bought
the Sixth Sense edition, I was pleased to see
the contents, although the cost was
beyond my range, I bought it as you are
simply the best. Seeing Fast Track To Vista
was simply superb. But as from my side I
also want you to listen some of my wishes:
1. Please start a regular tutorial on some
of the software and programming
languages from the begining. It can be
quite helpful to many of us.
2. Provide some fun clips like those from
miniclip.com and more. This can help me
who is not a regular Net visitor and many
more like me.
3. Can you provide us Bollywood
wallpaers?
4. We would like to get some more games.
Please provide some Indian songs also.
Old songs can also work.
5. Finally, please add a few pages in Fast
Track in explaining about the software you
provide on the CD/DVD.

A Great Thanks.

Sujay Rakesh 
Hazaribag, Jharkhand

Dear Sujay, 
Glad to know that you did like our sixth
anniversary issue. The dual layer DVD is +R, so
check whether your drive is +R compatible. Try
and run it on other computers or a DVD player.  If
you still face a problem, then send an e-mail to
help@jasubhai.com with your complete postal
address and PIN code, and we will send you a
working DVD. 

Thanks also for all your suggestions—they do
give us an idea of what our readers expect from us.

— Executive Editor

Cantenna For The Homesick
Hi! I am an electronics engineer, a regular
Digit reader, computer enthusiast, and an
avid gamer having “all night” gaming
sessions in my college hostel. As I have
recently moved out of the hostel I am

missing out on a lot of gaming. I had
almost given hope on gaming with my
friends, then I read your do it yourself
article on a Wi-Fi antenna (Digit, June
2007)... I live about one to one and a half
kilometeres from the hostel, and was
wondering if the range could be extended
further by means of some other antenna
design and by using an amplifier. Just
wondering if it could work.

Prem
Dear Prem,
One and a half kilometres is too much. We
really don’t think it’s possible. If you do find a
way to do this, don’t forget to write in!

— Executive Editor

Recycled Irony
I think you guys really have a “sixth
sense.” You really know what to pack, and
how to pack in your special issues.
Including the Don DVD was a good idea.
With today’s genuine DVD titles costing as
less as Rs 35, you can very much afford to
pack a title now and then, just use paper
covers for the month’s disc’s plastic.
Perhaps you could start printing the mag
on recycled paper. If you already do, place
a “Recycled” logo on the cover (the logo is
those cycloid arrows seen on the Windows
Recycle bin).

Tarun Balraj
Adilabad, Andhra Pradesh

Dear Tarun,
We share your concern for the environment,
but believe it or not, recycled paper is actually
more expensive than regular paper in India—
magazine-quality, that is. The process of
recycling itself is quite expensive, so using
recycled paper will just have us emptying our
pockets—something we wouldn’t like to do at
this time.

The packaging is a constant battle—if we go
the environment-friendly way and use paper
for the DVDs, then we risk them being
damaged on their way to the stands or
subscribers, and then they abuse us. If we use
plastic, we aren’t being environment friendly…

Your suggestions are duly noted, however,
and we’ll see what we can do.

— Executive Editor

Who needs a form?
My answer to questions:
Q: What do you want to read more in
Digit?
A: Some study related articles for
students of BCA, BCS, Computer Science
etc. FastTrack to Web Design was simply
awesome. I’m not joining any classes
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because I have that issue.
Q: What needs to be improved in
content of Digit CD and DVD?
A: The games, because many people
don’t have a high PC configuration. If I
have 50 friends, 45 out of them don’t
have a graphics card, so how can they
play such games ?
Q: Describe Digit in 10 words: (Prizes
NOT dependent on this) 
D emand 
I nformation & 
G et 
I nformation 
T oday.

Saurabh Sawant

Dear Saurabh
Thank you for your feedback, and I hope
you’ve sent in your form besides e-mailing us.
Given your concerns about the games, I think
you should enjoy this month’s content—the
games will run on any PC that’s less than three
years old.

We’ll keep the student article suggestion in
mind as well.

— Executive Editor

Unhappy Penguin
Dear Team Digit
I have been reading Digit from May 2006
and would congratulate you for
including Ubuntu Feisty Live CD in your
June issue (which I am using).

The June issue was overall good but
last year’s was better. There is one
mistake in your issue—the TQ section.
The question about which distro is Dell
preloading. You’ve given the answer
Gutsy, but the correct answer is Feisty.
It is great that Digit is going dual-layer
from now on, and I hope you include at
least one Linux distribution if not
more. I hope you would include MEPIS
in your August issue (I know you may
not in July).

We Linux users face a peculiar
problem with Digit. We hardly bear fact
that Digit on average has less than half
a page about Linux and there have been
no tips and tricks for Linux for months
now. The Linux applications included
are fine, but there are no instructions
on how to use them in case the user is a
newbie and faces problems. What is
more irritating that the Digit interface
is unable to run in Linux. Yes you have
done great work in it but for Linux
users it is null.

I tried running your interface in
Linux with WINE (which is a Windows

Inbox
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E-mail: editor@thinkdigit.com
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Emulation Layer in Linux, in case you
do not know), but ended up in white
screen with nothing on it (I had Flash
installed!). Even the Digit icon
appeared in the notification bar but
there was no further going. I have
tried and managed to run even the
miniclip games as well as the
flash.exe in my other CD in WINE but
not the Digit Interface.

There was no help available
anywhere. Can you tell me how to fix
the issue? If there is a way to run
Digit in Linux, would you please tell
me and publish it in your magazine.

In my understanding, the
Flash.exe are based on SWF files (I
may be wrong). I believe the SWF
files can be opened in Firefox with
Flash installed, and if indeed there is
no way to run digit.exe, then at least
you can include an alternative Web
page with the Flash interface
embedded in it. Perhaps this may be
technically impossible, but we need
the explanation why as well. 

The Linux users will be happy
even by THREE reserved pages per
issue! Even TWO! Even ONE! HALF! At
least a QUARTER! The long faces stare
into the darkness...

Anurag Panda

P.S.: I know my letter will not be
replied to. As for publication:
IMPOSSIBLE!!!

Dear Anurag,
First of all, ha! Your letter has indeed been
published. Second, you’re not the only one
to complain about our lack of Linux
articles, so we’re remedying that. Read our
DIY to making a Linux distro this month,
and if you’re having trouble with Fedora
(get it off the DVD), take help from our
Tips and Tricks section. We’ll be continuing
on this vein in the coming months, so your
long faces shouldn’t be staring into
darkness for too long.

As regards the interface, digit.exe isn’t
just a Flash EXE like the Miniclip games—
we use another software to compile the
SWF files and a miscellaneous amount of
code into the EXE. A lot of this code is
Windows-specific, so the chances of this
particular interface working in Linux are
slim, if not non-existent. That said, we
won’t discount an HTML interface, or at
least something that will work for Linux
users—but this will take time. 

— Executive Editor

Problems Beyond
Borders

This is Ashok Gelal all
the way from Nepal. I’m
a Digit addict, and you
can’t even imagine how
much pain I take to get a
copy of your magazine. The mag
is not easily available in my locality, so
have to rush to the Indian border,
which takes about Rs 200 for travelling
expenses only. Though your mag is
good with the Fast Track being the best,
I often have complaints regarding the
CDs and DVDs. I always expect the
special issue discs be wrapped in a
special case, but it couldn’t happen till
date. The special issue discs are of great
use but as they are not wrapped in a
good case holder, they often get
scratched very soon. All these cannot
be excused this time. 

I was so excited to have a grab on
the Sixth Anniversary Issue. The CD’s
and DVD’s content looked promising,
but I found both DVDs not working.
Initially I thought my drive wasn’t
reading the discs— take some notes
here, the dual-layer discs given by
other IT magazines run smoothly
though—but after trying other drives, I
concluded the discs were corrupted.
After going through the forum, I found
many other readers are also going
through the same problem.

One last query: are people really
interested in watching Don? It would
have been better if you had given some
documentary movies or some Oscar
non-English winners. My suggestion:
don’t always turn your ear to your
financial advisors, it can really ruin
your image. 

Ashok Gelal
Nepal

Dear Ashok,
Thanks so much for your mail. I do
understand your problem of the non-
functioning DVDs. Please send us your postal
address (with PIN code) and we’ll try to send
you a replacement. However, we’ve found that
the postal system often doesn’t deliver our
CDs to Nepal due to security concerns—we
hope that won’t be the case this time—but
we’ll try to ensure that you get your
replacements. I am amazed at the pains you
take to grab a copy of Digit… your mail makes
me feel proud, and also gives me an
assurance that we are indeed worth it. 

Thanks once again for all your efforts to
write to us and give us honest feedback.

— Executive Editor

Letter 
of the
Month
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The Palm Foleo is a new… 
a) Laptop

b) PDA
c) Mobile Companion
d) Portable media player

TCP port number 80 is usu-
ally reserved for…?

a) E-mail
b) HTTP
c) FTP
d) Telnet

Which doesn't belong in the
list? 

a) Santa Rosa
b) Merced 
c) Napa
d) Puma

In what year was DOS 
created?

a) 1987 b) 1981
c) 1973 d) 1967

Who were the two rival
company heads to 

have recently been on stage
together?

a) Jonathan Schwartz and Samuel
Palmisano

b) Azim Premji and N R Narayana 
Murthy

c) Steve Jobs and Bill Gates
d) Howard Stringer (Sony) and 

Satoru Iwata (Nintendo)

Error 500 in your browser
means… 

a) Request Timeout
b) Site Access Forbidden/ 

Password Protected
c) Internal Error/Server 

configuration problems
d) Bad File Request/Syntax error

What was the first ARPANET
message?

a) “lo” b) “hello world”
c) “Test” d) “Hi”

According to Intel, "MMX" in
their Pentium MMX chip

stood for…?
a) MultiMedia eXpanded
b) MultiMedia eXtensions
c) Matrix Manipulation eXtensions
d) Nothing

There is now an Internet2
link spanning the US. What

speed?
a) 100 Gbps b) 2000 Gbps
c) 10 Gbps d) 2 Gbps

10

9

8

7

6

5

4

3

2

ACROSS
7. Largest distributor of the GNU / Linux operating
system based in North Carolina (3,3)
8. Portable computer (6)
10.------space- space on hard disk drive dedicated for
temporary storage (7)
11.Device that joins a balanced line to an unbalanced line (5)
12. American National Standards Institute(abbr) (4)
13. A picture as opposed  to text (5)
17. -----box- a TV streaming device that enables consumers
to remotely view their PVR (5)
18.----tooth-connect and exchange information between
devices (4)
22.------ware- software distributed on trial basis(5)
23.Not a licensed software (7)
24.Computer controlled machines that perform jobs
automatically (6)
25. Area on a monitor usually made of glass (6)

DOWN
1. 1.Glassware made of quartz (7)
2. E-mail------ —helps to ensure messages reach the correct
person (7)
3. Cut and ----- - scissors and glue method of document
production (5)
4. Computer scientist Charles------ (7)
5. Static photograph (5)
6. To start or launch a computer application or software
programme (4)
9. Graphic or image made smaller to
display multiple images on a single Web page (9)

14.Computer programmes that request
data (7)
15. Contributor to an online journal (7)
16. Used to transfer information between Linux kernel
modules and user space processes (7)
19. Online audience (5)
20. A free suite of programmes which implement the
Server Message Block protocol (5)
21.-----hat—malicious hacker(5)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

DOS And The Little Disk
Which company first

produced the 3½-inch
floppy
disk? 

a) IBM 
b) Microsoft 
c) Philips 
d) Sony

1

The highest amount
paid for a domain

name was for business.com:
$7.5 million. This is followed by
AsSeenOnTv.com at $5.1
million. Third was
Altavista.com, at $3.3 million.

Did You
Know?

Answers

Bill Gates

7. (c) Internal Error/ 

server-configuration

problems

8. (a) “lo”

9. (d) Nothing

10. (a) 100 Gbps

mobile games

1. (d) Sony, in 1981

2. (c) Mobile

Companion

3. (b) HTTP

4. (d) Puma - an AMD 

platform

5. (b) 1981

6. (c) Steve Jobs and 

Crossword by Nitta Jaggi

Last Month’s Solution

June’s Winner:
Amit Gawde, Pune, Maharashtra

Send in your entries to
TQ@thinkdigit.com on or by 20th of
this month. One lucky participant
will 
win Introducing 
Autocard 2008
By George Omur

Published by

Win!



People And Events That Grabbed The Headlines—For Better Or For Worse

Ha ha! Funny joke! Well,
the closest to that merger
we’ve seen in recent years

is the on-stage interview, at the
D: All Things Digital conference,
with Steve Jobs and Bill Gates.
It’s been in the news a bit: they
actually were on the same stage
at the same time, and that’s
newsworthy enough for it to be
in the public memory for several
years to come.

Now both men are congenial
as well as witty by nature, so no-
one expected an on-stage fist-
fight. No fist-fight happened,
either. It seems to have been a
nice session, with jokes having
been cracked, and the two
talking about the future of
computing. Not only the future,
but also the past: ah, nostalgia…
The two companies’ efforts to
work together many years ago—
Microsoft’s first software for
Apple was BASIC for the Apple
II—and other such things. Like

the recent Mac vs. PC ads.
(Actually, if we remember right,
Gates was a little pissed at the
ads when they happened—we’re
wondering how he pulled off the
ha-ha-ha face at this point.)

It wasn’t all jokes and jibes.
Gates and Jobs did speak about
the future. There was no
particular focus, just general
talk of how we’re going to go
beyond keyboard and mouse—
you get the idea. Quite the
neutral topic, because all the
rivalry is about keyboard and
mouse computing.

And so, even as tech scribes
focus intensely on Apple-MS
competition, the men behind
the madness are, apparently,
good enough friends. God’s in
his heaven and all’s right with
the world, but all just might not
have been right with the world if
it were Ballmer in Gates’ place.
We think. Would have been
much more fun, really.

In an interview with Tim
Ferriss, who is a lot of
things (www.

huffingtonpost.com/tim-
ferriss), celebrity tech blogger
and technology evangelist
Robert Scoble explains how
he keeps his thousands upon
thousands of mails organised.
(It’s also been reported that
he reads 622 RSS feeds each
morning, which, as you
know, is impossible.)

‘ Keep all .PST files under
2 GB to optimise speed and
prevent crashes. He goes on:
“Creating a new .PST file is
not intuitive. Tools >
Options > Mail Setup >
Data Files > Add.” Mr
Scoble, it seems, has three
separate .PST files as folders
in his left-hand Outlook view,
which he’s classified into
“Old”, “Middle / Someday”,
and “Hot”. These are in
addition to the “Inbox”,
which he considers his

“working set”, Mr Ferriss tells
the world.

‘ Remove infrequently-
used .PST files: “right-click
and ‘close’ infrequently-used
.PST folders and other
folders.” Turns out this
doesn’t delete them, so you
can still use Google Desktop
Search to search for those
messages.

‘ Respond to fewer mails
(duh). Scoble has said that
“based on his analytics over
time,” each e-mail he replies
to produces between 1.5 and 2
additional mails in return.
Sending mail multiplies the
mail you receive (duh).
Replying to more people more
often actually creates more
work instead of cutting it
down (duh).

There you have it—
Outlook tips from The
Scobleizer himself to
supplement this month’s Tips
& Tricks section!

TMZ.com is a rather popular
celebrity gossip site. Now,
after Paris Hilton was

incarcerated luxury-class, site
traffic jumped to all-time-high
levels. Well, not quite. She-who-
must-not-be-mentioned (oops—
we just did!) has generated, in
the past, even more traffic at
TMZ. This is according to Inter-
net traffic monitor Hitwise.com.
There’s a page there that details
traffic to gossip sites and blogs
with interesting names like

HollywoodTuna. com.
The question now is, why are

we cluttering this page up with
something about Paris Hilton,
about whom you doubtless no
longer care—even if the poor
thing has been imprisoned? Well,
it’s because we wish to report the
sad state of affairs. According to
blog pulse meter Blogpulse.com,
the news that Hilton was going
to jail put her above President
Bush in the blog realm. Ah, the
wisdom of crowds.

The Crowds
Have Spoken

Tips & Tricks

Apple-MS
Merger
Imminent
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